ADAPT FLOOR-PRO 2019

USER MANUAL

Copyright 2019
## LIST OF CONTENTS

**GETTING STARTED** .............................................................................................. 1

**QUICK REFERENCE GUIDE** .................................................................................. 5

2.1 GENERATE INPUT DATA .................................................................................. 7
2.2 PERFORM ANALYSIS ...................................................................................... 9
2.3 PREPARE TO DESIGN .................................................................................... 10
2.4 GENERATE REPORT ....................................................................................... 12

**SIGN CONVENTION** .......................................................................................... 13

3.1 SIGN CONVENTION RULES ............................................................................ 15
  3.1.1 User-Defined Actions (Forces/Displacements) and Program Reported Displacements ................................................................. 15
  3.1.2 Sign Convention for Actions Reported by the Program for User Generated Manual Design Sections ................................................................. 16
  3.1.3 Sign Convention for Program Generated Tabular Reports for Automatically Generated Design Sections ................................................................. 17

**STRUCTURAL MODELING** .................................................................................. 19

4.1 STRUCTURAL MODELING RULES .................................................................. 21
  4.1.1 Default Position of Structural Components ........................................... 21
  4.1.2 Changing the Location of Structural Components .................................. 22
  4.1.3 Verification of Geometry of the Structural Model .................................. 23
  4.1.4 Position of Supports and Significance of Support Position .................... 23

4.2 BOUNDARY CONDITIONS – RERAINTS/RELEASE ......................................... 25

**POST-TENSIONING** .......................................................................................... 29

5.1 TENDON GEOMETRY .................................................................................... 31
5.2 TENDON PROPERTIES .................................................................................... 35
  5.2.1 Tendon Shape ........................................................................................ 35
  5.2.2 Cross-Sectional Geometry ..................................................................... 35
  5.2.3 Material Properties ................................................................................ 38

5.3 POST-TENSIONING SYSTEM, STRESSING AND TENDON FORCE ............... 39
  5.3.1 Post-Tensioning System ......................................................................... 39
  5.3.2 Effective Force Method of Design ............................................................ 40
  5.3.3 Variable Force Method of Design ............................................................. 40
  5.3.4 Tendon Friction ..................................................................................... 41
  5.3.5 Tendon Styressing ................................................................................ 42
  5.3.6 Long-Term Stress Losses ..................................................................... 42

5.4 TENDON GENERATION – TENDON RIBBON ............................................... 43
  5.4.1 Criteria Panel ........................................................................................ 43
  5.4.2 Settings Panel ........................................................................................ 44
  5.4.3 Model Panel ........................................................................................... 44
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.4.4</td>
<td>Modify Panel</td>
<td>45</td>
</tr>
<tr>
<td>5.4.5</td>
<td>Visibility Panel</td>
<td>46</td>
</tr>
<tr>
<td>5.4.6</td>
<td>Design Panel</td>
<td>47</td>
</tr>
<tr>
<td>5.4.7</td>
<td>Single Tendon Generation</td>
<td>47</td>
</tr>
<tr>
<td>5.4.8</td>
<td>Tendon Mapping – Banded and Distributed</td>
<td>49</td>
</tr>
<tr>
<td>5.4.9</td>
<td>Dynamic Tendon Modeling in Elevation (DTM)</td>
<td>60</td>
</tr>
<tr>
<td>5.4.4</td>
<td>Tendon Interference</td>
<td>61</td>
</tr>
<tr>
<td>5.5</td>
<td>SHOP DRAWING PANEL (ADD-ON MODULE)</td>
<td>62</td>
</tr>
<tr>
<td>5.5.1</td>
<td>Friction and Elongation</td>
<td>62</td>
</tr>
<tr>
<td>5.5.2</td>
<td>Felt 3D Report</td>
<td>63</td>
</tr>
<tr>
<td>5.5.3</td>
<td>Drawing Editor</td>
<td>63</td>
</tr>
<tr>
<td>5.5.4</td>
<td>Display Tendon Heights</td>
<td>64</td>
</tr>
<tr>
<td>5.5.5</td>
<td>Tendon Spacing Tool</td>
<td>65</td>
</tr>
<tr>
<td>6.1</td>
<td>MATERIAL PROPERTIES</td>
<td>69</td>
</tr>
<tr>
<td>6.1.1</td>
<td>Concrete</td>
<td>69</td>
</tr>
<tr>
<td>6.1.2</td>
<td>Mild Steel</td>
<td>70</td>
</tr>
<tr>
<td>6.1.3</td>
<td>Prestressing</td>
<td>71</td>
</tr>
<tr>
<td>6.2</td>
<td>DESIGN CRITERIA</td>
<td>71</td>
</tr>
<tr>
<td>7.1</td>
<td>LOAD COMBINATION</td>
<td>87</td>
</tr>
<tr>
<td>7.1.1</td>
<td>Load Combinations Set Up</td>
<td>87</td>
</tr>
<tr>
<td>7.1.2</td>
<td>Load Combination Label</td>
<td>89</td>
</tr>
<tr>
<td>7.1.3</td>
<td>Analysis/Design Options</td>
<td>89</td>
</tr>
<tr>
<td>7.1.4</td>
<td>Long-Term Deflection Template</td>
<td>90</td>
</tr>
<tr>
<td>7.2</td>
<td>PATTERN LOADING</td>
<td>91</td>
</tr>
<tr>
<td>7.3</td>
<td>REDUCTION OF LIVE LOAD</td>
<td>95</td>
</tr>
<tr>
<td>7.4</td>
<td>LATERAL (WIND/SEISMIC) LOADS FOR SINGLE LEVEL STRUCTURES</td>
<td>96</td>
</tr>
<tr>
<td>7.4.1</td>
<td>Lateral Load Case Definition</td>
<td>97</td>
</tr>
<tr>
<td>7.4.2</td>
<td>Load Combinations</td>
<td>99</td>
</tr>
<tr>
<td>7.4.3</td>
<td>Input/Editing of Lateral Forces</td>
<td>100</td>
</tr>
<tr>
<td>8.1</td>
<td>OVERVIEW</td>
<td>105</td>
</tr>
<tr>
<td>8.2</td>
<td>MESHING</td>
<td>105</td>
</tr>
<tr>
<td>8.2.1</td>
<td>Imposed Location of Nodes</td>
<td>107</td>
</tr>
<tr>
<td>8.2.2</td>
<td>Basics of Automatic Meshing</td>
<td>109</td>
</tr>
<tr>
<td>8.2.3</td>
<td>Manual Meshing</td>
<td>109</td>
</tr>
</tbody>
</table>
8.2.3.1 Overview and Use of Quadrilateral Cells .................................. 109
8.2.3.2 Generation of Triangular Cells ................................................ 116
8.2.4 Mesh Editing ............................................................................. 119
8.2.5 Nodes and Finite Elements ......................................................... 119
8.2.6 Natural and Analysis Nodes ......................................................... 119
8.2.7 Node Consolidation – Node Shift ............................................... 120
8.2.8 Excluder .................................................................................... 123
8.3 ANALYSIS OPTIONS ....................................................................... 124
8.4 ANALYZE THE STRUCTURE ............................................................ 125
8.5 DEFLECTIONS CALCULATION IN FLOOR PRO WITH ALLOWANCE FOR SLAB CRACKING .................................................... 125
8.5.1 Overview .................................................................................... 125
8.5.2 Procedure How to Calculate Cracked Deflection ..................... 126
8.6 CRACK WIDTH CALCULATIONS .................................................... 129
8.7 DISPLAY LINE CONTOURS ........................................................... 131
8.7.1 Overview .................................................................................... 131
8.7.2 Contour Settings Panel ............................................................... 132
8.8 VIBRATION ANALYSIS ................................................................. 133
8.8.1 General ....................................................................................... 133
8.8.2 Run Vibration Analysis ............................................................... 134
VIEW/VALIDATE RESULTS .................................................................... 137
9.1 View Analysis Results (ADViewer) ................................................ 139
9.1.1 Generate a Bitmap (ADViewer) .................................................. 140
9.2 Model Display Tools (ADViewer) .................................................... 141
9.3 Display Components/Entities (ADViewer) .................................... 142
9.3.1 Settings for Display Entities (ADViewer) ................................... 142
9.3.2 Result Display Settings (ADViewer) ......................................... 142
9.4 Settings for Results Display Toolbar ............................................. 144
9.5 Cuts Toolbar ................................................................................. 146
9.6 Scaling Toolbar ............................................................................ 149
DESIGN ........................................................................................................ 151
10.1 OVERVIEW .................................................................................. 153
10.2 DESIGN A SPECIFIC LOCATION ................................................ 153
10.3 DESIGN A SPECIFIC REGION ..................................................... 156
10.4 DESIGN THE ENTIRE FLOOR SYSTEM .................................... 157
10.5 PUNCHING SHEAR DESIGN ....................................................... 162
10.6 REINFORCEMENT SPECIFICATION AND DISPLAY ................ 170
10.6.1 Basic Features ........................................................................................................... 170
  10.6.1.1 Mesh Reinforcement Specification ............................................................... 174
  10.6.1.2 Generation of Rebar Drawing ................................................................. 177
  10.6.1.3 Reinforcement Display Control ............................................................... 179
  10.6.1.4 Detailing, Printing, Plot Preparation and Reporting ......................... 181
10.6.2 Advanced Features (DRD Module) ................................................................. 183
  10.6.2.1 Bonded and Distributed Bars Specification ......................................... 184

REPORTS ............................................................................................................................. 189
11.1 OVERVIEW .................................................................................................................. 193
11.2 REPORT COMPONENTS .......................................................................................... 193
  11.2.1 Default Reports of the Program .................................................................... 193
  11.2.2 Program/User Generated Reports ............................................................... 193
  11.2.3 Text-Based Information from Other Sources (External-Text) .................... 194
  11.2.4 Graphics-Based Information from Other Sources (External-Graphics) .... 194
11.3 REPORT GENERATION ........................................................................................... 194
  11.3.1 Print Panel ....................................................................................................... 195
  11.3.2 Compiled Reports ........................................................................................... 195
     Open Report Compiler ....................................................................................... 195
     Take Report Screenshot ..................................................................................... 198
  11.3.3 Single Default Reports Panel ........................................................................ 199
     11.3.3.1 General ..................................................................................................... 199
     11.3.3.2 Structural .................................................................................................. 200
     11.3.3.3 Loads ........................................................................................................ 201
     11.3.3.4 Tendon ...................................................................................................... 203
     11.3.3.5 Rebar ......................................................................................................... 204
     11.3.3.6 Punching Shear ......................................................................................... 205
     11.3.3.7 Column ..................................................................................................... 206
     11.3.3.8 Wall ........................................................................................................... 207
  11.3.4 Analysis Reports Panel ..................................................................................... 208
     11.3.4.1 Design Section/Strip ............................................................................... 208
     11.3.4.2 Analysis Data ........................................................................................... 209
     11.3.4.3 Reactions ................................................................................................. 210
  11.3.5 Export DWG Panel ........................................................................................... 211
     Export DWG/DXF .................................................................................................. 211
11.4 REPORT GENERATION UTILITIES ........................................................................ 211
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.4.1</td>
<td>Report Font</td>
<td>211</td>
</tr>
<tr>
<td>11.4.2</td>
<td>External-Text</td>
<td>211</td>
</tr>
<tr>
<td>11.4.3</td>
<td>External-Graphics</td>
<td>212</td>
</tr>
<tr>
<td>11.4.4</td>
<td>Program-User Report Components</td>
<td>212</td>
</tr>
<tr>
<td>11.5</td>
<td>LIST OF THE PROGRAM GENERATED REPORTS</td>
<td>212</td>
</tr>
<tr>
<td>11.6</td>
<td>SELECTED SAMPLE OF PROGRAM GENERATED REPORTS</td>
<td>214</td>
</tr>
<tr>
<td>APPENDIX A</td>
<td>NODE CONSOLIDATION</td>
<td>233</td>
</tr>
<tr>
<td>A1</td>
<td>Overview</td>
<td>233</td>
</tr>
<tr>
<td>A1.2</td>
<td>Consolidation of Analysis Nodes</td>
<td>234</td>
</tr>
<tr>
<td>A2</td>
<td>MESHING USING EXCLUDER</td>
<td>244</td>
</tr>
<tr>
<td>A3</td>
<td>VIEW FINITE ELEMENT NODE AND CELL INFORMATION</td>
<td>247</td>
</tr>
<tr>
<td>A4</td>
<td>FINITE ELEMENT CELL SIZE AND MESH DENSITY</td>
<td>249</td>
</tr>
<tr>
<td>A4.1</td>
<td>Maximum Mesh Size</td>
<td>249</td>
</tr>
<tr>
<td>A5</td>
<td>MANUAL EDITING OF AUTOMATICALLY GENERATED MESH</td>
<td>252</td>
</tr>
<tr>
<td>APPENDIX B</td>
<td>TIPS FOR MESHING</td>
<td>260</td>
</tr>
<tr>
<td>B1</td>
<td>Extend the Boundaries of Openings to Centerline of Adjacent Walls</td>
<td>260</td>
</tr>
<tr>
<td>B1.2</td>
<td>Extend Openings to Slab Edge</td>
<td>260</td>
</tr>
<tr>
<td>B1.3</td>
<td>Combine Adjacent Openings</td>
<td>261</td>
</tr>
<tr>
<td>B1.4</td>
<td>Break Up Walls and Beams That Intersect Outside a Slab Region</td>
<td>262</td>
</tr>
<tr>
<td>B1.5</td>
<td>Either “Disregard” Short Wall Projections, or Use Manual Shift Node</td>
<td>263</td>
</tr>
<tr>
<td>B2</td>
<td>SUGGESTIONS FOR IMPROVED MESHING</td>
<td>264</td>
</tr>
<tr>
<td>B2.1</td>
<td>Wall Intersections</td>
<td>267</td>
</tr>
<tr>
<td>B2.2</td>
<td>Break Walls Across Different Slab Regions</td>
<td>268</td>
</tr>
<tr>
<td>B2.3</td>
<td>Break Up Walls and Beams Adjacent to Jagged or Irregular Slab Boundaries</td>
<td>268</td>
</tr>
<tr>
<td>B3</td>
<td>MANUAL NODE SHIFT (NODE CONSOLIDATION)</td>
<td>270</td>
</tr>
<tr>
<td>B3.1</td>
<td>Exclusion of Locations of Your Choice from Node Shift</td>
<td>272</td>
</tr>
<tr>
<td>B3.2</td>
<td>Shift Node (Consolidate Node) Manually</td>
<td>274</td>
</tr>
<tr>
<td>APPENDIX C</td>
<td>GLOSSARY OF TERMS</td>
<td>277</td>
</tr>
<tr>
<td>C1</td>
<td>Natural Nodes</td>
<td>277</td>
</tr>
<tr>
<td>C1.2</td>
<td>Analysis Nodes</td>
<td>277</td>
</tr>
<tr>
<td>C1.3</td>
<td>Offset</td>
<td>279</td>
</tr>
<tr>
<td>INDEX</td>
<td></td>
<td>281</td>
</tr>
</tbody>
</table>
Chapter 1

GETTING STARTED
This manual explains how to use the ADAPT-Floor Pro application to model, analyze, and design a concrete floor system. Floor systems designed with ADAPT-Floor Pro can be conventionally reinforced, or post-tensioned. ADAPT-Floor Pro also enables the user to generate comprehensive reports for purposes of performing code checks, and gauging design values and reinforcement of floor systems.

ADAPT-Floor Pro is intended to be used in the context of single-level analysis and design. This tool can be used in conjunction with ADAPT-Edge and ADAPT-Modeler for modeling and analysis of multi-story structures. However, when used within single-level mode for the design of a single slab in a multi-story structure, the scope of usage for ADAPT-Floor functions within the parameters of standalone usage. See the ADAPT-Builder Getting Started Guide/User Manual for more information on the integration usage between Edge and Floor Pro.

It is assumed that (i) you have already created a structural model of the floor system you intend to analyze, (ii) obtained a first finite element (FEM) solution for its self-weight, and (iii) have validated the solution to be reasonable – all using the information detailed in the ADAPT-Modeler User Manual. The ADAPT-Modeler User Manual covers the prerequisites to the process that leads to the final design of your floor system.

In addition, advanced topics of FEM processing that were not covered in the ADAPT-Modeler User Manual are discussed in this manual. Follow the sequence of steps listed in Chapter 2 and detailed in the remainder of this manual to complete the analysis and design of your project.
Chapter 2

QUICK REFERENCE GUIDE

2.1 GENERATE INPUT DATA ................................................................. 7
2.2 PERFORM ANALYSIS ................................................................. 9
2.3 PREPARE TO DESIGN .............................................................. 10
2.4 GENERATE REPORT ............................................................... 12
2.1 GENERATE INPUT DATA

The natural sequence from creating a structural model, to generating structural documents and subsequently fabrication drawings, is listed in the following chapter. There are many short cuts and alternatives in the process of data generation and execution. These, however, are avoided in the following list in favor of a more common and straightforward approach. The items listed here are discussed in greater detail in the remainder of the manual.

Initial steps that are also covered in the ADAPT-Modeler User Manual are:

- Create a structural model.
- Generate a structural model, either by importing from a third-party program, or creating your own structural model using the tools of ADAPT-Modeler.
- Mesh the structure.
- Use Analysis→Meshing→Mesh Generation to mesh the structure. Use the defaults for simplified mesh.
- Analyze the structure for self-weight, using programs defaults.
- Once meshing is complete, use Analysis→Analysis→Execute Analysis.
- View the analysis results for solution validation.
- Validate the solution obtained by examining the deflected shape of the structure from Analysis→Analysis→Result Display Settings and evaluating the value of the maximum deflection reported.
- Save the input and the solution.
- Steps and considerations covered in this manual:

Complete and finalize input data

- Review the structural model for efficiency in analysis/design and mitigation of possible problems.
- View/edit boundary conditions, if necessary.
- Apply releases between the structural components, if necessary.
- Add post-tensioning tendons, if the structure is post-tensioned.
  - Select and display the Tendon ribbon.
• The tools available for tendon generation are shown above in the Model panel and are add tendon, map distributed tendon and map banded tendon.
  
  o Review and finalize reinforcement properties.
    • Go to Criteria ➔ Material Properties and enter the material properties for prestressing and rebar if applicable.

  o Specify base reinforcement to be included in your design, if any. Use Rebar ➔ Model Base Rebar.

  • Enter mesh reinforcement, if any
  • Enter single bars in size, length and number at locations of your choice using Banded or Distributed options.
  • Verify each of the reinforcement types entered through a visual check.

  o Review and finalize design criteria from the Criteria ➔ Design Criteria

  • Select/verify the building code to be used
  • View/edit the items listed under Analysis/Design options
  • Set the allowable stresses for the design of PT components
  • Set the one- and two-way shear design preferences from Shear Design
- Set the tendon height defaults for newly modeled tendons
- Select the type of reinforcement you prefer for punching shear design, stirrups or shear studs.
- Select the size of reinforcement bars to be selected by the program for bending and one-way shear.
- View each of the other tabs of the design criteria and edit the default values if necessary.
  - Define additional load cases; add loads if necessary
    - If the load cases you plan to use are more than “dead”, “live”, “self-weight”, and “prestressing” do the following:
      - Go to \textit{Loading $\rightarrow$ Load Case/Combo $\rightarrow$ Load Cases} and enter the label of the other load cases that you plan to use. Once the label is listed in the library, this enables you to enter the associated loads.
    - Enter the loads of each load case using \textit{Loading $\rightarrow$ General}.
  - View and edit the program-generated load combinations
    - Open the \textit{Load} Combination dialog window from \textit{Loading $\rightarrow$ Load Case/Combo} Depending on the building code selected, the program will display a number of load combinations.
      - Review/edit the load combinations displayed in the Load Combination dialog window for relevance and accuracy.
      - When adding a new load combination, check that the correct \textit{Analysis/Design Option} is selected. In most cases you would select \textit{No Code Check}.
      - It is not necessary, but is advisable to create a load case for prestressing only “PT” with no code check for evaluation of the post-tensioning entered.
      - Likewise, if you have unusual load cases, make sure that for each of the load cases you define a load combination. The objective is to be able to view the results of the unusual load case on its own, in order to evaluate its validity.

2.2 PERFORM ANALYSIS
  - Re-mesh the structure, if necessary.
  - Use the advanced features of meshing, if required to obtain optimum meshing.
  - Review analysis options–modify programs default, if necessary.
Chapter 2  QUICK REFERENCE GUIDE

- Obtain a solution.
- View the deflected shape of the structure for self-weight, and other load combinations for validation.
  - Once the analysis is complete, select View Analysis Results from Analysis ➔ Analysis. This opens the 3D viewer of the program to display the solution.
  - Once in the 3D viewer, select the load combination interested in and Z-translation. This is the vertical displacement of the structure. Then click on the tool with two light-bulb graphics. This will display the deflected shape under self-weight only.
  - Zoom, rotate and view the results thoroughly to ensure that the deflected shape under self-weight looks reasonable. In particular, make sure there is no deflection where the structure was intended to have been supported. Correct the structural model if the deflected shape and values under self-weight do not appear reasonable.
- Alternatively, the user can view the deflection contour in the Results Browser.
  - Once the analysis is complete the Results Browser will open on the right-hand side of the user-interface.
    - In the Loads tab, expand the Load Combos tree and select the load combination you are interested in viewing deflection results for.
    - In the Analysis tab, expand the Slab tree and check the box in front of Deformation ➔ Z-Translation. This is the vertical displacement of the structure. This will display the deflected shape under self-weight only.
    - Zoom, rotate and view the results thoroughly to ensure that the deflected shape under self-weight looks reasonable. In particular, make sure there is no deflection where the structure was intended to have been supported. Correct the structural model if the deflected shape and values under self-weight do not appear reasonable.

2.3  PREPARE TO DESIGN

- Create support lines, if not done already. Use options from Floor Design ➔ Strip Modeling to generate support lines and strips.
• Use Floor Design ➔ Strip Modeling ➔ Dynamic Editor to create support lines along the principal axes of the structure.

  o Create design sections automatically

    • Use Floor Design ➔ Section Design ➔ Generate Sections New.
    • View the automatically created design sections to ensure that the desired floor area is covered adequately. Use Floor Design ➔ Strip Results ➔ Visibility.
    • In the case of more complex structural layouts, splitters are available to aid in customizing the design strips. These tools are located on the Floor Design ➔ Section Design ➔ Splitters tools.

  o Design the design sections

    • Select Floor Design ➔ Section Design ➔ Design the Sections

  o View the outcome of the code check for the design sections in the X-direction. Use options in Floor Design ➔ Strip Results ➔ Visibility in tandem with Result Browser.

    • If there are no pink lines (broken lines) the requirements of the building code you selected is satisfied.
    • If there are pink (broken) lines, the code requirements have not been met; investigate and fix the problem as described in this manual.

  o View the outcome of the code check for the design sections in the Y-direction (follow the same instructions as with the X-direction).

  o If any changes are made to the model during code check, go back to the “Analysis” step and repeat.

  o Execute the punching shear option – if applicable

  o Click on Floor Design ➔ Punching Shear ➔ Punching Shear Check to perform the code check for punching shear.

  o Run and view the punching shear stress check on the screen

    • View the values of the punching shear reported by the program on the screen from the Results Browser. In the Loads tab select the strength envelope or a single strength load combination. In the Analysis tab expand the Punching Shear tree. Select the result for Stress Check
• If necessary and permissible, the program reports the necessary reinforcement. The program also reports if a section does not pass code by displaying it in red.

• To view the stress ratios, in the **Results Browser** on the **Analysis** tab check the box under **Punching Shear ➔ Stress Ratio**.

### 2.4 GENERATE REPORT

- Generate tendon drawing. On engineering drawings, most engineers group tendons into tendons in one-direction (such as banded tendons) and tendons in the other direction (distributed tendons).  

  1. If you plan to show the tendons in two drawings, you must first group them, following the instructions below. If this is not the case, go to the next step.

  - **Group Tendons**
    
    1. Go to **Visibility ➔ Display Settings ➔ Group Settings**. This opens the group library. Add two group names, such as “banded tendons,” and “distributed tendons.”
    
    2. Using **Visibility ➔ Display Settings ➔ View Settings**. Turn off everything except the tendons and other basic information you need to identify the tendons. In most cases, it is adequate to retain the tendons, slab outline and column supports.
    
    3. Select as many tendons of one group as practical.
    
    4. Select **Modify ➔ Modify Item Properties**.
    
    5. Once the **Modify Item Properties** dialog window opens, select the **Tendon** tab.
    
    6. In the **Tendon** tab, select the group to add the selected tendons. Press **OK** to close the **Modify Properties** dialog window.
    
    7. Repeat the above steps, until all tendons are assigned to their respective groups.

- Go to the **Grouping Dialog Window** and make only one group of tendons visible, such as distributed tendons. Once you have printed the drawing for this group, hide this group and make the next visible.

---

1. For generating fabrication drawings, tendons are grouped more extensively, assigning unique group identification to tendons of same length and profile.
Generate a single report

- Select Reports → Single Default Reports → Tendons → Graphical → Tendon Plan

- In the dialog window that opens, select the following, then click OK.
  - Tendon ID
  - Control point heights
  - Number of strands
  - Elongation (if you selected the option in data generation)
  - Stressing/dead end (if you selected the option in data generation)

Generate rebar drawing

- Select Floor Design → Rebar → Calculated Rebar Plan to compile a rebar drawing.

- Select Rebar → Visibility → Display Manager. Use the capabilities of the tools on this toolbar to view and edit the display.

- Select the reinforcement that you want to be shown on the structural drawing.

- Edit/move the reinforcement annotation to make it arrive at a clear presentation.

- Print the drawing or export it to AutoCAD, using the Export tools on the Rebar ribbon.

- In the same manner, generate other rebar drawings.

Generate compiled report for submittal to building officials.

- Select Reports → Compiled Reports → Open Report Compiler. Select the items of your choice and produce a compiled report.
Chapter 3

SIGN CONVENTION

3.1 SIGN CONVENTION RULES

3.1.1 User-Defined Actions (Forces/Displacements) and Program Reported Displacements

3.1.2 Sign Convention for Actions Reported by the Program for User Generated Manual Design Sections

3.1.3 Sign Convention for Program Generated Tabular Reports for Automatically Generated Design Sections
3.1 SIGN CONVENTION RULES

ADAPT-Floor Pro uses several sign conventions, each intended to reflect the common practice of many reinforced concrete designers. These are:

- Sign Conventions for user defined applied loads and software reported displacements
- Sign convention for the actions (forces) reported by user generated manual design sections
- Sign convention for program generated tabular reports from automatically generated design sections.

While in most instances the sign conventions are compatible among the various parts of the program, you are cautioned to interpret each of the actions reported by the program, using the associated sign convention.

3.1.1 User-Defined Actions (Forces/Displacements) and Program Reported Displacements

The positive signs of the user defined applied forces, user defined applied displacements, and program reported calculated displacements are illustrated in Fig. 3-1. Figure 3-1 does not apply to the program reported forces and moments.

![Figure 3-1: Positive Directions and Default Position of Applied Forces and Applied Displacements](build-h3.png)
3.1.2 Sign Convention for Actions Reported by the Program for User Generated Manual Design Sections

The program resolves the stresses that act on the face of a design section into six actions at the centroid of the design section. The actions consist of three forces and three moments. The six actions along with their designation are illustrated in Fig. 3-2.

For manually generated design sections, the positive sign of each of the actions is shown in Fig. 3-3. The value of the actions can be read off from the property box of the design section displayed in Fig. 3-4.
The same sign convention is used for reporting the forces generated by a manual design section in the program’s tabular compilation of the actions.\(^1\)

### 3.1.3 Sign Convention for Program Generated Tabular Reports for Automatically Generated Design Sections

In its automatically generated tabular reports, such as the sample shown in Table 3.1, the program lists the actions on the leading face of a design section, again expressed at the centroid of each design section (Fig. 3-5). Unlike the manual sections, where all six actions are reported, the automatically generated report is limited to four of the major actions as

\(^1\) This differs from the sign convention used in the tabular report for automatically generated sections.
shown with positive directions in Fig. 3-5. These are bending moment, torsion, shear normal to the slab and axial force.

![Figure 3-5](image)

**FIGURE 3-5 POSITIVE DIRECTION OF ACTIONS LISTED IN THE PROGRAM GENERATED REPORTS**

**TABLE 3.1 SAMPLE OF AN AUTOMATICALLY GENERATED TABULAR REPORT OF ACTIONS FOR AUTOMATICALLY GENERATED DESIGN SECTIONS**

<table>
<thead>
<tr>
<th>Design section</th>
<th>Moment</th>
<th>Shear</th>
<th>Axial</th>
<th>Torsion</th>
</tr>
</thead>
<tbody>
<tr>
<td>102000</td>
<td>-31.209</td>
<td>-20.096</td>
<td>-3.401</td>
<td>2.916</td>
</tr>
<tr>
<td>102001</td>
<td>4.63</td>
<td>0.087</td>
<td>-8.769</td>
<td>-3.69</td>
</tr>
<tr>
<td>102002</td>
<td>21.504</td>
<td>-11.101</td>
<td>-2.564</td>
<td>-5.403</td>
</tr>
<tr>
<td>102003</td>
<td>33.706</td>
<td>-3.878</td>
<td>-1.864</td>
<td>-9.488</td>
</tr>
<tr>
<td>102004</td>
<td>7.666</td>
<td>-0.075</td>
<td>-11.531</td>
<td>-2.554</td>
</tr>
<tr>
<td>102005</td>
<td>36.128</td>
<td>1.821</td>
<td>0.56</td>
<td>-8.532</td>
</tr>
<tr>
<td>102006</td>
<td>27.216</td>
<td>8.136</td>
<td>3.006</td>
<td>-7.477</td>
</tr>
<tr>
<td>102007</td>
<td>12.591</td>
<td>8.14</td>
<td>3.033</td>
<td>-7.817</td>
</tr>
<tr>
<td>102009</td>
<td>-42.483</td>
<td>27.74</td>
<td>10.384</td>
<td>-20.19</td>
</tr>
<tr>
<td>102010</td>
<td>-92.597</td>
<td>27.756</td>
<td>10.716</td>
<td>-21.382</td>
</tr>
</tbody>
</table>
Chapter 4

STRUCTURAL MODELING

4.1 STRUCTURAL MODELING RULES ................................................................. 21
    4.1.1 Default Position of Structural Components ........................................... 21
    4.1.2 Changing the Location of Structural Components ................................. 22
    4.1.3 Verification of Geometry of the Structural Model ................................. 23
    4.1.4 Position of Supports and Significance of Support Position ..................... 23

4.2 BOUNDARY CONDITIONS – RESTRAINTS/RELEASE ............................... 25
The basic steps of structural modeling are outlined in the Modeler User Manual. In this Chapter we will review several of the salient features of modeling for complex structures and improvements in analytical efficiency.

4.1 STRUCTURAL MODELING RULES

4.1.1 Default Position of Structural Components

Each floor level is modeled together with the supports immediately below and above it. The supports can be columns, walls, springs, points or lines. Soil supports are treated separately in the ADAPT-MAT manual. The geometry of a floor is defined with respect to a horizontal plane. The distances from the top of different parts of the floor to this horizontal plane determine the changes in the elevation of the floor, if any. This horizontal plane is referred to as the Current Plane. It is also referred to as the Current Reference Plane. Figure 4.1-1 shows an example of a current reference plane and the default positioning of several structural components with respect to this reference plane. For an example, note that the top of the beam and the drop cap are lined up with the current reference plane. When a structural component, such as a slab region, does not lie at the location shown, it has to be moved to its correct position. This is done using the “offset” feature of the program. The offset feature is described later in this document.

FIGURE 4.1-1
4.1.2 Changing the Location of Structural Components

The supports below the floor system are defined with reference to the current plane and bottom plane (Fig. 4.1-2). Similarly, the supports above the floor system, such as columns, walls, and ramps, are defined with respect to the current plane and the top plane. The top and bottom planes are used by the program to determine the height of each of the supports. For example, the length of an upper column is defined by the position of its top and bottom ends. The position of the bottom end is defined with respect to the bottom, and the position of the top end with respect to the top plane. The default of the program is that each wall or column support extends between the current plane and either the top or bottom plane.

There are two conditions when you may wish to change the end position of a structural component along the vertical plane. The Offset and Establish Component Connectivity functions do this for you.

- **Offset.** For components that do not extend over the entire length between two adjacent reference planes, such as the short upper column shown in Fig. 4.1-2, the offset (Z distance) from the associated reference plane is used to adjust the end of the member. Create the structural component, then open its property box and change its offset to the position of your choice.

![FIGURE 4.1-2](image)

- **Establish Component Connectivity.** The default position of the structural components with respect to the current plane is shown in Fig. 4.1-1. As a result, a lower column will have an overlap with
the slab, since both of them are adjusted to line up with the reference plane. However, once created, a structural component can be automatically adjusted by the program to its natural position. For example, the top of a column below a slab will be automatically moved to the soffit of the slab. Hence, there will be no overlap or interference between the top of a column and slab region. This is achieved if you click on the Establish Component Connectivity from Model \(\rightarrow\) Preprocessing.

4.1.3 Verification of Geometry of the Structural Model

Figure 4.1-3 illustrates the geometry of a complex slab in elevation. In this model, the position of each slab region is identified by its offset. You can access and adjust the offset value for each slab through its property box. The position of the supports (upper and lower columns) can be adjusted by using either the Offset tool, or the Establish Component Connectivity tool. The second tool is faster, since it automatically repositions all the walls and columns of your structural model to their correct locations.

In part (b), the slab region marked “F” is assumed to be at the level of the reference plane. The position of the remaining components of the floor system are defined by their Z-offset. For example, region “D” has a negative offset \(Z_F\), while region “E” has a positive offset \(Z_E\).

It is strongly recommended that you verify the details of the geometry of the structure at complex locations. Do so by using the Create a Cut at Specified Location tool \(\leftarrow\) from the Home \(\rightarrow\) Draw panel.

4.1.4 Position of Supports and Significance of Support Position

Supports, as illustrated in Fig. 4.1-4, are positioned at the reference line when generated first by the program. If need be, they have to be shifted to their final location prior to the analysis.

The position of supports on the structure can significantly impact the solution. In simplified analysis, supports are implicitly assumed to be positioned at the centroid of a section. Figure 4.1-5 illustrates the condition of a simple beam, where the solution is affected by the position of supports. Your structural model is generally far more complex. This is discussed in greater detail in the section on Boundary Conditions – Constraint/Release.
(a) ELEVATION

(b) OFFSET IDENTIFICATION

ADJUSTMENT OF LEVELS USING OFFSET

FIGURE 4.1-3

REFERENCE PLANE (CURRENT PLANE)

DEFAULT POSITION OF SUPPORTS WITH RESPECT TO REFERENCE PLANE

FIGURE 4.1-4
4.2 BOUNDARY CONDITIONS – RESTRAINTS/RELEASE

In the terminology of ADAPT-Builder, the connection between two structural components, such as a beam and a column, is defined by the “release” condition. This is shown symbolically in Fig. 4.2-1 for point B between two structural components. If no release is specified, the program assumes rigid connection between the components, such as point D in the same figure. It is assumed that all structural components are rigidly connected together unless “released” by you. The release can be freedom of “translation” or “rotation.” The translation allows one component to displace relative to the other in the direction specified by you. The freedom of rotation allows each component to rotate independent from the other, about the axis defined by you. The default directions are the global axes.

The connections between one or more structural components to the supports of the structure are defined by “restraints,” such as points A and C in Fig. 4.2-1. Restraints are the property of “supports.” You first need to place a support at the location of your choice, and then define the manner in which you expect the support to behave. The default of the program for a support is full fixity. That is to
say, neither translation nor rotation is allowed at the location of the support. But, you can open the restraint properties of the support and change them as needed.

**FIGURE 4.2-1**

**Figure 4.2-2** shows a beam resting on two columns. The columns are supported at their base by two user-defined “supports.” The supports are shown by the small triangles. The type of fixity of the column at its base is defined in the property dialog window of the “supports.”

**FIGURE 4.2-2 ELEVATION OF A BEAM AND TWO COLUMNS**

The beam is shown resting on the column. The default of the program is full fixity between the top of the column and the beam. However, you can change the transfer of force between one and the other by specifying a “release” either at the end of the beam or the top of the column.

**Release.** The dialog box for the release at the top or bottom of a column is given in **Fig.4.2-3**. As an example, referring to **Fig. 4.2-3**, the dialog box will be used to define the rotational fixity at the top of the column (imposition of a hinge between the beam and column).
Restraint. The condition of the support shown at the base of each of the columns in Fig. 4.2-2 is defined by the restraint dialog box shown in Fig. 4.2-4.
Chapter 5

POST-TENSIONING

5.1 TENDON GEOMETRY ........................................................................................ 31

5.2 TENDON PROPERTIES ....................................................................................... 35
  5.2.1 Tendon Shape ............................................................................................ 35
  5.2.2 Cross-Sectional Geometry ......................................................................... 35
  5.2.3 Material Properties .................................................................................... 38

5.3 POST-TENSIONING SYSTEM, STRESSING AND TENDON FORCE ............ 39
  5.3.1 Post-Tensioning System ............................................................................ 39
  5.3.2 Effective Force Method of Design ............................................................ 40
  5.3.3 Variable Force Method of Design ............................................................. 40
  5.3.4 Tendon Friction ......................................................................................... 41
  5.3.5 Tendon Stressing ....................................................................................... 42
  5.3.6 Long-Term Stress Losses ........................................................................... 42

5.4 TENDON GENERATION – TENDON RIBBON ................................................ 43
  5.4.1 Criteria Panel ............................................................................................. 43
  5.4.2 Settings Panel ............................................................................................ 44
  5.4.3 Model Panel ............................................................................................... 44
  5.4.4 Modify Panel ............................................................................................. 45
  5.4.5 Visibility Panel .......................................................................................... 46
  5.4.6 Design Panel .............................................................................................. 47
  5.4.7 Single Tendon Generation ......................................................................... 47
  5.4.8 Tendon Mapping – Banded and Distributed .............................................. 49
  5.4.9 Dynamic Tendon Modeling in Elevation (DTM) ...................................... 60
  5.4.4 Tendon Interference ................................................................................... 61

5.5 SHOP DRAWING PANEL (ADD-ON MODULE) .............................................. 62
  5.5.1 Friction and Elongation .............................................................................. 62
  5.5.2 Felt 3D Report ........................................................................................... 63
5.5.3 Drawing Editor ............................................................................................................. 63
5.5.4 Display Tendon Heights .............................................................................................. 64
5.5.5 Tendon Spacing Tool ................................................................................................. 65
5.1 TENDON GEOMETRY

Each tendon consists of one or more tendon spans. Each tendon span has a well-defined “Shape.” The “Shape” can be a simple parabola, a straight line, a reversed parabola or otherwise. There are a number of pre-defined shapes to assist you in rapid modeling of a long tendon that may consist of several tendon shapes along its length. A tendon span is independent from the span of the structure between two supports (structure span), although in many instances you may select a tendon shape for each structure span. In ADAPT Builder 2017 and later versions the program has several improvements to tendons modeling as well as the implementation of a Tendon Optimizer that are not discussed in this section. For description on the new modeling improvements and the use of the Tendon Optimizer please refer to the supplemental documentation found in the software. Manuals and supplemental manuals can be found in the software by going to Help->Documentation.

Figure 5.1-1 shows the elevation of a tendon with six spans. Each span has a geometry that can be defined by the available “shapes” in the program’s library.

![Diagram showing tendon spans and control points](attachment:wiSCO08.png)

**ELEVATION**

**EXAMPLE OF TENDON SPANS, CONTROL POINTS AND ELEVATION PARAMETERS**

**FIGURE 5.1-1**

The tendon shapes currently available in the program’s library are broken down into span tendons and cantilever tendons. These are (see Figs. 5.1-2 and 5.1-3):
Shapes suitable for structural spans

- Reversed Parabola (includes simple parabola)
- Extended Reversed Parabola
- Partial Parabola
- Harped
- Straight

Shapes suitable for structural cantilevers

- Parabola Up
- Parabola Down
- Harped
- Partial Parabola

FIGURE 5.1-2
At creation, the program places each tendon within the outline of the concrete slab or beam at the location of the tendon. In doing so, the program observes the minimum cover you have specified at the start, end and low point of each tendon. Later, you will read how to view the tendon in elevation within its concrete outline and edit its geometry, if needed.

The shape of a tendon, and the values for its centroid to the top and bottom fibers (CGS) of the concrete outline, are given in the property box of the tendon (Fig. 5.1-4).
FIGURE 5.1-4 TENDON PROPERTY BOX

The Shape/System/Friction input tab contains both tabular and graphical interactive screens. The tabular data includes shape, span length, control points, inflection points, friction parameters and system type. All fields are editable except for the span length which can only be changed in the main modeling screen. To select a shape for a tendon span, click on the shape combo box for the desired span in order to activate the specific span and then using the combo box assign a shape. The Typical input row (top row) can be used if several rows in a column have the same value. Creation of tendons and other properties of it are discussed later in this section.

You can also add and delete the first and last spans in the current, displayed tendon by using the “Insert” and “Delete” tabs below the tabular input screen. The minimum radius of curvature can be assigned and the actual value is reported in the graphical screen at each high and low point along the length of the tendon. Where the radius of curvature does not meet the user-specified minimum value, the graphical output will report this as “NG” and will be highlighted in red.

In addition to the reporting of radius of curvature, the graphical screen reports CGS at high and low points along the length of the tendon, span length, stressing ends (dead and/or live) and the average uplift (force/length) for each span. The latter value can be used to expedite a hand validation of % balanced load.
When the post-tensioning design option of “Calculated force” is set under the Stressing input tab, the graphical screen in the Shape/System/Friction input can be toggled to display the following output:

- The calculated elongation at stressing ends
- Jacking ratios at stressing ends
- The average and maximum stress ratios (actual stress/ultimate stress) along the length of the tendon

You can initiate the calculation of the aforementioned data by pressing the “Friction and Elongation Calculation” button located at the bottom of the screen. This function is only available with the Post-Tensioning Fabrication (Shop) Drawing module. When the post-tensioning design option of “Effective force” is used, the button is grayed out and the graphical screen will default to the tendon and span geometry.

The graphical screen can be stretched so that you can view any span or a combination of spans at a time. To stretch the screen, place your cursor inside the graphical view and use the mouse roller to stretch in or out. The view can also be panned by clicking on the mouse roller and moving left or right.

5.2 TENDON PROPERTIES

5.2.1 Tendon Shape

The shape of a tendon determines its profile in the vertical plane. This is discussed in the preceding section. A tendon can also have a shape other than a straight line on the horizontal plane. This is discussed in a later section on Tendon Generation. A graphical representation of the shape selected in the pull-down menu can be viewed by selecting the tendon profile icon. The program duly accounts for the effects of tendon curvature on the horizontal plane.

5.2.2 Cross-Sectional Geometry

A tendon is made up of one or more strands encased in a sheathing. Figure 5.2-1 shows a single strand with a plastic wrapping (mono-strand). The alternative, multi-strands in a single duct, is shown in Fig.

---

1 Mono-strand refers to tendons in which strands are pulled one at a time. In multi-strand tendons the strands within a duct are all pulled at the same time.
5.2-2(b). Three values should be specified for the cross-section of each tendon. These are (Fig. 5.2-3):

- Number of strands
- Cross-sectional area of each strand
- Tendon diameter

The number of strands and the cross-sectional area of each strand determine the amount of steel available for prestressing. The diameter of the duct, along with the minimum specified concrete cover, is used to determine the location of the tendon’s centroid (CGS) and also to avoid interference of intersecting ducts. The tendon’s centroid (CGS) is the centroid of its strands. For multi-strand tendons, this is different from the duct’s centroid. The distance between the tendon’s centroid and the duct centroid (shown as 0.43” – 11mm in Fig. 5.2-2) is referred to as “z” distance and is used in the preparation of fabrication (shop) drawings.

The structural drawings show the distance of the tendon’s centroid (CGS) from the member’s soffit. The fabrication drawings show the distance of the duct’s underside to the soffit of member².

² BUILDER Fabrication (Shop) Drawing Module uses the distance “z” to determine the chair heights.
The total area of prestressing steel for each tendon is obtained from the data entered in Fig. 5.2-3. It is the product of the area per strand multiplied by the number of strands. The tendon diameter entered in the same figure is used only to check the interference of tendons in space, and in the fabrication (shop drawing) module of the program.
5.2.3 Material Properties

There are two types of material properties generally specified for a tendon. One is the material property of the prestressing steel (strands in most cases). The other defines the friction properties between the prestressing steel and its sheathing (duct). In this section we consider the properties of the prestressing material. These are:

- \( f_{pu} \) (specified ultimate strength of prestressing material)
- \( f_{py} \) (yield stress of prestressing material)
- \( E_{ps} \) (modulus of elasticity of prestressing material)

Material properties are specified in the dialog box as shown in Fig. 5.2-4, which can be opened from the Criteria \( \rightarrow \) Material Properties \( \rightarrow \) Prestressing. Not all the tendons in your project need to have the same material properties. You can define more than one material property for prestressing steel in Fig. 5.2-5.

![FIGURE 5.2-4 DIALOG BOX FOR MATERIAL DEFINITION OF PROPERTIES OF PRESTRESSING STEEL](image)
5.3 POST-TENSIONING SYSTEM, STRESSING AND TENDON FORCE

5.3.1 Post-Tensioning System

Both bonded (grouted) and unbonded systems of post-tensioning are covered in the program. You can define each tendon individually as bonded or unbonded. In addition, for a given tendon, you have the option of defining one or more of its spans as bonded, and the remainder unbonded.

The assignment of bonded, or unbonded system to each span takes place through the combo box shown at the far right of Fig. 5.3-1.
5.3.2 Effective Force Method of Design

Effective force design is used primarily in North America. With this method, you define the required post-tensioning force at each location in the floor system, along with the associated tendon profile. Hence, the structural drawings show the final post-tensioning force after all stress losses (effective force) and the tendon profile. The post-tensioning supplier (contractor) can then convert your drawings (structural drawings) to fabrication (shop) drawings, on which the supplier will show the actual number and position of each tendon, together with stressing and elongation values. The value of the force you will use in your design is the force after all losses have taken place. These include friction, seating loss and long-term losses.

In common building construction, the effective force for unbonded tendons is calculated on the basis of 1,200 MPa (175 ksi) times the tendon area. The dialog window for the specification of effective force is shown in Fig. 5.3-2. Note that the force entered in this dialog window is the product of the effective stress multiplied by the area of each strand.

![FIGURE 5.3-2 DIALOG BOX FOR SPECIFICATION OF EFFECTIVE FORCE IN TENDON](image)

5.3.3 Variable Force Method of Design

With variable force design, you define the number, location, profile, and stressing of each tendon on your drawings. The program calculates the force immediately after seating of each tendon using the tendon’s geometry, its friction, seating parameters and the jacking force. The forces calculated immediately after stressing are then adjusted for long-term
stress losses before being used for code compliance in serviceability and strength requirements\(^3\).

To use this option, you must define the friction and stressing characteristics of each tendon. These are defined in the following sections.

### 5.3.4 Tendon Friction

The friction properties of a tendon are defined by the following two friction coefficients:

- \( \mu \) = coefficient of angular friction (meu); and
- \( K \) = coefficient of wobble friction (radians/ft or radians/m).

Each tendon span can have its own friction properties. This enables a tendon to be partly external, partly unbonded and partly bonded over its length. The friction properties of each tendon (or tendon span) are entered in the right data entry frame of the dialog window shown in Fig. 5.3-3. The input fields for the friction values appear only if you specify “Calculate Force” in the stressing tab of the tendon property box.

![FIGURE 5.3-3 DIALOG WINDOW FOR FRICTION PROPERTIES](image)

Obviously, for external tendon spans, you specify zero for the friction coefficients.

A full account of tendon stress losses, both due to friction and long-term effects, is given in an ADAPT-Technical Note\(^4\).

---

\(^3\) In this method of analysis, the tendon force for each finite element cell of the floor system is based on the force calculated on that location from the friction and other stress losses. The program does not use the now obsolete and simplified “load balancing” or “equivalent load” procedures, where a tendon is removed from its housing and substituted by an upward uniform force over each span.
5.3.5 Tendon Stressing

Each tendon can be stressed at either or both ends. At each end the stressing can be characterized by one of the following manners (Fig. 5.3-4):

- Specify jacking force, typically 80% of tendon’s ultimate strength (0.80*fpu*tendon area);
- Specify tendon stress at stressing end and prior to tendon seating, typically 80% of tendon’s ultimate stress (0.8*fpu); and
- Ratio of jacking stress to ultimate strength of tendon (typically 0.80).

FIGURE 5.3-4 DIALOG BOX FOR SPECIFYING TENDON STRESSING

5.3.6 Long-Term Stress Losses

Stress losses due to creep, shrinkage, relaxation in prestressing and “elastic shortening” are grouped as a lump sum and must be entered by you in the data field “Long-term stress loss.” The current version of the program does not calculate the long-term losses automatically. It is scheduled for release in future releases.

Typical long-term loss values for building structures are 75-100 MPa (11-15 ksi). Grouted tendons tend to have a larger friction loss, but a lesser long-term loss at the critical locations in a member.

The long-term stress losses are specified in the tendon’s property dialog window, only if you select the “Calculate Force” option (Fig. 5.3-4).

In ADAPT-Builder 2019 and later versions of the software, when the PT Shop Drawing module is enabled, the program gives new input and functionality for the calculation of long-term losses for unbonded tendons and bonded tendons stressed at the same time. For more information on the use of this feature refer to the ADAPT-Builder 2019 New Features Supplement manual.

5.4 TENDON GENERATION – TENDON RIBBON

5.4.1 Criteria Panel

Prestressing
Opens the Material dialog window for defining prestressing properties.

Allowable Stresses
Opens the Criteria – Allowable Stresses menu for defining code required allowable tension and compression concrete stress and non-prestressed and prestressed steel stress. Applies only to the PT design scope when tendons are modeled as part of a slab or beam. For some applicable design codes, input of allowable crack width is also input in this dialog.

Tendon Height
Opens the Criteria – Tendon Height Defaults menu for defining the distance from top and bottom slab or beam surface to the CGS of tendons at supports and span. Use this menu to input the incremental distance for adjustment of the CGS from slab soffit for tendon mapping and graphical tendon adjustment in elevation.
5.4.2 Settings Panel

Tendon Settings
Opens the Tendon Settings dialog menu to control modeling parameters and tolerances for tendons. Use this to disable spline tendon modeling and default to linearized tendon input.

5.4.3 Model Panel

Add Tendon
Adds a single tendon to the structure by graphical or coordinate input of tendon anchor and high point (control point) locations. The default tendon shape reverse parabolic. Select ESC or right-click Exit to close the command. Double-click on the tendon to modify Tendon Properties.

Map Distributed
Maps a selected “master” tendon over a region by selection of master tendon nodes to user-specified locations. Define the master tendon first, double-click to open the Map Distributed Tendon dialog menu and select coordinates 1 of N for mapping.

Map Banded
Maps tendons to selected design strips for the user-defined criteria set in the Map Banded Tendons dialog menu. Design strips are required to be generated before mapping.
5.4.4 Modify Panel

**Tendon Editor**
Opens the Dynamic Tendon Editor for rapid modification of tendon CGS, number of strands, anchorage, and spline override. Use Top View in Single-Level mode for recommended use.

**Trim/Extend Tendons**
Auto-adjusts tendon anchor locations to the slab edge. Use Tendon-Tendon Settings to adjust the tolerance distance.

**Insert Point**
Adds a new control point to the selected tendon on the current plane. Use this to create a new tendon span on an existing tendon.

**Remove Point**
Removes a control point on a selected tendon on the current plane and is only active when a single tendon is selected. Use this to remove a span from an existing tendon.

**Insert Swerve Point**
Adds a swerve point to the selected tendon on the current plane. Use the swerve point to control lateral curvature in the tendon span where inserted in the XY plane. A maximum of 3 swerve points can be added to a span.

**Remove Swerve Point**
Removes a swerve point on the selected tendon on the current plane. Use the swerve point to control lateral curvature in the tendon span where inserted in the XY plane. A maximum of 3 swerve points can be added to a span.
5.4.5 Visibility Panel

Tendon Display Manager

Opens the Tendon Display Information dialog for selection of tendon properties, curvature, stressing and geometry to be displayed. Use Visibility – Select/Set View Items to change the symbol and text height.
Display/Hide Tendons
Displays on/off tendons.

Tendon Intersection Detector
Detects the intersection of two or more tendons in the structure and marks the intersection points.

Display/Hide Radius of Curvature
Displays on/off the radius of curvature of the tendons end, high and low points in display and marks as NG or OK based on minimum radius set in the tendon properties dialog.

Display Tendon Elevation
Creates tendon elevations for the selected tendons at the user-defined insertion point.

5.4.6 Design Panel

Tendon Optimizer
Opens the Tendon Optimizer dialog for optimization of tendon design for P/A, %bal load and allowable stresses for the selected tendons within a span. Intended for Single-level use and the level should be analyzed first. Open the Tendon Optimizer and select tendons in the span to be optimized.

5.4.7 Single Tendon Generation

Each tendon consists of one or more spans. A tendon span is a length of tendon that has a pre-defined geometry (shape). A tendon span can be a simple parabola, a reversed parabola, or other shapes that were described earlier in the section on Tendon Geometry. New tendons are generated by clicking on the Create Tendon tool from Tendon → Model. Click at the two ends of each tendon span as you move the cursor along the path of the
tendon you intend to create. This will be treated as a continuous, multi-
span tendon until you hit the “C” or “end” key on the keyboard\textsuperscript{5}.

A tendon can be either a straight tendon, a “spline” tendon, or a “fillet”
tendon. Spline tendons can be curved in plan using “swerve points”. In the
vertical plane, the tendon will have the shape you specify in its property
dialog box. In Fig. 5.4-1 the tendon is a spline tendon swerved on plan to
avoid an opening between two columns. The swerve of the tendon is
modeled through “swerve points”. The height of the tendon from the soffit
of the slab is adjusted through the CGS parameters of each tendon span.
The three-dimensional view of the adjusted tendon is shown in Fig. 5.4-2.

Please refer to the supplemental manuals in the program for information
on the use of Spline Tendons in the software. For the use of Fillet Tendons
please refer to the ADAPT-Builder 2019 New Features Supplement
manual.

\hspace{1cm}

\textbf{FIGURE 5.4-1 TENDON WITH CURVATURE ON PLAN}

\hspace{1cm}

\textbf{FIGURE 5.4-2 THREE-DIMENSIONAL VIEW OF TENDON WITH
CURVATURE ON PLAN}

\textsuperscript{5} Alternatively, you can right click the mouse and select “Close.”
Within each span, the tendon you have marked will automatically assume the default shape you have selected. For example, if the default shape selected is “reversed parabola,” the tendon span created will have the shape of a reversed parabola. The program automatically detects the concrete outline within which the span is created and positions the high and low points of the tendon shape at the clearances specified. The clearances for each tendon are defined in its property box. Obviously, once generated, you can view a tendon in elevation and adjust its profile, if need be.

### 5.4.8 Tendon Mapping – Banded and Distributed

Tendon mapping is a process whereby you can replicate an existing tendon over a region of your choice—with some degree of intelligence from the tendon. The inbuilt intelligence in the current version of the program is as follows:

- The replicated tendon recognizes the change in the boundary of the region it is intended to cover and automatically adjusts its individual span length and consequently its total length to cover the entire area.
- The replicated tendon retains the minimum cover specified from the top and bottom, while cloning itself over regions of different length and depth. It also automatically adjusts its inflection point, or other parameters that define its shape.
- If there is a step, change in slab thickness, or a beam, the replicated tendon recognizes the change and automatically modifies its geometry to match the geometry of the concrete outline.
- The tendon can be automatically replicated using one or more of the following criteria defined by the user:
  - Minimum and maximum average precompression (P/A);
  - Minimum and maximum fraction of self-weight to be balanced;
  and
  - Maximum spacing between adjacent tendons,

The following describes the automatic generation of tendons in detail.
Map Distributed Tendon

This tool is used to cover an entire slab area with uniformly distributed tendons, each with the same cross-sectional area, material properties, stressing conditions, and number of tendon spans, and each also adjusted to the geometry of its location.

To map the distributed tendons, do the following:

- Select the tendon you want to replicate.
- Click on the map distributed tool. The dialog window shown in Fig. 5.4-3 opens. The layout can either be optimized based on average precompression and percent of balanced self-weight or simply replicated by a given number input by the user. The option is also given to define the parameters by which the spacing should be determined. If do not optimize is selected, the total number of tendons will be one more than the number of spaces you enter in the data field of this dialog window.

![FIGURE 5.4-3 DIALOG WINDOW FOR MAPPING DISTRIBUTED TENDONS](image)

We illustrate the mapping of a single span tendon over a region in the following steps (Fig. 5.4-4).

- Draw a single tendon anywhere on a slab region (part –(a) of the figure).
- Click on the tendon (select it), then click on the Map Distributed Tendons.
• With Do not optimize, replicate selected, enter 5 for the number of tendons to be duplicated.

• Next, follow the instructions that appear at the bottom of the screen. The instructions direct you to click at a point to represent the uppermost corner of the field over which you want the tendon replicated, and then click at the uppermost right corner. Parts (a) and (b) of the figure show the two extreme corners selected.

• When you click on the second point, the tendon replicates itself.

The area, shape and other parameters of the tendons will be identical to the master tendon used for mapping part (a) of the figure.

The same procedure is followed for a slab region shown in Fig. 5.4-4 (d) through (f). When mapping over a slab region, make sure that:

• you use the snap tool (Snap to Nearest in this case) and snap on the slab boundary, and

• snap at a point somewhat away from the slab edge in order to avoid a tendon falling exactly at slab edge. Typically, 150mm (6 inch) is a reasonable distance.

The three-dimensional view of the mapped tendon over the slab region is shown in Fig. 5.4-5.
Tendon mapping over two or more regions is done in a similar manner. The steps are illustrated in Fig. 5.4-6, with a three-dimensional view of the outcome in Fig. 5.4-7. Since there are two regions, the master tendon selected for mapping (Fig. 5.4-6 (b)) needs to have two spans.
The procedure for tendon mapping using the optimized option works in a similar manner as explained previously except that the number of tendons is calculated using user predefined parameters.

The number of tendons distributed will be calculated based on the average precompression and percent balanced dead load which is input by the user. The program uses these parameters to optimize a number of tendons for the given region where the tendon is to be distributed. Limits for the spacing can also be defined by parameters entered by the user such as enabling to enforce 8 times slab thickness or setting a maximum spacing value. The tendon properties such as number of strands, effective force and shape will be inherited from the initial tendon selected.
Example

Consider the column-supported slab shown in (Fig. 5.4-8). And, let us assume that we want the distributed tendons to be placed from left to right, and the banded tendons in the up-down direction. The three support lines drawn in part (b) of the figure break the slab into four parts in the up-down direction.

We start by drawing a master tendon next to the slab edge (b). The master tendon will be drawn with four spans, since there are four regions. We open the property box of this tendon and define the minimum cover, tendon area, profile, stressing and other features that we want common among all the distributed tendons. In the selection of profiles, we choose a cantilever profile for the first and last spans.

FIGURE 5.4-8 TENDON MAPPING OF A COLUMN SUPPORTED SLAB

The steps to follow are illustrated in parts (a) through (d) of Fig. 5.4-9. Part (e) of the figure shows the completed mapping. Part (f) is its three-dimensional view.
Map Banded Tendon

This tool is used to generate tendons that are banded along a user-specified guideline (Support Line). It generates a group of concentrated tendons on each side of the guideline. Each group will have the same total cross-sectional area, material properties, stressing conditions, and number of tendon spans, but each group will also adjust itself to the geometry of its location.

The procedure for mapping of banded tendons is illustrated by way of the same slab used in the preceding example. Click on the map banded tendons tool. You will be prompted to select a support line. In this example, the support line along the central columns is selected. This will
activate the dialog window for banded tendons which contains four sections as shown (Fig. 5.4-10).

![Map Banded(Grouped) Tendons](image)

**FIGURE 5.4-10 DIALOG WINDOW FOR BANDED TENDONS**

If the design strips had been previously generated the option to use the design strip width for the tributary would be available. If this is not the case the tributary width can be manually entered.

As in the case for the optimized distributed tendons, the banded tendons are automatically calculated using the average precompression and percentage of balanced dead load values entered by the user. The option is also given to idealize as two sets of tendons with a user defined offset (2ft) or to distribute the tendons at a specific spacing. If the second option is selected, the number of strands per tendon will become active and the program would calculate the number of tendons based on the total number of strands required. For common building structures and unbonded tendons this distance is 600 mm (2ft). The total width of the band would be 1200 mm (4ft). For this example, the default of 600 mm (2ft) was selected.

**Figure 5.4-11 (b)** shows the band generated along the support line selected at specified spacing of 2ft. The three-dimensional view of the band created for the central support line is shown in **Fig. 5.4-11(c)**.
The same procedure is repeated for the creation of banded tendons along the other two support lines in the up-down direction.

Since the tendon bands are created with a constant offset from their guide (support line), it is possible that their ends will not coincide with the slab edge, such as shown in Fig. 5.4-12 (a). In such cases, you need to pick the end of the tendon and bring it to either the slab edge, if it is a stressing end, or within the slab, if it is a dead end. The steps are illustrated in Fig. 5.4-12.

---

6 The cross mark at one of the tendon intersections indicates interference of the two tendons in space. That is to say at the location marked, the two tendons partially or fully overlap. This is explained in a later section of the manual.
FIGURE 5.4-11 STEPS IN THE CREATION OF BANDED TENDONS

(a) Select a support line for mapping the banded tendons. The band will be concentrated over a width along the selected support line.

(b) The band created automatically using the values as input in the banded tendon dialog box.

(c) Three-dimensional view of the slab showing the banded tendons over the central line.
FIGURE 5.4-12 ADJUSTMENT OF TENDON END TO SLAB EDGE

(a) Pick the tendon end that is outside the slab edge and drag it to the slab edge.

(b) Snap the tendon end to the slab edge using the “snap to nearest tool.”

(c) The ends of both banded tendons are adjusted to slab edge.
5.4.9 Dynamic Tendon Modeling in Elevation (DTM)

With the Dynamic Tendon Modeling of the program, you can view one or several tendons in elevation, each displayed within the outline of the concrete that contains it. More importantly, you can graphically edit each in a dynamic mode. That is to say, you can pick one of the hot spots of a tendon with the mouse, and drag it to a new location. The tendon profile adjusts itself to the new location graphically, and updates automatically the associated data in your structural model. The data updating is done in the background and will be fully transparent to you. Obviously, you can double click on each tendon, whether on plan or in elevation and open its property window to view/edit the updated values.

Select one or several tendons and click on the Display Tendon Elevation tool. The program will display the tendon elevations at an insertion point of your choice. For clarity of view, you may increase the display scale of the members depth.

Figure 5.4-13(a) shows a floor plan consisting of two slab regions, each with a different thickness and a beam. A tendon, as shown, was simply drawn on plan with the mouse. The program automatically detects the properties of the floor system and profiles the tendon as shown in part (b) of the figure. To display the elevation on the screen, pick the tendon and then click on the Display Tendon Elevation tool.

![Plan of Slab, Beam and Tendon](a_plan_of_slab_beam_and_tendon.png)

![View of Beam Within the Concrete Outline](b_view_of_beam_within_the_concrete_outline.png)

FIGURE 5.4-13 VIEW OF TENDON WITHIN CONCRETE OUTLINE

---

7 From Settings pull-down menu, select Distortion Scale and increase the scale factor in Z-direction.
The hot spot of the tendon will become visible, once you click on it. You can see the distance between the centroid of the tendon (CGS) and the soffit of its concrete container by clicking on the Tendon Display Manager tool and displaying the Control Points. (Fig. 5.4-14).

In practice, tendon heights are rounded up or down to a user-selected value (0.25 inch for American practice, and 5mm for SI practice). You can set the rounding value and force the tendon to snap to the nearest rounding of your choice while you edit a tendon dynamically. Use Tendon ➔ Criteria ➔ Tendon Heights (Fig. 5.4-15) to adjust the round up value as indicated in the figure.

In addition to dynamically being able to edit tendons in elevation ADAPT-Builder 2017 and later versions now gives the user the ability to edit tendon properties like control point height in plan as well. For more information on using the Dynamic Tendon Editor to edit tendons in plan please refer to the Supplemental Manuals in the program. The manuals can be found by going to Help ➔ Documentation.

5.4.4 Tendon Interference

You can have the program search through the tendon layout and indicate the locations where tendons intersect. The program can detect full or
partial intersection. In detecting the tendon intersection, the program uses the value of the tendon duct that you have entered in the property box of the tendons. Each tendon will be checked using its specific tendon duct for possible intersections with tendons that may have other duct diameters. In the case of flat ducts, use the width of the duct. This is the dimension that occupies space in the vertical plane and can interfere with the path of other ducts.

To start the detection of tendon interference, simply click on its tool. The locations where tendons interfere will be marked with a cross with a circle in the center as is shown in Fig. 5.4-12.

You can also select two or more tendons and detect the intersection among them. Clicking on the tool a second time will turn off the tendon intersection markings.

5.5 SHOP DRAWING PANEL (ADD-ON MODULE)

5.5.1 Friction and Elongation

Calculates friction loss and elongation for tendons set to Calculated Force option in Tendon Properties – Settings. Select tendons and then the tool to perform the calculations.

<table>
<thead>
<tr>
<th>Tendon(ID,Label)</th>
<th>Jack(1st,2nd)</th>
<th>Seating(1st,2nd)</th>
<th>Elongation (1st,2nd,Total)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>kN</td>
<td>mm</td>
<td>mm</td>
</tr>
<tr>
<td>1,Tendon 1</td>
<td>145824.000,145824.000</td>
<td>6,6</td>
<td>80,0,80</td>
</tr>
</tbody>
</table>

This operation is very time consuming, since the proximity of each tendon in space is checked against all other tendons in the structure.
5.5.2 **Felt 3D Report**

Produces combined prestress short- and long-term loss and elongation report for tendons set to the “Calculate Force” method.

**Single Strand**

Option to report losses as a function of a single strand when the number of strands designated exceeds 1.

5.5.3 **Drawing Editor**

Contains tools for modeling and drawing customization of tendons for shop drawing production including general tools, chair grouping, tendon color representation and construction joints.

**Tools** – Options provided to edit modeled tendons. Including:

- Converting tendons from straight or spline representation to fillet-radius representation. The default radius for in-plane swerve locations is 20ft (6m) as set in the the individual Tendon Properties menu and from Modify>Modify Selection>Tendons.

- Removal of all non-auto swerve points on spline or fillet-radius tendons. Auto swerve points are added to anchorage locations of tendons with a default offset.

- Update of tendon and construction joint intersections when a tendon and/or construction joint is removed or relocated.

**Chair Groups** – Options provided for support bar spacing and support bar extension each side of the control location. After entering the value, tendon locations that can be edited will be enabled with a yellow circle. Select the location and Apply the values set. The program will report the support bar height and number of spaces with spacing dimension.
**Colors** – Provides options to group tendons by customized colors for shop drawing production.

**Construction Joints** – Options provided for drawing construction joints as discontinuous and continuous (with varying anchor options) and pour sides and labels relative to the modeled joints. The joints are used to virtualize tendon loss and elongation calculations relative to the joint type and location.

### 5.5.4 Display Tendon Heights

Opens the **Tendon Chair** dialog to input display parameters for tendon chair heights. Use **Visibility – Select/Set View Items** to change the symbol and text height.

![Tendon Chair Window](image)

**FIGURE 5.5-2 TENDON CHAIR WINDOW**
In the window shown in Fig 5.5-2 you can:

Choose to display the chair heights of either all tendons or of tendon groups only.

Specify the z-offset which is defined as the distance between the centroid of prestressing steel of a tendon to the tendon’s geometry center.

Define the spacing between the chairs as either the number of divisions between high and low points or as the distance between the chairs.

For the setting of the chairs, you can make the program round up or down to the nearest value that you specify.

When the chair heights are displayed, the standard symbol indicating the number of strands per tendon is added to each tendon (Fig. 5.5-3).

**FIGURE 5.5-3 STANDARD SYMBOLS INDICATING THE NUMBER OF STRANDS PER TENDON**

5.5.5 Tendon Spacing Tool

Creates spacing dimensions between selected tendons at a user-specified insertion point. (Fig. 5.5-4).
## Chapter 6

**DESIGN CRITERIA – MATERIAL PROPERTIES**

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>MATERIAL PROPERTIES</td>
<td>69</td>
</tr>
<tr>
<td>6.1.1</td>
<td>Concrete</td>
<td>69</td>
</tr>
<tr>
<td>6.1.2</td>
<td>Mild Steel</td>
<td>70</td>
</tr>
<tr>
<td>6.1.3</td>
<td>Prestressing</td>
<td>71</td>
</tr>
<tr>
<td>6.2</td>
<td>DESIGN CRITERIA</td>
<td>71</td>
</tr>
</tbody>
</table>
To a great extent, the design criteria is dictated by the building code. However, within the limits of each code, there are some parameters that you will have to decide. ADAPT-Floor Pro comes with default values for all the design criteria. The default values of the program are those most commonly used in the industry. For your first run, you may choose to execute your structural model with the program’s default parameters. After a successful execution of data and its validation, browse through the default options and modify them to meet your particular requirements.

The specifics of implementation of each of the building codes in ADAPT-Floor Pro are given in its own Technical Note. The following covers an overview of the criteria. Where reference to a particular code becomes necessary, IBC (International Building Code) is used.

6.1 MATERIAL PROPERTIES

You can access the input dialog box for material properties from the Materials pull down menu. It has four menu items as follows:

Concrete

Mild Steel

Prestressing

Generic - Note that Generic material properties are discussed in Chapter 5 of the ADAPT-Builder 2019 User Manual.

6.1.1 Concrete

Select the Criteria ➔ Concrete to open the materials input dialog box (Fig. 6.1-1). In this dialog window, you can define one or more concrete material properties. Each concrete material will have its own Label. The program will give a label to each material you add to the list, but you have the option of modifying the label.
6.1.2 Mild Steel

Non-prestressed steel is grouped in the Rebar category for input data. The properties that you need to specify are listed in Fig. 6.1-2. Material properties for mesh reinforcement should also be entered in the same dialog box.

FIGURE 6.1-1 CONCRETE MATERIAL DIALOG WINDOW

FIGURE 6.1-2 NON-PRESTRESSED STEEL DIALOG BOX
6.1.3 Prestressing

You enter the material properties for prestressing in the input dialog window shown in Fig. 6.1-3.

![Prestressing Material Input Window](image)

**FIGURE 6.1-3 PRESTRESSING MATERIAL INPUT WINDOW**

6.2 DESIGN CRITERIA

**Design Code.** Figure 6.2-1 shows the list of building codes available at the time of preparation of this manual. Most probably, your program will display a larger selection, as more building codes are currently being added to the program. For each building code, the suggested strength-reduction factor, or material factors, will be displayed on the same screen. You have the option to edit these.
Allowable Stresses. The suggested values for the allowable stresses of each code are listed in the “Allowable Stresses” tab (Fig. 6.2-2). This tab will be displayed only if the program is opened with the prestressing option (PT) selected. Typically, the allowable stresses for both the final condition (service) and initial condition (transfer of prestressing) are listed.
Shear Design. The shear design options are listed in a separate tab (Fig. 6.2-3). For one-way shear (beams and one-way slabs), the program uses stirrups (links, ties), where needed. For punching shear reinforcement, you have the option to select between shear studs or stirrups. Other options, such as shear band, are being added to the punching shear reinforcement alternatives.

FIGURE 6.2-3 SHEAR REINFORCEMENT OPTIONS

Preferred Reinforcement Size and Material. The bar sizes and material for the main reinforcement, one-way shear stirrups and two-way shear reinforcement can be selected using the dialog window in Fig. 6.2-4.
Rebar Cover. The program assumes that your slab project is likely to have two layers of reinforcement at the top and two layers at the bottom. Each of the layers, associates with design of the slab in one of the two orthogonal directions. You need to specify the cover to the outermost layer at the top and the outermost layer at the bottom. Knowing the size of the bar, the program will automatically calculate the cover to the inner layers. Fig. 6.2-5 shows the dialog window you will use to specify the cover.

Choosing which rebar layers shall be considered for which direction is done in the property window of the design strips. Each design strip will be associated with one of the principal directions of the reinforcement layout.
Rebar Round-Up. The length of rebar calculated by the program based on the design criteria is generally not a round number. For practical purposes, however, it is common to specify the length in rounded up values. In the dialog window of Fig. 6.2-6 you can specify the value to which the program should round up the length of the reinforcement calculated, before reporting it in its output.

FIGURE 6.2-6 REBAR ROUND UP WINDOW

The second frame enables you to define the maximum spacing of bars on plan. This option is available only if the “RC only” option is selected.

The third frame enables you to specify the value to which the program should round down stirrup spacing.

The fourth frame “Round up to standard bar lengths” allows you to define libraries with standard top and bottom bar lengths.

The left text field displays your libraries in a tree structure. You can add, clone, delete and rename libraries by right clicking on a library name in the text field.
Each bar length can be changed by double clicking on the cell in either the top bar or bottom bar table that displays the bar length. A cursor appears and the length can be edited.

The rebar library which is highlighted when clicking the OK button on the Criteria window becomes the active rebar library.

![FIGURE 6.2-7 GENERATE REBAR DRAWING DIALOG WINDOW](image)

**Calculated Rebar Plan.** When you generate the rebar drawing on the screen (*Floor Design → Calculated Rebar Plan,*), you have two options as shown in Fig. 6.2-7. You can either choose “Calculated Lengths” which takes into consideration the values you entered for round up in the “Reinforcement Bar Length” tab or “Library Lengths,” where the program takes the calculated rebar lengths and searches in the active rebar library for the next rebar length. The next longer rebar length is then displayed on the screen. If there is no such rebar length specified in the rebar library, i.e. the calculated rebar is longer than the longest bar length in the active rebar library, the calculated rebar is displayed on the screen.

**Rebar Length.** The bar length is determined by the program based on the stress values, or the strength requirements. However, IBC/ACI requires that regardless of the other considerations, the length of a bar deemed satisfactory for the minimum requirements of a post-tensioned slab shall not be less than a given value. The value is entered as default for the IBC/ACI in the dialog window of *Fig. 6.2-8.* Where in other codes no prescription of minimum bar length is given,
the IBC/ACI value is used. You have the option to edit these values. Specify zero to disable the provision.

![FIGURE 6.2-8 BAR LENGTH DIALOG WINDOW](image)

**FIGURE 6.2-8 BAR LENGTH DIALOG WINDOW**

The second frame in **Fig. 6.2-8** enables you to set minimum lengths for the strength reinforcement bars. Edit the default value as needed.

There is yet another consideration in the bar length reported by the program. The program checks the reinforcement requirements at the face of support, at the face of a drop cap/panel, and at the design sections created between two supports in any given span. If a span is subdivided into a large number of divisions, the program will have a rebar value at each division and can give a more accurate account for the length of the bar. The approximation in the bar length is equal to the length of a division (distance between two design sections) in a span. Hence, if you want an accurate length for the bar, you must change the default of the program (generally 12 divisions) to a finer division. You can make this change in the property box of a support line.

The third frame in **Fig. 6.2-8** enables you to display and/or adjust the position of reinforcement on plan. When the option “Enter position of bars on plan” is selected, the program will display the distance of a bar end to the centerline of the nearest support (**Fig 6.2-9**).
When “Adjust length and center bars …” is selected, the program finds the larger length of the bar over the support or span centerline, makes the total length twice that of the larger side and centers it over the support or midspan. Dimension line text size can be modified through the “Font height” column of the Rebar item in the Select/Set View Items, tool.

**Tendon Height Defaults (FEM).** The program places a tendon with a minimum distance from the top and bottom fibers of the concrete outline as given in the first two data fields of Fig. 6.2-10. Once created, you can view and modify the tendon profile. If you choose to modify the tendon profile graphically, using the dynamic tendon modeling (DTM) as described earlier, the graphical work will move the tendon in steps of the distance given in the “round up” data field in the figure. This will result in a round number for the tendon height.
**Analysis/Design options.** Analysis and design options are listed in the “Analysis/Design Options” tab (Figs. 6.2-11 and 6.2-12).

**FIGURE 6.2-11 ANALYSIS/DESIGN OPTIONS FOR PRESTRESSED STRUCTURES**

**FIGURE 6.2-12 ADDITIONAL OPTIONS FOR CONVENTIONALLY REINFORCED STRUCTURES**

The following explains the function of each of the entries of the Analysis/Design Options tab:

- **Non waffle/joist floor systems.** If “Regular floor system” is selected, at design stage the program differentiates between “structural” and “architectural” beams. In its code check the program disregards the stem of an architectural beam. That is to say, if a design section crosses an architectural beam, the program will not design that beam for
reinforcement. The program will only place corner bars if entered by the user. In connection with a given support line, a beam is defined structural if it contains at least one “support” (vertex) of the given support line within, or on its boundary. Figure 6.2-13 illustrates the three options for treatment of a beam with a support line vertex. The option depends on the angle between support line and the centerline of the beam.

For $\alpha \leq \text{angle}_\text{for}_\text{beam}$ [30 degrees] consider as beam

For $\alpha \geq \text{angle}_\text{for}_\text{support}$ [70 degrees] consider as support

For the remainder of the angles, consider as architectural beam

The parameters “angle_for_beam” and “angle_for_support” are included in the program’s initialization file and can be modified by the user.

FIGURE 6.2-13 TREATMENT OF A BEAM WITH SUPPORT LINE VERTEX

The following example illustrates the treatment of beams based on two considerations, namely (i) the presence of at least one support line vertex on the beam and (ii) the angle between the beam’s centerline and the support line. Refer to Fig. 6.2.14, where the support line has vertices within the boundary of beam A, B and D. In relation to the support line shown, only beams A and D are structural, where beam A is considered as support and beam D is considered as a proper beam. The other two beams B and C are architectural.
When a beam is considered as a support, the program will not cut a section through it for the slab design. The reinforcement for the beam will be determined from the design sections in the orthogonal direction. For example, for region 1-2 shown in Fig. 6.2-14 there will be no design sections. In a region where one or more structural beams are encountered, the program will consider the cross-section of the steam as shown in region 3-4 of Fig. 6.2-14.

Drop caps, drop panels, slab bands, and changes in slab thickness and changes in elevation of structural components will be faithfully represented in the geometry of a design section and accounted for regardless of their relation to support lines.

- *Includes waffle/joist construction*. If “Includes waffle/joist construction” is selected, the program considers each waffle or joist stem that is within a design section as a beam entity. For example, if a design section cuts 6 stems, the program does as follows:
  
  o Combines the six stems and their topping slab into an idealized single beam with the web thickness equal to the sum of the webs of the individual stems. Or, as the case may be, the entire will be converted to a single equivalent I-section.

  o The idealized section will be used for stress and strength checks.

  o The actions reported by the program will be that of the design section, not the individual stems.
- The rebar displayed in builder sum and the report will be that of the entire design section.

- **Design all “beams” using the respective building code requirements for “beams.”** The program will use the “beam” option of the respective code to design and detail the structural components that were created as “beams.” In other words, if a design section cuts a beam the program will design it using the respective code provisions for beams.

- **Design each design strip as defined by user in its associated design strip.** In this case, the program will design each “support” line according to the user selection in the property box of the respective support line.

- **Create supports at far ends of walls and columns.** This feature automatically inserts supports at the far ends of walls and columns using the program’s default restraints prior to the analysis. If conditions other than the program’s default are selected in the “Criteria” pull-down menu, the program selects the latter. To modify any of the program specified boundary conditions, (i) **Model→Support→Create Supports** (*Fig. 6.2-15*), (ii) double click on the support you want to view/edit to open its property window, and finally (iii) change the support restraints to the condition of your choice.

*FIGURE 6.2-15*

If in the **Criteria→Analysis/Design Options** menu the option “Retain user modification” is checked, the program will not overwrite these modifications when you analyze your model. If you do not check this option the program overwrites the user modifications with the boundary conditions specified in the Analysis/Design option tab.

- **Consider the contribution of prestressing in strength check.** When not checked, the program considers the force due to Prestressing for the tendons that are “considered,” but does not allow for the contribution of tendons in the “strength” check. This scenario applies when a user adds tendons to a project for deflection or crack control.
• Include the minimum code-specified non-prestressed reinforcement. When this option is selected the program will calculate minimum reinforcement based on the provisions of selected design code.

• Consider code-required minimum rebar (RC Only). If selected by the user, the program calculates the minimum reinforcement that is based on respective code provisions.

• Include twisting moment in design of bending moment (Wood-Armer method). If selected by the user, the program calculates the reinforcement for ultimate limit state according to the Wood-Armer method.

• Reinforcement for strength be larger than cracking moment. If the user selects “Yes” the program performs the code-specified calculation for the design moment to be larger than a multiple of the cracking moment.

• Torsional Stiffness Options. This control enables the user to disregard the torsional stiffness of beams, lower and upper columns as desired. The user also is given the flexibility to manually define the percentage of torsional stiffness to consider for the beams, upper and lower columns.

• Meshing options. This control enables the user to select the meshing option. The default is “sparse mesh.”
# Chapter 7

## LOAD CASES AND LOAD COMBINATIONS

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>LOAD COMBINATION</td>
<td>87</td>
</tr>
<tr>
<td>7.1.1</td>
<td>Load Combinations Set Up</td>
<td>87</td>
</tr>
<tr>
<td>7.1.2</td>
<td>Load Combination Label</td>
<td>89</td>
</tr>
<tr>
<td>7.1.3</td>
<td>Analysis/Design Options</td>
<td>89</td>
</tr>
<tr>
<td>7.1.4</td>
<td>Long-Term Deflection Template</td>
<td>90</td>
</tr>
<tr>
<td>7.2</td>
<td>PATTERN LOADLING</td>
<td>91</td>
</tr>
<tr>
<td>7.3</td>
<td>REDUCTION OF LIVE LOAD</td>
<td>95</td>
</tr>
<tr>
<td>7.4</td>
<td>LATERAL (WIND/SEISMIC) LOADS FOR SINGLE LEVEL STRUCTURES</td>
<td>96</td>
</tr>
<tr>
<td>7.4.1</td>
<td>Lateral Load Case Definition</td>
<td>97</td>
</tr>
<tr>
<td>7.4.2</td>
<td>Load Combinations</td>
<td>99</td>
</tr>
<tr>
<td>7.4.3</td>
<td>Input/Editing of Lateral Forces</td>
<td>100</td>
</tr>
</tbody>
</table>
The definition of loads and load cases, including the creation of new load cases for gravity and other general conditions are described in the Modeler User Manual. Further, if you plan to import loads and or geometry from a general-purpose multi-story building program, the ADAPT-Floor Pro program has special features which enable you to import wind, seismic and other loads from solutions obtained by other programs. In the following text, you will learn about load combinations.

7.1 LOAD COMBINATION

7.1.1 Load Combinations Set Up

To open the load case combinations dialog window (Fig. 7.1-1), select Loading → Load Cases/Combos → Load Combinations. Depending on the building code selection you have made, and whether or not you have implemented prestressing, the program automatically defines a number of load cases and load combinations. You can add to or edit the program’s selection. The design code you have selected is displayed in the middle of the dialog box – ACI in the case illustrated in Fig. 7.1-1.

![FIGURE 7.1-1 LOAD COMBINATION DIALOG WINDOW](image)

The current load cases of the program are listed in the Load cases combo box on the bottom right of the figure. The program obtains a solution for each load case, then combines them, each with its respective Load factor as listed in the Combination list. Only the load combinations will be available for you to view, and are included in the program’s reports. As a result, if you wish to see the program’s solution for a particular load case, such as “Selfweight,” you must define it as a load combination on its own (Fig. 7.1-2).
The default load cases of the program are:

- Selfweight
- Dead Load
- Live Load
- Prestressing
- Hyperstatic

The selfweight load case is determined automatically by the program using the volumetric geometry of your structural model and the unit weight you have assigned in the Material pull down menu. If you change the unit weight default of the program to zero, the program will automatically delete the “Selfweight” as a load case. Or, if you prefer, you have the option of excluding the selfweight load case in your load combination table.

Dead Load will be shown among the load cases only if you have assigned load to it and check-marked it in the Load Case Library dialog window. Likewise, Live Load will appear in the load case combo box, if you have assigned a load to it and check-marked it in the Load Case Library dialog window.

Prestressing and Hyperstatic load cases will appear in the load case combo box if you define at least one prestressing tendon in the structural model. The prestressing load case determines the displacements and stresses in the structure resulting from the actions of the prestressing tendons. The hyperstatic (secondary) load case gives you the moments and shears in the structure due to the restraint of the supports to free the deformation of the
structural model. The prestressing load case is the one you will be using for the service condition of the structure – that is to say for the stress check in concrete, crack control, and deflection checks. The hyperstatic load case is used only for strength (safety) load combinations.

### 7.1.2 Load Combination Label

Each load combination can be assigned a unique name. You can enter the load combination name in the field marked *Label* in **Fig. 7.1-2**. In its reporting, the program uses the name you entered in the label field to report the associated results.

### 7.1.3 Analysis/Design Options

Results of each load combination will be treated by the program using one of the following options:

- Serviceability
- Strength
- Initial
- Cracked Deflection
- No Code Check
- Long-Term Deflection
- P-Delta

For each of the load combinations, you need to select the option you want in the *Analysis/Design options* dialog box of **Fig. 7.1-2**.

The “serviceability” option applies the in-service requirements of the code you have selected to the results of the load combination. This includes stress checks, deflections, and crack control, as well as the minimum rebar. Likewise, the “strength” option uses the safety requirements of the code you selected to check the outcome of the load combination. The “Initial” option is used for the transfer of prestressing to the structure – jacking stage. The “Cracked Deflection” option is used for calculation of deflection with due allowance for loss of bending stiffness due to cracking. The “No Code Check” option simply reports the results of the FEM analysis without any additional processing. For example, if you are interested to see the displacements and moments for the selfweight or prestressing, you would select this option. A new analysis/design option
type for P-delta is included in ADAPT-Builder 2019 and later versions, in
which combinations can be singularly run for 2\textsuperscript{nd} order effects or
processed as a batch, based on a combination used to obtain the geometric
matrix. Graphical analysis results similar to regular combinations can be
obtained for P-delta combinations. These results can be utilized for the
design of columns. For more information refer to the ADAPT-Builder

7.1.4 Long-Term Deflection Template

You have the option to manually define load combinations for long-term
deflection results or to use the “Add Long-Term Deflection Template”
button as shown in Fig. 7.1-3. When this option is invoked, the program
will prompt the user to enter a creep and shrinkage factor (See Fig. 7.1-4)
and will automatically generate two additional load combinations and add
these to the combination list. These combinations are “Sustained_Load”
and “Long-Term.” The “Sustained_Load” combination can be edited to
include different load cases and factors using the input for “Combination
parts” and “Load factor.” This combination is automatically set to the
Analysis/Design Option of “Cracked Deflection.” The “Long-Term” load
combination can also be edited in a similar way with the difference that
“Combination parts” can include only existing “non-long-term” load
combinations (see Fig. 7.1-3). The Analysis/Design Option of this
combination is grayed out and cannot be modified. The user can add as
many long-term combinations as required.

FIGURE 7.1-3 LONG-TERM DEFLECTION TEMPLATE
FIGURE 7.1-4 CREEP AND SHRINKAGE FACTOR

The purpose of this feature is to automate the calculation and reporting of long-term deflection results in lieu of manually applying a creep and shrinkage coefficient to elastic deflections in ADViewer (View Results from the FEM tab) to obtain long-term deflection combinations and results. It also serves as a template to setting up long-term deflection combinations and results. This feature can be used to combine results of different load combinations. It is important to stress that the program is not limited to its default combination and the user can edit or add combinations as required.

7.2 PATTERN LOADING

Skipping of live load, also referred to as pattern loading, is the process in which a given load is selectively placed at different locations on the structure, in order to determine the maximum adverse effect of the load on the structure. This process applies to the loads that can be either present or absent at specified locations on the structure, such as live load. ADAPT-Floor Pro allows you to define as many number of skip load arrangements (patterns) as required. The program analyzes each pattern separately, and obtains an envelope of the maximum and minimum values for use in design.

The following are the steps for skipping of live loads (refer to Figs. 7.2-1 and 7.2-2):

- Define the structure. Figure 7.2-1a shows symbolically the floor plan of a structure. Supports and other features of the floor are not shown, since these are not required for the definition of skip loading, although you may use them to determine the subdivision of a floor into skip regions.

- From Loading → Pattern → Subregions (Fig. 7.2-3). The same menu item is used for the reduction of live load for horizontal elements (slabs, beams, etc.)

- Create “skip division lines” following the instruction at the bottom of the screen (hint line). This consists of using the mouse and drawing “division lines” to subdivide the floor plan into “skip regions” (Fig. 7.2-1b).
o Identify the “skip sub-regions” that form a load pattern, by selecting the Define/Edit Load Pattern option in Fig. 7.2-3.

o Define a skip factor, and/or request reduction of live loading through the dialog box of Fig. 7.2-4.

o Open the properties box (Fig. 7.2-5) of each skip sub-region by double clicking on its hot spot (circle displayed in its middle). Alternatively, select a skip region and then invoke its properties box by clicking on “Item’s Properties” tool.

Once the skipping of live load is defined and saved, the program automatically generates a load case for each of the skip patterns along with two load case envelopes, one reporting the maximum and the other the minimum value obtained from the skipping of the live load.
For example, in the floor plan shown in Fig. 7.2-1, four skip sub-regions are identified. If you select four skip patterns, the program will generate the following load cases and load envelopes.
The solution of each of the load cases can be viewed individually, reported individually and combined with other load cases.

The symbol #### represents the label you will select for the load you skip, such as “Live load.” The Skip_####_Max and Skip_####_Min represent an envelope of the maximum and minimum values for all the patterns defined by you. In this example, these will be the envelope of the load cases Pattern_1, Pattern_2, Pattern_3 and Pattern_4.

FIGURE 7.2-4 SKIP PATTERN SELECTION
7.3 REDUCTION OF LIVE LOAD

Live load values specified in the code are determined statistically, using a notional floor area. For floor areas larger than the notional areas used in the building codes, there is less of a likelihood of the load covering the entire area with the code-specified intensity. For this reason, the building codes generally allow a reduction in the intensity of the specified live load, when the load covers large areas. ADAPT-Floor Pro can automatically determine the reduction in the intensity of the live load specified, and accounts for it in its analysis. It also reports the reduction value used. An additional option allows the user to enter reduction values. Note that the reduction of live load for analysis is an option that you must select in your input data. Otherwise, the program applies the entire load you have specified over the area you selected.

The value used for the reduction of live load is calculated for each skip region (see the preceding section for the definition of skip regions). Hence, each skip region has its own coefficient of live load reduction. The area used for the calculation of the live load reduction in each skip region is strictly the area covered by the live load in that region. This is shown graphically by the hatched regions in Fig. 7.2-2(a). The concentrated (point) loads and the line loads that are part of the live load being reduced, and that fall within the skip region under consideration, are not reduced. The reduction is applied only to the distributed loads.

If you do not define a skip region, the program applies the reduction to the entire area of each part of the live load you have defined.

For the reduction of live load, the program uses the recommendations of the IBC-2005 (International Building Code), as detailed below:
R = 0.08(A – 150)

Where,

R = reduction factor, not to exceed 40%; and
A = tributary in square feet (where the live load is applied.)

Nor more than

R = 23.1 (1 + D/L₀) = < 40%

Where,

D is the dead load, and L₀ the applicable live load.

7.4 LATERAL (WIND/SEISMIC) LOADS FOR SINGLE LEVEL STRUCTURES

The procedure how to manually apply lateral loads on a structure is explained step-by-step using the example shown in Fig 7.4-1. In general, it consists of the following steps:

- Define a lateral load case. This is done by going to the load case library and defining a new load case for the lateral forces you plan to enter.
- Using Loading ➔ Lateral/Building, enter new loads:
  - Identify the position of a new load by selecting the wall/column of your choice.
  - Click the Lateral Reactions tool 🏗️. The program applies point loads at far ends of selected walls/columns.
  - To enter the load magnitude or edit the loads that you have already entered double click on the load symbol and insert the load values in the activated edit box.

Each time a lateral load case is created, its name appears in the list of load cases in the load “combination” table. The next step is to go to the load combination table and specify how you want the solution of the load case you have defined to be combined with the other cases.
The following example will walk you through the process in a more detailed manner. It is a single level substructure with two lateral load cases, one applied in X- and the other in the Y-direction (Fig. 7.4-8)

![Figure 7.4-1 Geometry of the Substructure](image)

7.4.1 Lateral Load Case Definition

Before entering any lateral loads, you must first define a lateral load case as described in the following.

- From Loading ➔ Load Cases/Combo ➔ Load Case Library, check Special lateral loads option. The dialog window shown in Fig. 7.4-2 will appear.
  - Click Add button. The program shows one load case with the name “Lateral_1.” This is a default lateral load case which can be renamed by editing it in the data cell “Label.” Note that the string “Lateral_” must be placed in front of the name selected. For example, if the load case is to be named “Wind-XX,” it would have to read “Lateral_Wind-XX.” It is the string “Lateral_” that signals to the program how to treat the load case.
  - Similar to gravity load cases, if you want to add or delete a lateral load case, you would use the “Add” or “Delete” buttons.
  - Once all loads are defined Click on the OK button to close the window.
As an example, Fig. 7.4-4 shows the definition of two load cases Lateral_EQ_x and Lateral_EQ_y. “Dead load” and “Live load” are default load cases of the program.
7.4.2 Load Combinations

To define load combinations, do the following:

- Select Loading ➔ Load Cases/Combo ➔ Load Combination, which will display the Combinations dialog box.
- Click the Load cases drop-down box and choose the load case that will be included in the load combination. Combine this load case with the other load cases in the same manner that you would do for gravity loading.

Figure 7.4-5 shows the definition of two load combinations EQ_x and EQ_y.
7.4.3 Input/Editing of Lateral Forces

You can input or edit lateral forces, after you have defined them in the load case library. This is explained in the preceding section.

- Select the walls and columns for which you wish to define lateral loads. Click on tool. Select lateral loads case from the drop-down list that opens. Click Create button. The program gives the option of entering lateral loads for each of the columns or walls you click on. It shows the availability of the option by a hexagon symbol that appears on the component you click on. If there are columns or walls both below and above a floor slab, the best is to select a perspective view of the structure, instead of the plan view (use this tool). In the perspective view, click once on an upper wall/column and once on a lower wall/column to activate both. Obviously, you can use the convenient tools that are available for selection of all the columns or walls, if a lateral load acts on all of them.

- Next you have to define the magnitude and orientation of each of the loads. The program automatically positions the point of application of each of the loads at the top or bottom centroid of the wall/column selected by you. You have the option to change the point of application, as will be described later.

Double click on the symbol generated for a point load to open its property box (Fig. 7.4-6). At this time the Lateral Load Editing Mode window will open (Fig. 7.4-7). Under the “General” tab of Point Load property box, enter the orientation and magnitude of the forces and moments you wish to specify.
When finished click the ✓ button to accept the values defined.

- Uncheck the tool.

When finished with editing of point loads for the given load case click Exit Lateral Load Editing Mode. (Fig. 7.4-7). Double click on the load that you want to modify. This will activate Lateral Load Editing Mode. When you finish with load editing close the Lateral Load Editing window.

Figure 7.4-8 shows lateral forces defined for the X- and Y-directions.
FIGURE 7.4-8 DISPLAY OF LATERAL LOADS FOR THE X AND Y DIRECTIONS
8.1 OVERVIEW

In this chapter we will continue to explore meshing. It should be noted that many meshing stages take place in the background, without your intervention, others require that you interact with the program and make a selection. If in any of the steps the program encounters something unusual, it will stop and provide a detailed warning. You have the choice of disregarding the warning and continuing. If the program encounters an error, however, the program will in most cases not continue until you remove the error reported. Among the steps we will review:

- Create a finite element mesh for the slab regions
- Validate the mesh for cell angles, size and aspect ratio
- Apply default boundary conditions at locations that generally require support, but you have not specified one – such at bottom of a column
- Check the structure for stability in the horizontal direction, stabilize if needed
- Validate the structure, such as proper connection between a column and slab
- Generate finite element mesh for the columns and walls consistent with the cells in the slab regions
- Discretize the loads (and soil support, if applicable)
- Solve for structure’s deformations for each of the load cases
- Check the validity of the solution obtained
- Combine the results obtained for each load case according to the load combination table.

8.2 MESHING

The basics of mesh generation are outlined in the Modeler User Manual. In this section, we will focus on the less common aspects of meshing. The break-down of the structural model into finite elements is referred to as “discretization.” In general, the discretization - also referred to as “meshing” - of the structure is done automatically by the program using ADAPT-Mesher. ADAPT-Mesher is based on adaptive mesh generation technology. It scans your structural model, detects its features and details, such as openings, steps, and creates a well-proportioned set of quadrilateral cells to suit the detail of your structure. While the entire mesh generation operation is done in the background, some knowledge of the way
ADAPT does the discretization is of great help in achieving a good and expedient solution. This section explains the concept and the information necessary for a successful discretization of the structural model. Some of the less immediate, but important concepts and procedures are reported in the Appendices A and B of this manual.

ADAPT-Floor Pro uses several different types of elements in its discretization. These are:

- Flat quadrilateral or triangular shell elements
- ADAPT-Mesher uses an adaptive technology, and automatically creates almost exclusively well-proportioned quadrilateral elements, adjusted to the details of your structural model. You have the option to view and edit the mesh generated by the program. This includes creations of triangular cells, if you so decide. The shell elements are used for the slab regions, and walls.
- Frame elements
- Prismatic frames with one node at each end, having six degrees of freedom per node. The frame elements are automatically generated for beams and columns.
- Point spring elements
  - These provide six degrees of restraint at a point of your choice. They are not generated automatically by the program.
- Soil support elements
  - The soil support elements provide Winkler type foundation over a region defined by you.

Meshing is required for the slab regions only, including drop caps and drop panels. Meshing of other components, such as beams, columns, and walls, is carried out automatically, using the slab meshing as a template. Supports, such as the supports at the far ends of columns and walls are also handled by the program automatically, unless you wish to change the default boundary specifications, in which case, you can define the support conditions.¹

The beam elements will be created by the program automatically to match those of the slab they support. The mesh generation of stand-alone beams, or grids with no slab support is also done automatically. You define the preferred element size.

¹ If the manual meshing option is used, point supports that are on a slab are to be identified with a “node.”
Columns are divided into a number of elements specified in the “initialization” file of the program. Likewise, walls are subdivided into shell elements that line up with those of the slab they support. In the vertical direction, walls are subdivided between two or more elements as specified in the initialization of the program.

8.2.1 Imposed Location of Nodes

This section will only be of interest to users who are planning to either use manual meshing, or edit a mesh generated by the program automatically. Prior to meshing, the program scans your structural model and imposes a number of “leader” nodes and lines at selected locations. These are intended to delineate the bounds of the structural components for the finite element meshing. In meshing, nodes will be located at these points and over the imposed lines. In addition to the imposed nodes, others will be generated within the enclosed areas of slab regions.

The location of imposed points are:

- The end of walls, beams and columns
- At the intersection of structural components, such as a beam and a wall
- At the corners of slab regions, openings, drop caps and similar conditions

Similarly, there will be imposed lines that would form the sides of the finite element cells. No finite element cell can cross these lines – they but against it.

- Along the edge of slab regions
- Along the edges of openings
- Along the boundary of drop caps and drop panels
- Along the length of beams and walls

Figure 8.2-1 is an example of imposed nodes and lines for meshing. It shows the partial plan of a slab with a wall and column support. The imposed nodes are at the ends of the wall (marked with A and B in part b of the figure). Other nodes will be generated between A and B along the imposed line AB. The number of elements generated along the line AB,

---

2 Many of the parameters that govern the behavior of the program are listed in the program’s initialization file. This is a text file “initialize_builder.txt” and is located in the subdirectory, where your ADAPT-Floor Pro program resides. The default subdivision of a column and wall in the vertical direction is two cells.
either automatically by the program or manually by you, depends on your choice and is determined by the cell size you choose.

An example of imposed nodes, imposed lines and automatic meshing is illustrated in Fig. 8.2-2. Note that the meshing generated automatically by the program includes the imposed nodes placed along the imposed lines.
FIGURE 8.2-2 IMPOSED NODES, LINES AND AUTOMATIC MESHING

The diagram of line and node constraints for the meshing (Fig. 8.2-4) is generated each time meshing is attempted. It is saved in a layer called “component representative.” You can view it on its own, by turning this layer on and all the others off.

8.2.2 Basics of Automatic Meshing

The basics of automatic meshing are outlined in the Modeler User Manual. This Chapter, and the Appendices A and B of this manual, cover additional details and the advanced features of meshing not covered in the Modeler User Manual. If it is your first attempt at meshing, it is highly recommended that you read the Modeler User Manual.

8.2.3 Manual Meshing

8.2.3.1 Overview and Use of Quadrilateral Cells

Only in rare cases will a structure need to be meshed manually. In the worst scenario, you are likely to use a combination of automatic and manual meshing. However, knowing how to perform manual meshing is of value, should you decide to edit

---

3 The component representative will be displayed automatically, if you attempt manual meshing. It will also be saved in a dedicated layer called "component representative." The automatic meshing is also based on the component representative drawing. But, the drawing is not displayed on the screen. Neither is it saved in a layer, unless you do the following. From the FEM pull-down menu select Manual Meshing. Click on Cancel button, when the option opens. This will generate the component representative layer.
the mesh generated by the program, or should you in a special case have a reason to use manual meshing.

The node consolidation (node shift) feature of the software, described in the last chapter of this manual, is also available for manual meshing. If required, the node consolidation option has to be exercised before manual meshing is started. For your first reading, there is no need to use “node shift.”

Once you click on the manual meshing tool, the program performs a “validation check” for the structural model to be meshed. The purpose of this validation check is to detect obvious errors, such as a column not having been attached to a slab. The validation also corrects, or improves a number of shortcomings in the structural model, such as merging points that are too close to one another, or multiple slab vertices.

Let’s explore the process of manual meshing by way of an example. **Figure 8.2-3** shows the plan of a floor with an opening, three columns and a beam.

Click on the **Manual Meshing** tool on the **Analysis → Meshing** panel. The program performs a validation for the structural model in the background. If the program detects a problem, or shortcoming, it will display its finding on the computer screen either as an “error,” or “warning.” The errors must be corrected before manual meshing can proceed. The warnings, however, can be ignored, if these are acceptable to the user.

After the structural validation, the program converts the floor system to a simple drawing (component representation as described above) that shows only the outline to be covered by mesh cells. The component representation is shown in **Fig. 8.2-4**.
The columns are shown by points in the outline. Beams, walls, opening and slab boundaries are shown by lines, each with its own color. The manual meshing should conclude with a “node” on each of the points on the component representation plan, and cell boundaries on each of the lines. Further, the cells should cover the entire floor area, except the openings.

At the next step, the program prompts a dialog box for cell divisions in each direction of a mesh to be created. This dialog box is shown in Fig. 8.2-5(a) for the current example. A complex floor plan is generally covered by several mesh sets. For the current example, one mesh set will be adequate. As shown in Fig. 8.2-5(a), a mesh with 10 by 8 is selected.
After pressing “OK” on the cell divisions dialog box, the program asks you to select the four corners of the region you want to apply the selection. Follow the prompts on the command line at the bottom of the computer screen. At this stage, use the snap tools of the program and match the corners/sides of the mesh to those of the points/lines on the component representation. In the current example the “snap to intersection” tool is used. As it is illustrated in Figs. 8.2-5(b) and 8.2-5(c), the corners of the slab region are selected. Once the last corner at the bottom left is clicked, the mesh shown in Fig. 8.2-5(d) appears.

**FIGURE 8.2-5 STEPS IN GENERATION OF A MESH REGION**

*Figures 8.2-6 through 8.2-12 illustrate the editing of the mesh to map it on the point and line restraints of the component representation in Fig. 8.2-4. The editing consists of the following steps.*

- Select the common node of the cells next to column points, drag them and snap them to the column points (Figs. 8.2-6...
through 8.2-8). In this operation, it is important to select all the cells that share the common node to be shifted to the column.

- Select the common nodes of the cells that are close to opening corners and using Snap Intersection snap them to the adjacent opening corner. Follow this by bringing the nodes next to opening sides and snapping them to the side. Use Snap to Nearest for this operation. Then select and delete the cells that are inside the opening. The mesh editing for the opening is illustrated in Figs 8.2-9 through 8.2-11.

- Using Snap to End edit the common cell nodes next to the end of lines to snap to the line ends (Fig. 8.2-12). Then, using Snap to Nearest adjust the cells that straddle across the beam or wall line to have their boundary on the line.
FIGURE 8.2-8 COLUMN POINT IS COVERED BY THE COMMON VERTEX OF ITS ADJACENT FOUR CELLS

FIGURE 8.2-9 THE COMMON VERTEX NEXT TO A CORNER OF THE OPENING IS PICKED AND SNAPPED TO THE CORNER

FIGURE 8.2-10 VERTICES ADJACENT TO THE OPENING ARE SELECTED, DRAGGED AND SNAPPED TO THE OPENING SIDE AND CORNER
Once the meshing is complete, the program automatically generates the shell and frame elements for the beams, columns and the walls. The generation of these elements is achieved prior to the Finite Element Analysis of the floor system. Once the analysis is complete, you can view the meshing of the structure in three dimensions.

An alternative to the manual meshing is automatic meshing. The automatic meshing option for the current example is shown in Fig. 8.2-13. The cell size selected for the automatic meshing was the same used for the manual example.
8.2.3.2 Generation of Triangular Cells

Quadrilateral shell elements yield a more accurate solution. However, when using manual meshing, in some locations the geometry of a slab is more amenable to triangular elements. For such cases triangular cells are used.

A triangular cell is created by transforming a quadrilateral cell into a triangle. Click on one corner of the quadrilateral, drag it over and snap it onto another corner of the same quadrilateral. Figure 8.2-14 illustrates the process. The quadrilateral cell ABCD shown in part (a) of the figure is transformed into the triangular cell ABD. The following are the steps.

- Activate the Snap to Intersection tool and turn other snap tools off.
- Select the corner to be eliminated (point C in the figure).
- Snap the corner selected onto another vertex of the quadrilateral (point D).

![Figure 8.2-14 Transformation of a Quadrilateral to a Triangular Cell](image)
The following example illustrates the editing of quadrilateral cells and the application of triangular cells to a particular floor slab.

![Figure 8.2-15 Plan of a Slab Region and the Initial Mesh Mapping](image)

**Figure 8.2-15** shows the plan of an irregular slab region. Selection of a 6x6 division when snapped at the four convex corners of this slab region give a mesh as shown in part (b) of the figure. Note that the cell falling entirely outside the boundary of the slab region is not generated by the program. This feature is designed to minimize the effort of manual meshing.

**Figures 8.2-16 through 8.2-20** show graphically how nodes A and B of the quadrilateral cell next to corner C of the slab are edited to conform with the geometry of the slab boundary. The figures also illustrate the editing of the adjacent cells to complete the meshing along the slab boundary line CD.

![Figure 8.2-16 Close Up of the Top Left Corner of the Slab](image)
FIGURE 8.2-17 NODE A IS DRAGGED AND SNAPPED ON LINE CD

FIGURE 8.2-18 NODE B IS DRAGGED AND SNAPPED AT THE INTERSECTION OF A ON CD

FIGURE 8.2-19 TOP LEFT QUADRILATERAL CELL IS TRANSFORMED TO A TRIANGULAR CELL MATCHING THE SLAB GEOMETRY
8.2.4 Mesh Editing

The program provides you with a set of effective tools to view and edit the layout of a mesh either generated automatically by the program, or otherwise. The process is detailed in the preceding section on manual meshing.

8.2.5 Nodes and Finite Elements

Prior to the analysis, the cells created in the mesh will be converted into finite elements and their vertices into nodes. You have full access to the node and element numbers, their connectivity and other properties. In the normal course of your work you would not need to access this information, since the program automatically performs all the operations necessary to obtain a complete finite element solution. The last Chapter of this manual describes how you can view both in graphical and tabular forms the internal information used by the program for the nodes and elements.

8.2.6 Natural and Analysis Nodes

In order to enable the program to model complex structures, it is necessary that each node of a finite element has a twin. Unlike simple finite element programs, the FEM processor of ADAPT-Builder is based on retaining the node definition and position that are commonly used. Again, this is all done in the background and will not be apparent either in data generation, nor the solution/results of the program.

Figure 8.2-21 illustrates an example.
8.2.7 Node Consolidation – Node Shift

Another tool available to you is the node consolidation, referred to as Node Shift. Again, in the course of your normal work, you need not be conscious of it, nor use it. However, using it can help pave the way for a seamless integration of your design work with the architect’s work, and facilitate the structural drawings you generate. Node consolidation (Node Shift) also makes it possible to take advantage of the application of Component Technology in your modeling and designs.

The details of the implementation are given in the last chapter of this manual. The following describes the concept.

Consider the slab detail shown in Fig. 8.2-22. Part (a) of the figure shows the architect’s drawing and the manner in which the structure will be built.
This is also the way you would show it on your structural drawings. However, in performing the analysis and design, traditional FEMs would model the structure as shown in part (b). That is to say, the column extends to the mid-depth of the slab, and the slab terminates short of the edge of opening. This may be fine for the analysis, but renders the structural model invalid for construction detailing. In summary, the model generated on the basis of traditional modeling does not lend itself for direct export as structural drawing. The alternative shown in part (c) of the figure overcomes this shortcoming. The slab is modeled to cover the entire area. Likewise, the column is terminated at the slab soffit. The geometry of the structural model (part (c)) of the figure matches that of the architect. It can be directly used as a structural drawing for construction.

The handshake for force transfer between the column and the slab in part (c) of the figure takes place at the “analysis” node. The combination of the shift of the slab node to the slab edge and the selection of the analysis node is referred to as “node consolidation.” The process takes place in the background, once you bring in the architect’s drawing into the program. However, you have full control to edit and manipulate the process, if you so wish.

FIGURE 8.2-22
The seamless integration that can be achieved between the architect’s presentations and the structural drawings you prepare is illustrated in Figs. 8.2-23 and 24. Again, Fig. 8.2-23 shows the traditional method of creating a structural model from a simple portal frame. Note that neither the column, nor the beam lengths (h, l) used in the structural analysis match the construction length.

Again, the modeling technology used by ADAPT-Floor Pro (Fig. 8.2-24) is Component Technology, which means that each component of your structure, such as a column or a beam, can be represented by their actual physical dimension. This process alleviates the discrepancy between the construction requirements and the structural engineering model. In addition, the analysis is based on the actual length. Your analysis model can be used to generate rebar layouts automatically (using the rebar module of the program). The rebar length, extent of ties and other particulars of the rebar layout would match the construction requirements.
8.2.8 Excluder

Excluder is a feature, whereby you can bound one or more regions of a floor system and select to have the slab inside or outside the bounded region(s) meshed when the automatic meshing of the program is invoked. See Fig. 8.2-25. This feature applies to general analysis and vibration analysis. It is most useful when the features of a specific region require a manual mesh. Once the program concludes with the automatic meshing function, the areas of the slab that were excluded from the mesh can be completed using the manual meshing tools from the FEM menu. This process is described in the advanced features of the program in the last chapter of this manual. It is unlikely that you would use it for normal structures and in the course of routine work. This feature can be used for vibration analysis of a single region of a floor slab (see Section 8.7.1). Some users, however, may find this material beneficial for research and possibly with very complex structures.
8.3 ANALYSIS OPTIONS

As it is detailed in the ADAPT-Modeler manual, the program automatically stabilizes your structural model against horizontal body movement, assuming that you are not doing so yourself. However, if you provide adequate boundary conditions, such as fixity at the supports in the X- and Y-directions, there is no need for the program to stabilize the model. If you have provided adequate supports in your structure to hold it tight in position, the “Stabilize the slab automatically” option in Fig. 8.3-1 need not be checked.
If you provide adequate supports, but do not uncheck the program’s stabilization option in the above figure, the structure will end up with more supports than you intended.

8.4 ANALYZE THE STRUCTURE

Select the Execute Analysis button from Analysis \(\rightarrow\) Analysis. The analysis does not require interaction from you. If no problems are encountered, the program prompts on the screen the successful completion of the analysis.

8.5 DEFLECTIONS CALCULATION IN FLOOR PRO WITH ALLOWANCE FOR SLAB CRACKING

8.5.1 Overview

ADAPT-Floor Pro has the option to calculate the deflection of a floor system with allowance for loss of bending stiffness due to cracking of either slab regions or beams. The formulation used in ADAPT-Floor Pro is rigorous, iterative, and accounts for loss of stiffness at the individual finite element cells over the entire floor system. The following is a brief outline of the algorithm used:

1. User identifies the load combination for which the deflection with cracking is to be calculated.
2. Using the geometry, material properties, information on current second moment of area of each finite element cell and support condition of the floor system, the program sets up the system stiffness matrix for the entire structure. From this stiffness matrix and the load identified above, the program calculates the distribution of moments (Ma) and axial forces over the entire structure.
3. The program scans the available reinforcement in the floor system. The reinforcement is either determined by the program prior to the initiation of deflection calculation, or is a combination of program-calculated and user-defined or user-edited reinforcement. Once the deflection calculation is initiated, the available reinforcement remains unchanged. There is no restriction on the orientation and length of reinforcement bars, nor the position of reinforcement within the slab. The available reinforcement can be in one or more of the following forms:
User-defined one or more top and bottom mesh reinforcement;

User-defined grouped or distributed reinforcement bars at top and/or bottom of slab and beams;

Reinforcement calculated and reported by the program for code compliance, such as minimum requirements of the code, strength check, initial conditions, or other criteria; and

Post-tensioning tendons defined by the user, each with its own location and force.

4. The calculated moment (Ma) and axial force of each finite element cell is matched with the reinforcement in that cell. Using the parameters given below, the program calculates the effective moment of inertia of each cell:

Finite element cell thickness (to obtain uncracked second moment of area);

Available reinforcement associated with the cell (nonprestressed and prestressed);

Cracking moment of inertia associated with the cell in each direction (Icr);

Cracking moment associated with the cell (Mcr); and

Applied moment and axial force.

5. Using the modified moment of inertia due to cracking, the program re-calculates the stiffness matrix of each of the finite element cells.

6. The system matrix of the entire structure is then re-assembled and solved to obtain a new set of deflection values.

At this stage the solution given is a conservative estimate for the floor deflection with cracking. However, at user’s option, the program can compare the calculated deflection with that of a previous cycle.

In its computations, the program accounts for loss of bending stiffness in beams as well as the slab. In the first release of the program, the formulation used for the calculation of stiffness loss from cracking is the one recommended in ACI318. However, the algorithm is general and can be readily expanded to relationships suggested in other codes.

8.5.2 Procedure How to Calculate Cracked Deflection

The following are the steps to calculate cracked deflection:
1. First, define the load combination for deflection with cracking.
   
o Select Loading ➔ Load Cases/Combo ➔ Load Combinations. Define the load combination. In the “Analysis/Design Options” combo box select option “CRACKED DEFLECTION” (Fig 8.5-1)

2. Analyze and design the structure.

3. View the reinforcement reported by the program. Modify as needed.

4. Go to Cracked Deflection ➔ Analysis ➔ Cracked Deflection.

5. To view the deflection, select Analysis ➔ Analysis ➔ View Analysis Results. In the “Results” tab select “Z-translation.” Go to the Load case/Combination tab. This tab lists the load combinations you defined together with the load combination for the cracked deflection. For this load combination the program creates two sets of results. The one with the prefix “Cracked” shows the cracked deflection. To view, select Display Results tool, from the Results toolbar. The program will display the cracked section deflection contour (Fig. 8.5-2) Alternatively, the user may view the results through the Result Browser as well.

![FIGURE 8.5-1 COMBINATIONS WINDOW]
To display the loss of rotational stiffness about X or Y direction of the slab, click on Results -> Slab Actions only -> Reduced Rotational Stiffness About XX or Reduced Rotational Stiffness About YY. The loss of stiffness is represented as a ratio of effective to gross second moment of area (Fig. 8.5-3).

FIGURE 8.5-3 REDUCED ROTATIONAL STIFFNESS ABOUT YY

To display the stiffness ratio for beams, go to Beams action only -> Reduced Stiffness Ratio. To show values click on tool.
8.6 CRACK WIDTH CALCULATIONS

The program allows you to specify a limit for crack width (Fig. 8.6-1). If the calculated width exceeds the user-defined limit, the program will add reinforcement to limit the crack width as per design code provisions. The calculated rebar is included in the “service” envelope of reinforcement. The calculation of crack width will be available as an option when the selected design code doesn’t require limitations for crack width (Fig. 8.6-2). You can select to only report crack width, or to report and limit crack width in which case the program adds reinforcement if required. For this scenario the calculations are based on European code provisions.
To obtain results for crack width:

1. Go to **Criteria ➔ Design Criteria ➔ Design Code** (if opened in RC only mode) or **Criteria ➔ Design Criteria ➔ Allowable Stresses** (if opened in PT and RC mode).
2. Depending on the selected design code you will have an option to enter the allowable crack width or to report crack width only.
3. Analyze and design.
4. To view crack width contours, select **Analysis ➔ Analysis ➔ View Analysis Results**.
5. In the Load Cases/Combinations tab select “service” load combination.
6. In the Results tab ➔ Slab Action only select Cracks along Strip Y – (width) or Cracks Along Strip X-(width). Note that these options will not be available if the crack width calculation does not apply to selected load combinations (for example “strength” load combination).
7. Select ✓ and ✓ tools. The color contour will display on the screen (Fig. 8.6-3)
8.7 DISPLAY LINE CONTOURS

8.7.1 Overview

ADAPT-Floor Pro provides the option to display line contours for moments and shear forces in the modeling environment. After a successful analysis, go to Analysis ➔ Contour Settings ➔ Display Contours to display the “Generate Line Contour” window (Fig. 8.7-1).
From the Load combination drop down box select the load combination for which you want to display the line contours.

You have the option to select the following slab actions:

- Bending moment about the local axis 1 (M11)
- Bending moment about the local axis 2 (M22).

In the “Orientation” group box, you can specify the angle for the global X-axis to the local axis 1. This allows you to display line contours for slab actions in any direction.

Click “OK” to display the specified line contours for your model in ADAPT-Floor Pro’s modeling environment.

8.7.2 Contour Settings Panel

The Contour Settings panel allows you to display and manipulate the line contours (Fig. 8.7-2). These tools are also available from the Analysis ribbon.

**FIGURE 8.7-2: CONTOUR SETTINGS TOOL PANEL**

- **Display/Hide Contour.** Use this button to either display or to hide the line contours after generating them.

- **Increase Number of Displayed Contour Lines.** This tool allows you to increase the displayed number of contour lines.

- **Reduce the Number of Displayed Contour Lines.** Click this button to decrease the number of contour lines for your model.

- **Display/Hide Text Shown on Contour Lines.** Use this button to either display or to hide the labels for the contour lines that are labeled.
8.8 VIBRATION ANALYSIS

8.8.1 General

ADAPT-Floor Pro includes the option to determine the vibration response of a floor system with respect to consideration of full bending stiffness and reduced bending stiffness due to cracking of either slab regions or beams. The formulation used in ADAPT-Floor Pro accounts for the loss of stiffness at the individual finite element cells over the entire floor system.

Inherent to the nature and type of slab systems designed using ADAPT-Floor Pro, the most common design carried out with the vibration module might be that associated with foot drop of walking occupants in residential and commercial buildings, however, the use of the tool is not limited to this. It is important for the user to determine the proper criteria for vibration excitation and susceptibility related to the source of vibration.

The results allow the user to obtain a simple and expeditious first estimate for a floor’s vibration response where the objective is to determine whether a floor meets the serviceability requirements for vibration. The vibration response of a concrete floor is attributed to:

- Consequence of foot drop in residential and commercial floors;
- Rhythmic vibration, such as in dance and sporting events
- Vibration in laboratories or manufacturing facilities
- Vibrations due to vehicular traffic outside a facility
- Vibrations due to the operation of machinery
- Transient impulse due to earthquake, wind or other impact loads

ADAPT Floor-Pro has pioneered a method, whereby from the full 3D model of a building generated for overall design of a structure, a sub-region can be isolated for vibration analysis. Through use of the Excluder tool the program allows the user to draw a boundary around specific region of a floor slab and determine the vibration response of this area of slab. Fig. 8.8-1 shows a portion of a slab identified for analysis as an example. Note that the option, “Limit the analysis to the region” is selected as “inside the polygon.” This will give results for vibration and general FEM results only for the region selected. The support conditions selected for the boundary will have significant impact on the frequency of sub-region. To obtain the more reliable solution, the boundary of selected region should be extend farther away from the panel of interest, in order to minimize the impact of the user selected boundary restraints.
8.8.2 Run Vibration Analysis

Prior to executing the analysis of a model, to initiate the vibration analysis the user should select the option “Include vibration analysis” from Analysis → Analysis → Analysis Options dialog window as shown in Fig. 8.8-2.
From the *Analysis ➔ Vibration ➔ Settings*, the window shown in **Fig. 8.8-3** will appear. In this window, the user can input multiple load combinations for which vibration results will be generated. Load factors and cases can be combined in the window at the bottom, along with the Mass Participation Factors (Rx, Ry, Rz). The Mass Participation Factors are used to release the motion of the added mass from that of the structure in one or more of three global directions (1=fixed, 0=released). You can also set the number of modes for which results will be reported. After new combinations have been added and the number of reported modes is determined, select OK to proceed.
After an analysis has been completed for a given slab, the user can view vibration results from Analysis → Analysis → View Analysis Results. If this is selected, the ADViewer screen will appear as shown in Fig. 8.8-4. Select the “Vibration Results” tab in the left-hand panel and the vibration analysis load combinations will appear for un-cracked and cracked results (if cracked analysis was initiated).

If either of the vibration results is expanded, by pressing the “plus” symbol, the mode numbers are listed and can be selected to view contour results in the screen.

The program reports the frequency (Hz), period (sec) and shows a normalized amplitude scale at the right edge of the screen. The maximum and minimum values in reference to the amplitude scale are also reported.

In order to obtain vibration results based on reduced stiffness due to cracking the user will have to run Cracked Deflection analysis (see Section 8.5.2). It is important to note that in the case when there is more than one load combination set to “cracked deflection” the vibration analysis will be based on stiffness that is calculated for the “cracked deflection” load combination that is defined the last.

FIGURE 8.8-4 RESULTS OF VIBARTION ANALYSIS
# Chapter 9

**VIEW/VALIDATE RESULTS**

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.1</td>
<td>View Analysis Results (ADViewer)</td>
<td>139</td>
</tr>
<tr>
<td>9.1.1</td>
<td>Generate a Bitmap (ADViewer)</td>
<td>140</td>
</tr>
<tr>
<td>9.2</td>
<td>Model Display Tools (ADViewer)</td>
<td>141</td>
</tr>
<tr>
<td>9.3</td>
<td>Display Components/Entities (ADViewer)</td>
<td>142</td>
</tr>
<tr>
<td>9.3.1</td>
<td>Settings for Display Entities (ADViewer)</td>
<td>142</td>
</tr>
<tr>
<td>9.3.2</td>
<td>Result Display Settings (ADViewer)</td>
<td>142</td>
</tr>
<tr>
<td>9.4</td>
<td>Settings for Results Display Toolbar</td>
<td>144</td>
</tr>
<tr>
<td>9.5</td>
<td>Cuts Toolbar</td>
<td>146</td>
</tr>
<tr>
<td>9.6</td>
<td>Scaling Toolbar</td>
<td>149</td>
</tr>
</tbody>
</table>
Once the analysis is completed and saved, you can view and examine the results graphically. You can also obtain tabular reports of the analysis outcome. The focus of this chapter is the graphical view and queries from the graphical display to validate the solution. The tabular reports of the program are described in the chapter on “Reports.”

The description of graphical results in this Chapter focus on the legacy graphical results viewer, *ADviewer*. The current version of the software includes an embedded Results Viewer in the main graphical interface. For more information related to this viewer, use the latest *ADAPT-BUILDER User Manual*.

### 9.1 View Analysis Results (ADViewer)

Open the Results Viewer from *Analysis ➔ Analysis ➔ View Analysis Results*. Once the 3D viewer opens, do the following:

- On the left margin of the screen, click on the *Load Cases/Combinations* button.
- From the list that opens, select *Service* or another load combination, if you did not select the service condition.
- Click on *Results* button on the top of the screen.
- From the list that opens, select *Z-Translation*.
- Finally, click on the *Display Results* tool.

This will display the deflected shape contour of your structure. If the deflected contour does not display, click on this button:

- Use the *Warp Display* and *Rotate* tools to examine the deformation of the structure. In particular, make sure that the slab does not displace excessively where it is supported on walls and columns.
- Use the other tools on the screen for a closer examination of the solution.

---

1 Deflected shape will not be displayed for the load combinations assigned to “strength” code check, nor for “hyperstatic” load case.
9.1.1 Generate a Bitmap (ADViewer)

Click on this tool to capture the 3D viewer image in bitmap format. You can ask the program to save this image for use in project reports or other purposes. Once clicked, the dialog window shown in Fig. 9-1 opens. Note that apart from choosing your own title and location for saving the file, you can specify a title and subtitle for the image and its position of the report page. Fig. 9-2 Illustrates the preview of such a screen capture. The preview shown is accessed from the File pull-down menu.

![FIGURE 9-1 DIALOG BOX FOR SCREEN CAPTURE](image)

![FIGURE 9-2 REPORT SHEET GENERATED BY 3D VIEWER SCREEN CAPTURE](image)

Note that if you wish to copy the display into the Windows clipboard, simply use the standard copy tool that is on the main screen of the 3D viewer.
9.2 Model Display Tools (ADViewer)

- Display the model in solid form
- Display the model in transparent (see through) mode
- Display the model in wire frame
- Display the frames (beams and columns) as lines (represented by their center lines)
- Display the model in color
- Display the model in gray scale (black and white)

Tools to manipulate the solutions displayed by curves are:

- **Scale down values** – reduce the ordinates of the results shown by curve(s)
- **Display values with default scale** – show the ordinates of the solution curve(s), according to the program’s own choice
- **Scale up values** – enlarge the ordinates of the results shown by curve(s)
9.3 Display Components/Entities (ADViewer)

9.3.1 Settings for Display Entities (ADViewer)

This tool opens up the dialog window of Fig. 9-3 that controls the attributes, such as color, line thickness, and font of each of the entities displayed on the screen.

![Settings for Display Entities (ADViewer)](image)

**FIGURE 9-3 DIALOG WINDOW TO CONTROL THE ATTRIBUTES OF THE DISPLAYED ENTITIES**

9.3.2 Result Display Settings (ADViewer)

This tool opens up a dialog window as shown in Fig. 9-4. The dialog window controls the attributes of the displayed solution, such as line color and font.
FIGURE 9-4 DIALOG WINDOW TO CONTROL THE ATTRIBUTES OF THE DISPLAYED ENTITIES

Tools to turn the display of the structural components on or off can be found on the Display Components/Entities toolbar.

Each tool turns on or off the display of the structural component symbolized by its graphics within the ADViewer.
9.4 Settings for Results Display Toolbar

This toolbar controls the display of the results shown in contour form. The following describes the function of each of its tools.

- **Vector plot (Fig. 9.5a)**
- **Line contour (Fig. 9.5b)**
- **Color contour (Fig. 9.5c)**
- **Intensity contour**
- **Max value contour (Fig. 9.5d)**

**Display results.** This tool activates the display of the items you select. When you first enter the 3D viewer, the results of the calculations will be shown on the screen, but only after you select the values to be displayed followed by clicking on this tool.

**Display numerical results for diagrams**

**Display numerical results for contours**

**Warp display (Fig. 9.5e).** This tool displays the contour of your selection in three dimensions.

**Increase warping**

**Decrease warping**
Increase line contour density (Fig. 9.5f)

Decrease line contour density

Two-dimensional viewer. To activate the two-dimensional contour viewer of the program, click on this tool first, then select the result you wish to be displayed.

Start Animation

FIGURE 9-5 DISPLAY OPTIONS
9.5 Cuts Toolbar

This toolbar gives you the ability to view the distribution of the solution values along or across a line you draw (a cut) on the structural model. If applicable, it also gives you the total (integral) of the distribution you have selected over the length of the cut line.

For example, a line drawn across the slab shown in Fig. 9-6(a) shows the distribution of slab deflection along this line. In a similar manner, the distribution of moment about a cut line is shown in Fig. 9-6(b). In addition to the distribution, this figure shows the total value of moment across the cut line drawn. The unit of the distributions displayed will be shown on the hint line at the bottom of your computer screen. If the size of the text is not appropriate, you can change it to a size of your liking using the tool.

![Distribution of deflection and moment](image)

**FIGURE 9-6 DISTRIBUTION OF VALUES AT CUT LINES**

Note that the distributions for the cut lines relate to the slabs, including drop cap/panels only. They do not include the values of beams, walls and columns. Later it is explained how to view the column values graphically.

To initiate a cut line, first click on the tool (Cut Line) located on the left of the toolbar. The program will be ready for a cut that would display any of the four options identified by the four tools on the left of the toolbar (moment, axial, shear and current display). The cut will show the option that is lit. If this is not your choice, click on the tool or the option of your choice, and follow the instructions at the bottom of the screen to proceed with the cut.

The following provides additional information.
Cut Line. This tool creates a vertical section through the floor system along a line that you draw. The program will then show the values of the solution entity you select along or across this line.

Show Moment About Cut Line. Shows moment about a cut line (Fig. 9-7)

Show Axial Force Across Cut Line (Fig. 9-7 (a))

Show Vertical Shear Along Cut Line (Fig. 9-7 (c))

Show Distribution of Contour Quantity Along Cut Line. This tool shows the distribution of the solution that you have currently selected. For example, if you select the distribution of stresses along the X-direction, and click on this tool, the program will show you how these stresses vary along the cut line you have selected. Unlike the previous tools, this tool applies to all the solution results.

Delete All Cut Line. Deletes the user created cut lines.

Export Last Cut Line. You can retain one or more of the cuts you make, along with the associated solution for (i) further investigation, and/or (ii) inclusion in the report of your project. By clicking on this tool, the program stores the information on the cut. In addition, the program will enable you to review other information on the cut when you return to the program’s main screen. For example, if the cut you have generated is to show the bending moment across the cut, when exported, the program will also calculate and display or report other actions, such as shear, stress and reinforcement associated with the cut.
Delete All Exported Cut Lines. This tool cancels the cuts that you had selected for further investigation using the tool described above.

Perpendicular Projection. The distribution of the variable you select can be displayed either on the plane of the floor system (Fig. 9-8(a)), or perpendicular to it (Fig. 9-8(b)). This tool toggles between the two display options.
FIGURE 9-8 DISPLAY OPTIONS OF CUT LINE VALUE DISTRIBUTIONS

Scale Down Values

You can use this tool and the one shown below, to either reduce (Fig. 9-9(a)) or enlarge (Fig.9-9(b)) the display of the solution on a cut line.

Scale Up Values

FIGURE 9-9 DISPLAY OF DISTRIBUTION OF SOLUTION AT A CUT IN REDUCED OR ENLARGED SCALE

9.6 Scaling Toolbar

The functions of the tools in this toolbar are the same as Support Line Result Scale Toolbar that was explained earlier.
10.1 OVERVIEW

Design consists of the calculation of (i) values (Design Values) that you use to determine the adequacy of the structure, and (ii) code compliance. Adequacy can be determined for the performance and safety of the structure under service conditions, and if the structure is post-tensioned, its adequacy at the time the tendons are being stressed (transfer of prestressing). In this section, you will learn how to use ADAPT-Floor Pro to achieve the design objective.

Except for deflection, when you will be looking at specific points in the structure, all other design operations are based on Design Sections or in the case of punching shear an assumed Critical Perimeter.

ADAPT-Floor Pro offers you exceptional flexibility to perform this task because it allows you to.

- Choose to design a specific location of the structure
- Choose a specific region in the structure
- Have the program perform an automatic design for the entire floor system, and generate a professional quality report, ready for submittal

By way of an example, we will describe the three options of performing a design. Figure 10.1-1 shows the floor system selected. The deflected shape of the floor is shown in Fig. 10.1-2.

10.2 DESIGN A SPECIFIC LOCATION

You can select specific locations, such as it is identified by design section 1 in Fig. 10.2-1. The program will determine the design values for this location; find the associated stresses; determine the reinforcement for each of the load cases you have defined; display the stresses in both a tabular and graphical form; find the reinforcement that may be required; find maximum and minimum deflection and report them all for your use.

The envelope of reinforcement required and the bar selection is also shown on the plan of the floor system (Fig. 10.2-1).
FIGURE 10.1-1 3D VIEW OF THE DESIGN EXAMPLE FLOOR SYSTEM

FIGURE 10.1-2 THE DEFLECTED SHAPE OF THE DESIGN EXAMPLE FLOOR
Figure 10.2-2 is the display of the actions at a manually drawn design section, along with the stresses for “service” condition and the envelope of reinforcement required.
For a detailed account on the values reported for manual design sections, the computation of stresses and reinforcement, as well as the method you may use for their verification refer to the Technical Note.¹

10.3 DESIGN A SPECIFIC REGION

Rather than a specific section, you can select a portion of the floor system and execute a design. Fig. 10.3-1 illustrates a portion of the floor system selected for design. The selection is created by using a “splitter” around its boundary.

The direction of reinforcement to be reported by the program, as well as the direction of the stress for stress check, is identified by a support line that you draw across the entire length of the slab sub-region selected for design (Fig. 10.3-2).

The Strip Modeling tool panel from the Floor Design ribbon can be used to auto-generate design sections (Fig. 10.3-3) within the slab sub-region selected and performs a complete code check and design. The outcome of the design, such as distribution of stress and the amount and length of reinforcement needed, will be reported by the program in the standard manner.

FIGURE 10.3-1 IDENTIFICATION OF A SLAB REGION FOR DESIGN

¹ This Technical Note TN-180: “Stress Check and Rebar Verification” is on your program CD-ROM and can be downloaded from ADAPT website, www.adaptsoft.com
10.4 DESIGN THE ENTIRE FLOOR SYSTEM

Once the support lines are laid out for the entire floor system, you will need to generate the design sections from Floor Design ➔ Section Design ➔ Generate Sections New.

From the same ribbon and panel, select Design the Design Sections. Once the design is complete, a message will appear asking if you would like to save the design results.
You can now review the design results for your model by use of *Floor Design ➔ Strip Results/Visibility* (Fig. 10.4-1).

![FIGURE 10.4-1: STRIP RESULTS/VISIBILITY TOOL PANEL](image)

**Display Strip Results**
Opens the ADAPT Solid Modeling Viewer. This tool is used to dynamically view the model components, imported CAD drawings, and view displacements and deformations.

**Results Scale Down**
Reduces the graphical results scale ordinate.

**Default Results Scale**
Resets the graphical results scale ordinate to the program default relative to max/min values on the element or design strip.

**Results Scale Up**
Increases the graphical results scale ordinate.

**Numerical Display**
Displays numerical values at each element node or design section for the selected graphical result in Result Display Settings.

**Display Max/Min Values**
Shows the maximum and minimum values of the selected results.

**Perpendicular Projection**
When selected, displays the selected graphical design strip or beam element result from Result Display Settings in the XY plane. Use Top View for results display.

**Display Manual Design Sections**
Toggles on/off the display of manual design sections.
Display Design Sections
Displays off/on design sections along support lines and is dependent on the selection made for All Section, X direction or Y direction within this tool panel. To generate design sections, go to Floor Design-Section Design-Generate Design Sections. This display is ON by default when sections are generated.

Display/Hide Support Lines
Displays on/off support lines assigned to X and Y directions. If Display Design Sections is active and sections have been generated from Floor Design-Section Design, support lines and design sections will appear. Support lines and sections will be displayed by default for both directions when they are generated.

Display/Hide Support Lines in X-Direction
Displays on/off support lines assigned to X direction. If Display Design Sections is active and sections have been generated from Floor Design-Section Design, support lines and design sections will appear.

Display/Hide Support Lines in Y-Direction
Displays on/off support lines assigned to Y direction. If Display Design Sections is active and sections have been generated from Floor Design-Section Design, support lines and design sections will appear.

Display/Hide Splitters
Displays on/off splitters assigned to X and Y directions.

Display/Hide Splitters in X-Direction
Displays on/off splitters assigned to X direction.

Display/Hide Splitters in Y-Direction
Displays on/off splitters assigned to Y direction.

Display/Hide Support Line Tributaries
Displays on/off tributary regions for support lines with colored polygons and is dependent on the selection made for X and Y direction, X direction only or Y direction only within this tool panel. Tributaries are generated when design sections are generated from Floor Design-Section Design-Generate Design Sections, but are hidden in display by default.
Display/Hide Support Line Tributaries X-direction
Displays on/off tributary regions assigned to X direction. If Generate Design Sections from Floor Design-Section Design has been performed, tributary regions will not be shown by default.

Display/Hide Support Line Tributaries Y-direction
Displays on/off tributary regions assigned to Y direction. If Generate Design Sections from Floor Design-Section Design has been performed, tributary regions will not be shown by default.

Use Analysis → Analysis → Result Display Settings in conjunction with the tools described above to view results and select options for graphical viewing load combination and load case results.

Within the Loads tab of the Result Display Settings window (Result Browser), the appropriate load combination has to be selected. Note that combination envelopes are also available for selection.
In the *Result Display Settings* if you go to *Analysis* → *Design Sections* tree, you can select from five result groups: actions, deflection, stresses, precompression and balanced loading.

- **Action**: Select from the drop-down box one of the six actions that you would like to review. To view the curve for the selected action, the “Display Graphically” button has to be clicked (*Fig. 10.4-1*).

- **Deflection**: Provide the maximum allowable deflection in the text box of the Deflection field. Clicking “Apply” will recalculate the status.

- **Stress**: Select either top and/or bottom stress to review. The stress limits are defined under *Criteria* → *General* → *Allowable Stresses*.

- **Average stress (Precompression)**: You can provide the minimum allowable precompression and compare it to your actual average stress. Click “Apply” to recalculate the status.

- **Balanced loading**: Provide the maximum percentage of the balanced dead load and click “Apply” to recalculate the status.

The status for deflection, stress, average stress and balanced loading provides you an overall view on whether the criteria are met (OK) or not (NG). If the criteria for one result are not met, the color of the respective design section(s) will turn magenta, else the color will stay green.

*Figures 10.4-3 and 10.4-4* show how the program covers the entire floor system by design sections. This is the only option that guarantees the safety and code compliance of the entire floor system.

A sample stress check for one of the design strips is shown in *Fig. 10.4-5*. 
10.5 PUNCHING SHEAR DESIGN

ADAPT-Floor Pro performs an automatic punching shear design, reports the calculated punching shear stresses, and provides punching shear reinforcement, where required. You have the choice of specifying whether the punching shear
reinforcement should be in the form of stirrups, studs or otherwise. In checking for punching shear, the program automatically recognizes whether a column’s position is at interior, edge, or corner. Depending on the position of a column with respect to a slab edge, the program will automatically select the correct formulation and perform the relating code check. For ADAPT-Builder 2019 and later versions there are additional punching shear features as outlined in the ADAPT-Builder 2019 New Features Supplement manual.

Where there is a change in slab thickness at a column location, or its immediate vicinity, the program will conservatively select the smaller slab thickness for punching shear.

At locations of a drop cap or drop panel, the program performs the punching shear check both within the thickened drop cap/panel and in the slab outside the perimeter of the drop cap/panel.

Where punching shear reinforcement is required, the program continues checking the column-slab adequacy at code-specified successive layers (critical perimeters) around the column, until it reaches the perimeter, where no reinforcement is needed.

No punching shear check is performed for walls that have a length-to-thickness ratio larger than the program’s default setting [4], or for columns butted by one or more beams. At these locations, the program reports (NA; Not Applicable). Punching shear design options are selected from Criteria ➔ Design Criteria ➔ Shear Design (Fig. 10.5-1).

![FIGURE 10.5-1 SHEAR DESIGN OPTIONS](image-url)
The punching shear check can take place after you have successfully completed the analysis stage of your work. Select *Floor Design ➔ Punching Shear ➔ Execute Shear Check*. If the model being checked for punching shear is set to the EC2, BS8110 or Hong Kong design codes an additional window, as shown in Fig. 10.5-2, will appear. If the design sections have not been designed and reinforcement has not been generated, the program will default to using the minimum reinforcement ratio per code in addition to contribution from precompression in calculating concrete shear strength.

If the design of sections and reinforcement has been carried out and the punching shear analysis is checked, the program gives the option to use the minimum reinforcement ratio or some percentage contribution of the program-calculated mild reinforcement envelope and/or bonded tendons in addition to contribution from precompression.

![Punching Shear Check](image)

**FIGURE 10.5-2 PUNCHING SHEAR CHECK REINFORCEMENT RATIO – AFTER REBAR DESIGN**

The display of results on the screen and the tabular report of the program are illustrated by way of the following example. Figure 10.5-3 (a) shows the view of a slab supported on columns and a wall. The column identification is shown in part (b) of the figure. For the American code version of the program, you have the option of considering the moments in each of the orthogonal directions separately along with the column reaction (recommended), or consider the moments acting simultaneously. Parts (c) and (d) of the figure show the results from each of the two options. Two stress ratios (SR) are reported, if the moments are considered separately. Otherwise, one stress ratio (SR) for the combined moment will be reported.
New to ADAPT-Builder 2018 build 3 and later releases, the software now groups the punching shear graphical results in with the Result Browser. After the user performs a two-way shear check by going to Floor Design → Execute Shear Check, the user can go to the Analysis tab of the Results Browser and expand the Punching Shear tree as displayed in Figure 10.5-4 to view the punching shear results. Note that two-way shear is a strength level check, as such, the Strength Envelope or a singular Strength combination needs to be selected on the Loads tab of the Results Browser before the Punching Shear tree results become active.
Figure 10.5-4 shows the graphical results that are available in the software. An explanation of each is as follows:

**Stress Check.** When this option is selected the following design outcomes for the selected load combination are displayed:

- “OK” - calculated stresses are below allowable stresses
- “Reinforce” - calculated stresses exceed allowable stresses and design code requires reinforcement
- “Exceeds Code” - design code requirements are not satisfied
- “NA” - punching shear design is not applicable

**Stress Ratio.** When this option is selected the punching shear stress ratios for the selected load combination will display on the screen. The maximum and minimum ratios are also reported in the results legend at the top left of the modeling window.

**Condition.** When this option is selected the following columns position and designation for shear check, as well as the first critical section at the face of the column and drop cap/slab thickening is displayed.

**Reinforcement.** When this option is selected the program will display a graphical representation of the shear reinforcement to scale on plan. An example is shown in Figure 10.5-5. The legend for the text is also shown in the upper left of the modeling window.
ADAPT-Floor Pro provides a clear summary of the actions on each column, the design values and the outcome of the code check. The program’s calculations and findings for the punching shear check are presented in the Reports section of the manual. A sample of punching shear reinforcement for stirrups is given in Table 10.5-1. A similar output for shear stud reinforcement is listed in Table 10.5-2. In addition, the software now reports more detailed results summary in the form of a .xls report. This report can be located by going to Reports → Punching Shear → Punching Shear Report.

The reinforcement metrics reported in the two tables reads as follows: For stirrup reinforcement of Column 6 (Table 10.5-1): 10 legs at a distance of 3.00” from the face of column, followed by 4 legs at distance 6.25” from the face of column. The 10 and 4 legs are the total number around the perimeter of the column. Stirrup diameter is 0.5” (#4)

For shear stud reinforcement (Table 10.5-2): 2 stud rails are specified per column side. For Column 6, each rail has 4 studs. The position of studs of each rail from the face of column is: 1.50, 3.25, 4.75, 6.50”. The stud diameter is 0.38”.

FIGURE 10.5-5 PUNCHING SHEAR TREE REINFORCEMENT RESULT
### TABLE 10.5-1 PUNCHING SHEAR REINFORCEMENT USING STIRRUPS

#### 180.80 SCHEDULE OF STIRRUPS FOR PUNCHING SHEAR REINFORCEMENT

**Load Combination: Strength (Dead and Live)**

<table>
<thead>
<tr>
<th>Column ID</th>
<th>Perimeter</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>7</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td>19.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>7</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td>19.00</td>
<td>22.25</td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>10</td>
<td>7</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Distance</td>
<td>(8)25.25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>(8)6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td>19.00</td>
<td>22.25</td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>10</td>
<td>6</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

**Load Combination: Strength (Dead Load Only)**

<table>
<thead>
<tr>
<th>Column ID</th>
<th>Perimeter</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>7</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td>19.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>7</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td>19.00</td>
<td>22.25</td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>10</td>
<td>7</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Distance</td>
<td>(8)25.25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>(8)6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td>19.00</td>
<td>22.25</td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>10</td>
<td>6</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

**Load Combination: Envelope Strength**

<table>
<thead>
<tr>
<th>Column ID</th>
<th>Perimeter</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>7</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td>19.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>7</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td>19.00</td>
<td>22.25</td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>10</td>
<td>7</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Distance</td>
<td>(8)25.25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>(8)6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Distance</td>
<td>3.00</td>
<td>6.25</td>
<td>9.50</td>
<td>12.50</td>
<td>15.75</td>
<td>19.00</td>
<td>22.25</td>
</tr>
<tr>
<td></td>
<td>Legs</td>
<td>10</td>
<td>6</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

**Notes:**

Distances are in (in)
- **Legs** = total number of vertical reinforcing bars for the layer: bar size #4(0.50in)
- **Distance** = distance of the vertical reinforcing bars from the respective column face
- Distance (9)15.75 indicates layer 9 at distance 15.75 in
- Legs (9) 12 indicates layer 9 with 12 vertical legs
- Distance (9)15.75* indicates layer 9 at distance 15.75 in measured from the face of drop caps
- ***** = exceeds maximum allowable by code
- Refer to details for arrangement (**Fig 10.5-6**).
TABLE 10.5-2 PUNCHING SHEAR REINFORCEMENT USING SHEAR STUDS

180.90 SCHEDULE OF STUD RAILS FOR PUNCHING SHEAR REINFORCEMENT

<table>
<thead>
<tr>
<th>Label</th>
<th>Column ID</th>
<th>Number of rails per side (rr, ss)</th>
<th>Number of rails</th>
<th>Stud diameter (in)</th>
<th>Rail Length (in)</th>
<th>#Studs @ spacing (in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column 2</td>
<td>2</td>
<td>2,2</td>
<td>6</td>
<td>0.50</td>
<td>6.00</td>
<td>2@2.8</td>
</tr>
<tr>
<td>Column 5</td>
<td>5</td>
<td>2,2</td>
<td>6</td>
<td>0.50</td>
<td>6.00</td>
<td>2@2.8</td>
</tr>
<tr>
<td>Column 6</td>
<td>6</td>
<td>2,2</td>
<td>8</td>
<td>0.50</td>
<td>12.00</td>
<td>4@2.8</td>
</tr>
<tr>
<td>Column 7</td>
<td>7</td>
<td>2,2</td>
<td>8</td>
<td>0.50</td>
<td>12.00</td>
<td>4@2.8</td>
</tr>
</tbody>
</table>

Notes:
10@100 = rail placement at face of support.
10@100* = rail placement at face of drop.
Refer to details for arrangement (Fig. 10.5-7).

FIGURE 10.5-6 ARRANGEMENT OF PUNCHING SHEAR REINFORCEMENT USING STIRRUPS
10.6 REINFORCEMENT SPECIFICATION AND DISPLAY

This section describes the features available for reinforcement specification and display. Basic features allow you to specify mesh reinforcement prior to design, to display reinforcement plans, and to generate reinforcement reports. Advanced operations include specifying rebar and editing rebar drawings, predefining beam rebar, inserting templates of beam details in your drawing, and more.

10.6.1 Basic Features

Basic features for reinforcement specification and display enable you to:

- Specify mesh reinforcement.
- Generate rebar drawing in plan.
- Control reinforcement display.
- Print/plot reinforcement plan.
- Generate tabular reports.

All basic tools related to reinforcement specification and display are grouped in the *Rebar* ribbon.
Rebar Ribbon

Rebar Cover
Opens the **Criteria – Rebar Minimum Cover** menu to define the top and bottom cover distance to non-prestressed longitudinal reinforcement. For two-way slabs the distance defined is relative to the outer layer of reinforcement. Open **Support Lines – Design** properties to define outer and inner layers for reinforcement of the strip. For one-way slabs and beams the distance defined is relative to the reinforcement parallel to the support line.

Rebar Size/Material
Opens the **Criteria – Preferred Reinforcement and Material** menu to define preferred reinforcement sizes, reinforcement material assignments and select a default rebar library. Rebar libraries can be modified and imported/exported. Define top and bottom flexural bar sizes for one-way, two-way and beam criteria and shear stirrup size for beams.

Rebar Round-Up
Opens the **Criteria – Rebar Round Up** menu options for bar length and spacing detailing options. Use this menu to input length and spacing distance rounding, bar spacing limits (RC mode only) and defining Rebar Library Lengths.

Rebar Lengths
Opens the **Criteria – Reinforcement Bar Lengths** menu options for longitudinal reinforcement cut-off lengths and bar extension lengths. Cut-off lengths apply to minimum reinforcement over supports and in the span for slabs and beams. Bar extension distance is applied to reinforcement...
required for Strength combinations (demand moments). Options are available for adjusting bar lengths and position for graphical rebar output.

**Mesh**

Creates a mesh reinforcement region by graphical or coordinate entry of the mesh polygon vertices. Use **ENTER** or right-click **Close/End/Accept**, to close the polygon. Select **ESC** or right-click **Exit** to close the command. Double-click on the mesh symbol to modify mesh properties or use **Modify-Item Properties** prior to placement. Slabs of varying offsets should be assigned unique mesh reinforcement regions.

**Mesh Wizard**

Opens the **Create Mesh Reinforcement Automatically** dialog to select the reinforcement position, CGS, and bar area or size and spacing. Requires selection of at least one slab or polygon to map load input to the region. Slabs of varying offsets should be assigned unique mesh reinforcement regions.

**Banded**

Creates banded (grouped) rebar by graphical or coordinate entry of the rebar start and endpoint. Select **ESC** or right-click **Exit** to close the command. Double-click on the rebar to input properties or use **Modify-Item Properties** prior to placement.

**Distributed**

Creates distributed rebar by graphical or coordinate entry of the rebar start and endpoint and distribution range. Select **ESC** or right-click **Exit** to close the command. Double-click on the rebar to input properties or use **Modify-Item Properties** prior to placement.
Calculated Rebar Plan
Opens the **Generate Rebar Drawing Options** dialog to select combinations, bar length selection and orientation for graphical display of calculated reinforcement for X and Y design strips at top and bottom locations.

Display Manager
Opens the **Rebar Display Manager** dialog to select rebar graphical display options for calculated and base strip and mesh reinforcement.

Display/Hide All Rebar
Displays on/off all reinforcement.

Print Settings
Opens the **Rebar Plot Settings** dialog to configure the rebar appearance settings for printing.

Export Settings
Opens the **DWG/DXF Export Settings For Reinforcement** dialog to configure the rebar appearance settings for export to AutoCAD files.
10.6.1.1 Mesh Reinforcement Specification

You can specify a base mesh reinforcement in the slab prior to the design of your structural model. The program automatically accounts for the presence of the reinforcement specified by you, and will calculate and report the reinforcement required in addition to the amount you provided.

You can add mesh reinforcement using:

- **Rebar ➔ Model Base Rebar ➔ Mesh or Mesh Wizard**
  Click on the tool to initiate the identification of the area over which you plan to specify the base reinforcement. Follow the instructions on the screen to draw the area covered by the mesh. **Figure 10.6-1** displays a region drawn to represent a mesh coverage. The program will apply the mesh only over the slab regions within the area specified by you.

![Figure 10.6-1 DEFAULT DISPLAY OF MESH](image)

**FIGURE 10.6-1 DEFAULT DISPLAY OF MESH**

Double click on the mesh to open its property dialog box (**Figure 10.6-2**). In this dialog window, you can specify the following:

- Area of reinforcement in each direction
- Orientation of the mesh with respect to the global coordinates
- Position of the mesh at the top or bottom of the slab, and the distance to the centroid of the mesh bars in each direction from the slab surface
In Figure 10.6-2, and throughout the mesh reinforcement data input, it is assumed that the primary mesh reinforcement will be placed in direction 1-1. Optionally, a second set of parallel reinforcement can be specified in direction 2-2 normal to 1-1.
The specified reinforcement need not be in the direction of the global axis. The orientation of the reinforcement with respect to the global axis X-X, however, must be specified. This is achieved by declaring the angle between the X-X axis and direction of the primary reinforcement in the mesh (1-1) measured counterclockwise. Further, by specifying the CGS (Center of Gravity of Steel) from the bottom fiber of the member for the bottom mesh, or from the top fiber of the member for the top mesh, you identify which layer of reinforcement is the inner and which is the outer.

To specify mesh reinforcement you can also use Mesh Rebar Wizard tool. The advantage of the wizard is that you no longer need to draw the boundaries of the mesh, if the slab region over which the mesh applies has already been defined. When you activate the Mesh Rebar Wizard, the program first asks you to identify the slab region over which you want to specify a mesh. Once you identify the region, the program places a mesh using its default values. Next, you will edit the properties of the mesh specified by the program, if the default values are not as you choose. To edit the mesh reinforcement, double-click on it.

The mesh reinforcement input dialog window (Figure 10.6-3) will open. Enter the mesh details.

![Create Mesh Reinforcement Automatically Dialog Window](image.png)

**FIGURE 10.6-3 CREATE MESH REINFORCEMENT AUTOMATICALLY DIALOG WINDOW**
10.6.1.2 Generation of Rebar Drawing

The program can generate a plan view of the reinforcement for each load combination after you complete the design of your structural model. To create the drawing follow the steps below:

1. Go to Floor Design ➔ Rebar ➔ Calculated Rebar Plan

2. The dialog window shown below opens

![Generate Rebar Drawing Options](image)

3. From the drop-down list select the load case for which you would like to display the calculated reinforcement

4. Select if the displayed bar length will be equal to the calculated length or taken from the library you previously defined.

5. Set bar orientation.

6. Click OK.

7. The program displays a plan such as shown in Figure 10.6-4 (1), with the reinforcement displayed according to the program’s default settings. You can control the display as described below.
In addition to the plan view you can also see calculated rebar in elevation along each support line.

To see the reinforcement in elevation, do the following:

- Turn on the support line.
- Select the support line (double-click on it).
- From the support line property box, select the section display tool and click at the location where you want to insert elevation view. The program will display the reinforcement along the support line as shown in Figure 10.6-4(2).
10.6.1.3 Reinforcement Display Control

The display of reinforcement can be controlled from
Rebar ➔ Visibility ➔ Display Manager.

This tool opens the dialog window shown in Fig. 10.6-5. The
dialog window gives you full control over the display of
reinforcement. Several of the options available in the dialog
window are explained in its Help file, reproduced in Fig. 10.6-
6. The remainder is either self-explanatory, or described next,
by way of using a partial plan of a typical rebar display. The
partial plan (Fig. 10.6-7) displays two columns and the span
between them. In this figure, the top bars (marked “T”) over
the column are grouped together, but the bottom bars in the
span (marked “B”) are distributed over a range identified by
the extents of the arrows.

FIGURE 10.6-5 REBAR DISPLAY OPTIONS WINDOW
Below are descriptions of some of the other options listed in the rebar display dialog box. For clarity in illustration, only the bottom bars are displayed. The solid line between the two columns represents the support line for which the reinforcement was calculated.

- **Display design moment (strength) along Support Lines.**
  In a similar manner, the design moment used to calculate the reinforcement for strength condition of the design can be displayed on the support line along the rebar reported by the program. This is critical information, in particular for
non-prestressed slabs, where the inflection points along the moment diagram determine the cutoff points of the bars.

- **Circle Size/Symbol Size.** The number in this data field controls the size of the circle that is drawn at the intersection of a bar and the line that represents its extent.

- **Arrow Size/Symbol Size.** The number in the data field controls the size of the arrow arms at the end of the extent line of distributed reinforcement.

- **Rebar End Symbol Size.** This determines the size of the small square that marks the end of a bar required by calculation. The extension of a bar beyond this symbol is the development length. You define the development length as part of the input data in the “Criteria” input tab of the program.

- **Rebar Line Thickness.** This data field specifies the thickness of the rebar line shown on the computer screen.

- **Mesh Rebar Line Thickness.** This data field specifies the line thickness of the display symbol selected for the mesh reinforcement on the plan.

- **Tag base reinforcement.** This option allows you to easily distinguish between base and calculated rebar on the rebar plan. Once checked the program marks all base rebar with label “BR” (see Fig. 10.6-8)

You can control the size of the display font (size of text) by changing the font size of the “Rebar” item from Visibility → Display Settings → View Settings. This adjusts the size of the font on the screen for better viewing.

The text of the bar normally appears below its line. However, you can pick the cross (shown in Fig. 10.6-8 over the numeral “6”) and move it to the location of your choice. The ability to move the text helps to alleviate congested displays.

**FIGURE 10.6-8**

10.6.1.4 Detailing, Printing, Plot Preparation and Reporting

Text, line thickness and symbol sizes that are suitable for viewing a drawing on the computer screen are not necessarily optimal for large-size drawings common in construction.
practice. As a result, prior to either plotting or exporting your drawing, you would select a set of suitable text and line sizes. The program allows you to set default values for your print and plot outputs, without affecting the view of the structure on the screen.

Use the tools located at Rebar ➔ Reporting.

These reporting tools enable you to set the parameters of printing or plotting your model. The tools are described in more detail at the beginning of this section.

Access reporting tools from Reports ➔ Single Default Reports ➔ Rebar. Descriptions of each of these reports is shown below.

**Rebar List**
Generates a .RTF file with size, quantity, and length for calculated and base reinforcement in the current mode.

**Rebar Legend**
Generates a .RTF file for a rebar legend with like reinforcement for size, length and placement (T or B) in the current mode.
Rebar Totals
Generates a .RTF file with total size, quantity, length and cost for all longitudinal reinforcement in the current mode.

Design Section Rebar Tabular Report
Generates a .RTF tabular report for required flexure and shear reinforcement at design sections in the current mode.

Punching Shear Reinforcement
Generates a .RTF file with schedule for stud rails or links at column locations requiring shear reinforcement.

Rebar Plan
Opens the Rebar dialog for display selection and creates a plan view of reinforcement for the current level.

10.6.2 Advanced Features (DRD Module)

In addition to the basic features already explained in previous sections, you can use advanced features. Advanced features are specific for the “Dynamic Rebar Design Module” (DRD) and are included in Floor Pro and MAT. These features enable you to:

- Interactively edit the reinforcement calculated by the program and shown on its rebar drawings. Dynamic editing means that any change you make in any of the rebar properties, such as its size, results in an automatic change in the associated properties of the same bar. For example, if you change the diameter of a bar, the program automatically changes the number of bars to keep the total area the same. In addition to links among the properties of a single bar, such as its area and nominal size, each rebar, being a live object, is linked upstream with the information in your structural analysis model, and downstream with the list of quantities and reporting. A change you make in the layout of a bar will automatically be reflected in your structural model and your report.

- Define a single bar or a group of reinforcing bars at the location of your choice prior to the structural calculation. At design stage, the program will recognize the pre-defined reinforcement (base reinforcement), and report added reinforcement, should the rebar you define not be adequate.

- Once the program completes the design, it reports the entire reinforcement necessary, including the base reinforcement that you may have pre-defined as input.
In line with the practice of creating engineering drawings, the program displays the slab rebar on plan, and the beam rebar on the elevation of the beam.

Each reinforcement entity on plan is clearly annotated, giving the number of bars, size, and length. Once the entities are displayed on plan, you have full control to change the bar number, its size and length. However, since the bars displayed on plan are not merely lines, but are defined as “objects” linked with the remainder of your design parameters, the program can guide you in your bar editing and let you know whether the change of length, location and other characteristics that define a reinforcing bar are in violation of the code requirements used by the program.

Along the length of a bar on plan, you can request that the program display the bending moment diagram used in the determination of the bar’s value and length. Also, the program can show you graphically the minimum amount of the reinforcement necessary for each location, alongside the reinforcement provided by you or the program.

For the beams, the program displays on the beam elevation the reinforcement that is necessary along with the four corner bars you select. The location of each added bar is shown clearly on the elevation. Again, you have full control to edit the reinforcement selected by the program.

The stirrup requirements of a beam are also shown graphically on the elevation of the beam, ready to be exported to the structural drawings.

A complementary feature to the rebar module is the summary report of the entire non-prestressed reinforcement shown on your drawing. This consists of the reinforcement that was used in the calculation and reported by the program, along with the reinforcement that you may have added manually and subsequent to the calculations for structural detailing.

The tools not listed below were explained in Section 10.6.1.

10.6.2.1 Bonded and Distributed Bars Specification

You can specify reinforcement for the program to account for in its calculation as pre-defined (base reinforcement), add reinforcement subsequent to the program’s design and display of reinforcement, and modify the reinforcement reported by the program. There is full flexibility both in the specification of
reinforcement, and its editing. The following distinction is important, however:

If you want the given base reinforcement you define to be accounted for by the program when it goes through its code check and design process, you have to define the base reinforcement before the program goes through its design process. The reinforcement that you define, or edit subsequent to the calculation by the program, will appear on your drawings and cause a change in the base reinforcement that you may have defined, but will not go through the code check of the program, unless you reactivate the design process of the program.

To create banded rebar, select Rebar → Model Base Rebar → Banded 🏛️. Once you click on it, the program prompts you to draw on the plan the location and length of the reinforcement, using the mouse. Depending on the system of units you selected, the program will display a bar with its default values, such as shown in Figure 10.6-12. Once the default rebar is created, you can modify it to the bar of your choice as described below:

![Figure 10.6-12 CREATION OF DEFAULT REBAR](image)

If you double-click on the rebar shown, its property window (Fig. 10.6-13) opens. Using the options provided in the property window of the rebar, you can fully edit the bar selected. Among the many properties, you can edit the number, size, length, cover, and whether the bar is at top or bottom. The program allows you to specify any rebar as base reinforcement. If you select “Base”, the program keeps this rebar in case you re-design the structure. When re-designing, the program would only provide reinforcement that is needed in addition to the base reinforcement. Once you change the bar to “Base” you cannot switch it back to “Calculated”. The bar can be deleted or modified.

If distributed is selected for rebar distribution you have the option to fix the number of bars and/or the spacing as desired. If the number of bars is fixed the spacing and extents will be newly calculated as necessary. The same applies if the spacing is fixed the number of bars and extents will be calculated
accordingly. If a specific number of bars and spacing is
required and fixed the extents will be adjusted accordingly.

The “Location” tab (Figure 10.6-14) allows you to edit the
rebar by specifying its coordinates, as opposed to using
graphical tools. The “Help” button on the dialog box provides
additional guidance.

![Figure 10.6-13 Distributed Rebar Property Window](image1)

**FIGURE 10.6-13 DISTRIBUTED REBAR PROPERTY WINDOW**

![Figure 10.6-14 Definition of Rebar by Coordinates](image2)

**FIGURE 10.6-14 DEFINITION OF REBAR BY COORDINATES**

There are several convenient graphical tools that allow you to
edit the length, location and display of bar reinforcement.

- If you click on a bar (select it) as shown in **Figure 10.6-15(a)**, two small squares, one at each end, appear on it. The
distance between each small square and the tip of the bar represents the development length of that bar.

- To change the length of a bar graphically, or to rotate it, select one of the squares at its ends and drag it (part (b) of the figure).
- To move a bar parallel to itself, select one of the squares, hold down the “Control” key and drag (part (c) of the figure).
- To change the extension of distributed bars, select the arrow and drag it to the new location.

Other editing tools, such as move and copy, that are available for other components can be used for rebar also.

(a) Rebar Activated for Editing

(b) Pick a Square and Drag to Edit

(c) Pick a Square, Drag While “Control” Key is Depressed

**FIGURE 10.6-15 MODIFICATION OF BAR REINFORCEMENT LENGTH**

To create banded rebar select *Rebar ➜ Model Base Rebar ➜ Distributed*. The distributed rebar tool is used when a number of identical bars with identical spacing are to be specified over a given area of a slab, such as #4 bars, each 6’0” in length, spaced at 16” on center over a 14-foot width of slab (T12x2300@300 mm o.c. over a distance of 4m).
- Click on the tool and follow the instructions on the command line (bottom of the screen) to complete the display of a group of distributed bars as shown in Figure 10.6-16(a).

- You can edit the features of the distributed bars displayed in a similar manner to the single bar (part (b) of the figure).

- In addition, you can move the extension line of the bar parallel to itself, by selecting the tip of one of the arrows and dragging it to a new location.

- Using the same procedure as above, you can change the extent of a bar. Once the extent of a bar is changed graphically, the program automatically adjusts the bar spacing, so as to maintain the total area of steel over the selected region.

![Display of Distributed Bars](image1)

![Shift of Extension Line](image2)

**FIGURE 10.6-16 DISPLAY OF DISTRIBUTED BARS**
Chapter 11

REPORTS

11.1 OVERVIEW ........................................................................................................ 193
11.2 REPORT COMPONENTS .................................................................................. 193
  11.2.1 Default Reports of the Program............................................................... 193
  11.2.2 Program/User Generated Reports .......................................................... 193
  11.2.3 Text-Based Information from Other Sources (External-Text)................. 194
  11.2.4 Graphics-Based Information from Other Sources (External-Graphics)... 194
11.3 REPORT GENERATION .................................................................................... 194
  11.3.1 Print Panel ............................................................................................... 195
  11.3.2 Compiled Reports .................................................................................... 195
    Open Report Compiler .................................................................................. 195
    Take Report Screenshot .............................................................................. 198
  11.3.3 Single Default Reports Panel................................................................. 199
    11.3.3.1 General ......................................................................................... 199
    Report/Project Title Settings ....................................................................... 199
    Report Cover ......................................................................................... 199
    Material and Design Criteria ..................................................................... 199
    Quantity and Cost ............................................................................... 199
    11.3.3.2 Structural .................................................................................. 200
    Slab Regions Detailed Report .................................................................. 200
    Slab Regions Summary Report .................................................................. 200
    Openings Detailed Report ....................................................................... 200
    Beams Detailed Report ......................................................................... 200
    Columns Detailed Report .................................................................... 200
    Drop Caps/Panels Detailed Report .......................................................... 200
    Walls Detailed Report ........................................................................... 201
    Point Springs Detailed Report ................................................................. 201
    Point Springs Summary Report ............................................................... 201
    Area Springs Detailed Report ................................................................. 201
    Releases and Restraints Detailed Report ................................................. 201
11.3.3.3 Loads ................................................................. 201
Load Cases and Combinations ....................................... 202
Skip Pattern ................................................................. 202
Applied Loads ............................................................. 202
Dead Load ..................................................................... 202
Live Load ....................................................................... 202
User Defined Load Cases .............................................. 202
Column Tributary .......................................................... 202
Tributary Load Check .................................................... 202

11.3.3.4 Tendon ............................................................ 203
Tendon Report ............................................................... 203
Tendon Group Report ..................................................... 203
Tendon Elongation, Individual Report ......................... 203
Tendon Elongation, Group Report ............................... 203
Tendon Totals ............................................................... 203
Felt 3D Long-Term Loss .............................................. 204
Felt 3D LTL - Single Strand ......................................... 204
Tendon Plan ................................................................. 204

11.3.3.5 Rebar ............................................................... 204
Rebar List ..................................................................... 204
Rebar Legend ............................................................... 204
Rebar Totals ............................................................... 204
Design Section Rebar Tabular Report ......................... 204
Punching Shear Reinforcement ..................................... 205
Rebar Plan ................................................................. 205

11.3.3.6 Punching Shear ................................................ 205
Stress Check Parameters .............................................. 205
Stress Check Results .................................................... 205
Punching Shear Reinforcement ..................................... 205
Punching Shear Report (XLS) ....................................... 205

11.3.3.7 Column ........................................................... 206
Column Reactions – Tabular (RTF) .............................. 206
Column Design .......................................................... 206
Column Tributary ......................................................... 206
Tributary Load Check .................................................. 206
Column Design Summary ............................................ 206

11.3.3.8 Wall ............................................................... 207
Wall Reactions - Tabular (RTF) ..................................... 207
Wall Reactions - Graphical .......................................... 207
Pier Reactions ............................................................. 207
Wall Design Sections .................................................. 207
Wall Design Summary ................................................ 207
Wall Intersection Summary ......................................... 207

11.4 Analysis Reports Panel ............................................ 208

11.4.1 Design Section/Strip ............................................ 208
Design Section Forces Tabular Report ........................................... 208
Design Section Rebar Tabular Report ............................................ 208
Design Section Moment Capacities Tabular Report ..................... 208
Design Section Dimensions Tabular Report ................................. 209
Design Section Geometry Tabular Report .................................... 209
Support Lines X-Direction Plan ...................................................... 209
Support Lines Y-Direction Plan ...................................................... 209
Design Strips X-Direction Plan ...................................................... 209
Design Strips Y-Direction Plan ...................................................... 209
Design Check X-Direction Plan ....................................................... 209
Design Check Y-Direction Plan ....................................................... 209

11.3.4.2 Analysis Data ................................................................ 209
Equilibrium Check ........................................................................ 210
Solution Statistics .......................................................................... 210
Analysis Nodes ............................................................................. 210
Analysis Elements ......................................................................... 210
Analysis Mesh Plan ....................................................................... 210
Drift Report .................................................................................. 210

11.3.4.3 Reactions ........................................................................ 210
Point Support Reactions ............................................................... 210
Line Support Reactions ................................................................. 211
Point Spring Reactions ................................................................. 211
Line Spring Reactions ................................................................. 211

11.3.5 Export DWG Panel ............................................................... 211

Export DWG/DXF ........................................................................ 211

11.4 REPORT GENERATION UTILITIES ........................................ 211
11.4.1 Report Font ......................................................................... 211
11.4.2 External-Text ........................................................................ 211
11.4.3 External-Graphics ................................................................. 212
11.4.4 Program-User Report Components ...................................... 212

11.5 LIST OF THE PROGRAM GENERATED REPORTS .................. 212

11.6 SELECTED SAMPLE OF PROGRAM GENERATED REPORTS .... 214
11.1 OVERVIEW

ADAPT-Floor Pro’s report-generation capability enables users to create highly professional and targeted reports. Intuitive and highly versatile, the report-generation features make it easy for you to create detailed documentation on all aspects of your work, from basic structural layout all the way to quantities and fabrication drawings. These reports are ideal for a variety of uses:

- For submittal to building officials and plan check
- For validation of the program, verification, post-processing, documentation
- For creations of structural documents
  - Structural drawings
    - Rebar drawings
    - Post-Tensioning drawings
- Fabrication (shop) drawings
- Cost estimating, and quantities

11.2 REPORT COMPONENTS

11.2.1 Default Reports of the Program

ADAPT-Floor Pro automatically generates a comprehensive list of pre-programmed reports, including:

- Stress check results
- Column reactions
- Live load plan

The default reports are broken down into tabular and graphical groups

11.2.2 Program/User Generated Reports

During the creation of data, execution of the program and the design process, you have the option to capture the image on the computer screen, crop it, annotate it, edit it, save it, and include it in your final report. These
are referred to as “Program/User” generated report components. Once created, they remain available to you to edit, delete and save at your current session or subsequent sessions.

11.2.3 Text-Based Information from Other Sources (External-Text)

The program can import a text-based file and include it in your report at the location of your choice. The text file can be of any length. Once imported, it can be viewed and edited prior to compilation and printing of the report. The program refers to imported text as “External-Text.”

11.2.4 Graphics-Based Information from Other Sources (External-Graphics)

Graphics stored in bitmap format can also be imported by the program, viewed, edited, and included in the report.

11.3 REPORT GENERATION

There are two options in report generation: (i) you can generate a “Single Report” for the purpose of viewing or printing a given set of information, or (ii) you can create “Compiled Reports” that are made up of more than one report component. Again, you can view, edit, save or discard either type. The compiled reports are made up of a grouping of selected single reports. Each report section is described below.

Report generation is initiated from the Reports ribbon. (Fig.11.3-1)
11.3.1 Print Panel

Print
Opens printer selection and settings and prints active screen.

11.3.2 Compiled Reports

Open Report Compiler

Opens the Report Generation Manager for selecting tabular and graphical reports and screenshots to be generated as a compiled report. After making selections, use FILE-Generate Compiled Report.

Compiled reports are created through Report Generation Manager (RGM) (Fig. 11.3-3). The following four functions/features of the Report Generation Manager are critical to its effective use.
The Report Generation Manager uses the resources available to it, and your instructions to compose a report. The resources available to the RGM are:

- **Default Reports of the Program.** You can access the program-generated default reports through the check boxes on the left side of the RGM dialog window. These include both the tabular and graphical reports. The default reports include all that is listed under single reports in 11.3.1 plus a “Content List.”

- **Program/User Generated Reports.** Any screens captured by you during the course of data generation and execution will all be listed in the RGM for your view and possible inclusion in the finished report. Figure 11.3-4 shows an example for a list containing three user-generated screens from the program.

- **External Text.** Text files you have imported for possible inclusion in your report will be listed in RGM as shown in Fig. 11.3-5.
External Graphics. The graphics that you have imported for possible inclusion in your report will be listed under in the RGM as illustrated in Fig. 11.3-6.

FIGURE 11.3-6 EXAMPLE FOR A LIST OF IMPORTED EXTERNAL-DRAWINGS/IMAGES

COMPOSITION. Reports are composed as follows:

- Select Report Components. You select the report parts to be included in the compilation by (i) checking the box in front of them, and (ii) shifting them to the window on the right side of the RGM, using the arrow “=>” between the two windows.

- Arrange the Report Components. Arrange the sequence of the report parts with the following tools:
  - Move up: shifts the selected report component toward the beginning of the report
  - Move down: shifts the selected report component toward the end of the report
  - Delete selected reports: removes the report components marked from the compiled report. If a report component is removed accidentally, you can always go back to the list of report parts in the left window of the RGM and add them back to your compiled report.

VIEW/EDIT. You can view and edit any of the report components you have included in the compiled report as follows:

- Select the report component by placing the cursor on it and left clicking the mouse to highlight the item;
• Click on the View/Edit menu item at the top of the RGM.

This will open the report component for your view. At this time, you have the option of editing the displayed report component. If you save the edited report component, it will be included in your final report in its edited format. However, if you decide to restore the report to its original un-edited format, you can do so. Simply select “Regenerate Reports” from the “File” pull down menu of the RGM screen.

PRINT PREVIEW. The print preview displays the report in three parts as follows:

• Content List

• Selected Graphical Reports. This includes all the graphics-based report components

The sequence of the printed report components is given in the “Content List” In print preview, however, these are grouped into tabular and graphical parts.

PRINT. You can create either a hard copy or electronic copy of your compiled report.

• For a hard copy, simply click on the “Print” tool. The program sends a copy of the report to the default printer of your computer.

• Electronic copies of the compiled report can be generated by selecting the “Acrobat Distiller” from the list of printers. This will create a PDF file. The individual report components can be printed using other printers.

Take Report Screenshot

Saves the graphical screen with user-defined name to the Report Generation Manager. Use this option to produce custom images for a compiled report.
11.3.3 Single Default Reports Panel

11.3.3.1 General

**Report/Project Title Settings**
Set the General and Specific title and information lines.

**Report Cover**
Generates a .RTF file with report title settings.

**Material and Design Criteria**
Generates a .RTF tabular report with material and design criteria settings for the model.

**Quantity and Cost**
Generates a .RTF tabular report with material quantity and cost for the model components for the current mode (Single- or Multi-Level).
11.3.3.2 Structural

**Slab Regions Detailed Report**
Generates a .RTF file with slab vertices coordinates for slabs in the current mode.

**Slab Regions Summary Report**
Generates a .RTF file with slab material, area and volume for slabs in the current mode.

**Openings Detailed Report**
Generates a .RTF file with opening vertices coordinates for openings in the current mode.

**Beams Detailed Report**
Generates a .RTF file with beam material, geometry, volume and length for beams in the current mode.

**Columns Detailed Report**
Generates a .RTF file with column material, geometry, volume and length for columns in the current mode.

**Drop Caps/Panels Detailed Report**
Generates a .RTF file with drop cap/panel material and geometry for drop caps/panels in the current mode.
Walls Detailed Report
Generates a .RTF file with wall material, geometry, volume and length for walls in the current mode.

Point Springs Detailed Report
Generates a .RTF file with spring translational and rotational subgrade modulus values for and location coordinates for point springs in the current mode.

Point Springs Summary Report
Generates a .RTF file with spring subgrade modulus for Kzz, location coordinates and spring type (C or T) for point springs in the current mode.

Area Springs Detailed Report
Generates a .RTF file with spring subgrade modulus for Kzz and location coordinates for area springs in the current mode.

Releases and Restraints Detailed Report
Generates a .RTF file with point and line support coordinates and translational and rotational fixity in the current mode.

Plan Geometry
Displays a plan view of all modeled components and dimensions for the current level.

11.3.3.3 Loads

![Loads Diagram]
Load Cases and Combinations
Generates a .RTF file with load cases and combinations defined in the model.

Skip Pattern
Generates a .RTF file listing pattern loads with included sub-regions, skip factors and load reduction factors.

Applied Loads
Generates a .RTF file with coordinates, load magnitudes and parameters (Seismic) for all applied loads in the model.

Dead Load
Displays a plan view of all modeled Dead loads and magnitude for the current level.

Live Load
Displays a plan view of all modeled Live loads and magnitude for the current level.

User Defined Load Cases
Displays a plan view of all modeled user-defined General load case, loads and magnitude for the current level.

Column Tributary
Opens a .XLS file containing tributary area, load and FEM reaction information for solved load cases.

Tributary Load Check
Opens a .XLS file containing tributary load validation check for equilibrium.
11.3.3.4 Tendon

Tendon Report
Generates a .RTF file with individual tendons geometry, system type and friction parameters for tendons in the current mode.

Tendon Group Report
Generates a .RTF file with tendon group geometry, system type and friction parameters for the model.

Tendon Elongation, Individual Report
Generates a .RTF file with individual tendons jacking force, seating distance, and elongation for tendons in the current mode. Requires use of Calculated Force option for stressing in the tendon properties.

Tendon Elongation, Group Report
Generates a .RTF file with tendon group jacking force, seating distance, and elongation for the model. Requires use of Calculated Force option for stressing in the tendon properties.

Tendon Totals
Generates a .RTF file with tendon totals for strand and duct length, number of strands, weight and stressing ends for tendons in the current mode.
**Felt 3D Long-Term Loss**
Produces combined prestress loss and elongation report in PDF format for the total number of strands assigned to the tendon.

**Felt 3D LTL - Single Strand**
Option to reports losses as a function of a single strand when the number of strands designated exceeds 1.

**Tendon Plan**
Opens the Tendon Report dialog for display selection and creates a plan view of tendons for the current level.

11.3.3.5 **Rebar**

**Rebar List**
Generates a .RTF file with size, quantity, and length for calculated and base reinforcement in the current mode.

**Rebar Legend**
Generates a .RTF file for a rebar legend with like reinforcement for size, length and placement (T or B) in the current mode.

**Rebar Totals**
Generates a .RTF file with total size, quantity, length and cost for all longitudinal reinforcement in the current mode.

**Design Section Rebar Tabular Report**
Generates a .RTF tabular report for required flexure and shear reinforcement at design sections in the current mode.
Punching Shear Reinforcement
Generates a .RTF file with schedule for stud rails or links at column locations requiring shear reinforcement.

Rebar Plan
Opens the Rebar dialog for display selection and creates a plan view of reinforcement for the current level.

11.3.3.6 Punching Shear

Stress Check Parameters
Generates a .RTF file with a summary of column punching shear parameters for the critical section producing the controlling stress ratio.

Stress Check Results
Generates a .RTF file with a summary of column punching shear results for the critical section producing the controlling stress ratio.

Punching Shear Reinforcement
Generates a .RTF file with schedule for stud rails or links at column locations requiring shear reinforcement.

Punching Shear Report (XLS)
Generates a .XLS file including shear calculation results for each critical layer checked along with schedules for stud rails or links at column locations requiring shear reinforcement.
11.3.3.7 Column

**Column Reactions – Tabular (RTF)**
Produces column reactions at top and bottom column locations for solved load combinations.

**Column Reactions - Graphical**
.opens the Column Reactions dialog to produce graphical column reactions.

**Column Design**
Opens a .XLS file containing column design information.

**Column Tributary**
Opens a .XLS file containing tributary area, load and FEM reaction information for solved load cases.

**Tributary Load Check**
Opens a .XLS file containing tributary load validation check for equilibrium.

**Column Design Summary**
Opens the Design Summary window to enable selection of View Report for the HTML summary page for design groups.
11.3.3.8 Wall

**Wall Reactions - Tabular (RTF)**
Produces wall reactions at top and bottom column locations for solved load combinations.

**Wall Reactions - Graphical**
Opens the **Wall Reactions** dialog to produce graphical wall reactions.

**Pier Reactions**
Opens a .XLS file containing pier geometry, properties and reactions for solved load combinations.

**Wall Design Sections**
Opens a .XLS file containing wall design section reinforcement, geometry, and design loads and utilization checks.

**Wall Design Summary**
Creates a combined PDF summary report for the selected wall design sections.

**Wall Intersection Summary**
Creates a combined PDF summary report for joint intersection details of designed wall sections.
11.3.4 Analysis Reports Panel

11.3.4.1 Design Section/Strip

**Design Section Forces Tabular Report**
Generates a .RTF file reporting design section actions and stresses (when tendons included) at the current level.

**Design Section Rebar Tabular Report**
Generates a .RTF file for required flexure and shear section reinforcement at the current level.

**Design Section Moment Capacities Tabular Report**
Generates a .RTF file for positive and negative capacities for design sections in the current level.
Design Section Dimensions Tabular Report
Generates a .RTF file for design section dimensions for sections at the current level.

Design Section Geometry Tabular Report
Generates a .RTF file for geometric properties for sections at the current level.

Support Lines X-Direction Plan
Displays X-direction support lines and labels in plan.

Support Lines Y-Direction Plan
Displays Y-direction support lines and labels in plan.

Design Strips X-Direction Plan
Displays X-direction design strips and labels in plan.

Design Strips Y-Direction Plan
Displays Y-direction design strips and labels in plan.

Design Check X-Direction Plan
Displays X-direction design strips graphical stress check in plan.

Design Check Y-Direction Plan
Displays Y-direction design strips graphical stress check in plan.

11.3.4.2 Analysis Data

![Analysis Data Menu](image-url)
Equilibrium Check
Generates a .RTF file with gravity and lateral load equilibrium checks for solved applied loads and reactions.

Solution Statistics
Generates a .RTF file reporting total number of nodes, elements and solved load cases and combinations for the current analysis.

Analysis Nodes
Generates a .RTF file for analysis nodes and location coordinates for the current analysis.

Analysis Elements
Generates a .RTF file for shell and frame elements with connected analysis nodes for the current analysis.

Analysis Mesh Plan
Displays a plan view of the current analysis finite element mesh.

Drift Report
Generates a .XLS file after selecting Report Options for combinations, Allowable Values and directions considered. The drift report contains column coordinate and elevation data, displacement and drift data for columns and story data for average drift at each level. Plot data is reported for graph production in Excel.

11.3.4.3 Reactions

Point Support Reactions
Generates a .RTF file with point support label and reactions for Fxx, Fyy, Fzz, Mxx, Myy, and Mzz.
**Line Support Reactions**  
Generates a .RTF file with point support label and reactions for 
Fxx, Fyy, Fzz, Mxx, Myy, and Mzz.

**Point Spring Reactions**  
Generates a .RTF file with point support label and reactions for 
Fxx, Fyy, Fzz, Mxx, Myy, and Mzz.

**Line Spring Reactions**  
Generates a .RTF file with point support label and reactions for 
Fxx, Fyy, Fzz, Mxx, Myy, and Mzz.

---

### 11.3.5 Export DWG Panel

![Export DWG/DXF](image)

**Export DWG/DXF**

Opens the dialog for selecting the AutoCAD version and tendon type (linear or spline) for export of the current view as a .DWG or .DXF file.

---

### 11.4 REPORT GENERATION UTILITIES

The principal tools for creating reports tailored to your needs are described below:

#### 11.4.1 Report Font

For the graphical components of your report, you can select the font shape and size. To do so, click on the *Settings* pull down menu of the RGM and select *Graphical Report Font Size*. Follow the instructions on the screen.

#### 11.4.2 External-Text

To add an existing text file to your compiled report, select *Import Text File* from the *File* menu of the RGM and follow the instructions prompted on the computer screen.

---

211
11.4.3 External-Graphics

To add an existing graphics file saved in bitmap format to your compiled report, select Import Bitmap from the File menu of the RGM and follow the instructions prompted on the computer screen.

11.4.4 Program-User Report Components

To save a display of the program during data generation, analysis or design, do the following:

- Compose the display on the computer screen as you want it to appear in your report;
- From the Report pull down menu, select Save Current Screen.

The program captures the screen and saves it in a layer with the label “Report name,” where “name” is the label you will give to the captured screen. The layer generated will be turned off, in order not to interfere with the original flow of your work. At any given time, however, you can go to the list of layers from the main screen’s pull-down menu, turn all layers off, except the layer you generated from the screen capture. You can view and edit the information on this layer for possible inclusion in your report.

11.5 LIST OF THE PROGRAM GENERATED REPORTS

110 STRUCTURAL COMPONENTS
110.10 SLAB REGIONS (Summary Report)
110.15 SLAB REGIONS (Detailed Report)
110.35 OPENINGS (Detailed Report)
110.40 BEAMS
110.50 COLUMNS
110.55 DROP CAPS/PANELS
110.60 WALLS

111 PRESTRESSING
111.10 TENDON MATERIAL
111.20 TENDON GROUPS GEOMETRY, SYSTEM AND FRICTION
111.30 INDIVIDUAL TENDON'S GEOMETRY, SYSTEM AND FRICTION
111.50 TENDON ELONGATION, BY GROUPS
111.60 TENDON ELONGATION, INDIVIDUAL TENDONS

112 RELEASES AND RESTRAINTS
112.20 POINT SUPPORT LOCATION AND RESTRAINT
112.40 LINE SUPPORT LOCATIONS AND RESTRAINT

113 OTHER SUPPORTS
113.10 POINT SPRINGS (Summary Report)
113.15 POINT SPRINGS (Detailed Report)
113.35 AREA SPRINGS/SOIL SUPPORTS (Detailed Report)

117 MATERIALS
117.20 CONCRETE MATERIAL PROPERTIES
117.40 REINFORCEMENT (NONPRESTRESSED) MATERIAL PROPERTIES
117.60 PRESTRESSING MATERIAL PROPERTIES

120 APPLIED LOADS
120.10 DEAD LOAD
120.20 LIVE LOAD
120.30 LATERAL

132 ANALYSIS DATA
132.10 EQUILIBRIUM CHECK
132.20 SOLUTION STATISTICS
132.30 NODES
132.40 ELEMENTS

142 CODES AND ASSUMPTIONS
142.10 DESIGN CODE SPECIFIED
142.20 MATERIAL AND STRENGTH REDUCTION FACTORS
142.30 COVER TO REINFORCEMENT
142.40 MINIMUM BAR LENGTH

143 DESIGN CRITERIA
143.10 ONE-WAY SLABS
143.20 TWO-WAY SLABS
143.30 BEAM

146 LOAD CASES AND COMBINATIONS
146.20 LOAD CASES
146.30 SKIP PATTERN
146.40 LOAD COMBINATIONS

152 DESIGN SECTION GEOMETRY
152.20 AUTOMATICALLY GENERATED DESIGN SECTIONS
152.40 MANUALLY GENERATED DESIGN SECTIONS

153 DESIGN SECTION DIMENSION
153.20 AUTOMATICALLY GENERATED DESIGN SECTIONS
153.40 MANUALLY GENERATED DESIGN SECTIONS

154 DESIGN SECTION ACTIONS
154.20 DESIGN ACTIONS FOR AUTOMATICALLY GENERATED SECTIONS
154.40 DESIGN ACTIONS FOR MANUALLY GENERATED DESIGN SECTIONS

156 DESIGN SECTION REBAR
156.20 DESIGN SECTION REBAR FOR AUTOMATICALLY GENERATED SECTIONS
156.40 DESIGN SECTION REBAR FOR MANUALLY GENERATED SECTIONS

158 DESIGN SECTION CAPACITY
158.20 DESIGN SECTION CAPACITIES BASED ON REINFORCEMENT REPORTED IN THE PROGRAM
158.40 DESIGN SECTION CAPACITIES FOR MANUALLY GENERATED SECTIONS

160 COLUMNS
160.20 LOWER COLUMNS
160.40 UPPER COLUMNS

170 WALLS
170.20 LOWER WALLS
170.40 UPPER WALLS

180 PUNCHING SHEAR DESIGN
11.6 SELECTED SAMPLE OF PROGRAM GENERATED REPORTS

110 STRUCTURAL COMPONENTS

110.10 SLAB REGIONS (Summary Report)
ID: 1 Label: Slab Region 1 Material: Concrete 1 Thickness: 200 mm Offset: 0 mm

<table>
<thead>
<tr>
<th>Vertex</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>-7.688</td>
<td>3.209</td>
<td>3.000</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>6.210</td>
<td>0.608</td>
<td>3.000</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>16.207</td>
<td>1.649</td>
<td>3.000</td>
<td></td>
</tr>
</tbody>
</table>

110.15 SLAB REGIONS (Detailed Report)

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>Thickness</th>
<th>Offset</th>
<th>Material</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Slab Region 1</td>
<td>200</td>
<td>0</td>
<td>Concrete 1</td>
<td></td>
</tr>
</tbody>
</table>

110.35 OPENINGS (Detailed Report)
Opening: 1 Label: Opening 1 Slab region IDs: 1

<table>
<thead>
<tr>
<th>Vertex</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>24.00</td>
<td>23.00</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>28.00</td>
<td>23.00</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>28.00</td>
<td>21.00</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>24.00</td>
<td>21.00</td>
<td>10.00</td>
<td></td>
</tr>
</tbody>
</table>

110.40 BEAMS

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>First (X,Y); Second (X,Y)</th>
<th>Width</th>
<th>Depth</th>
<th>Offset</th>
<th>Material ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Beam 1</td>
<td>0.52,31.54; 56.43,31.54</td>
<td>12.00</td>
<td>22.00</td>
<td>0.00</td>
<td>Concrete 1</td>
</tr>
</tbody>
</table>

110.50 COLUMNS

<table>
<thead>
<tr>
<th>Label</th>
<th>#</th>
<th>Centroid X,Y,Alpha</th>
<th>A or D</th>
<th>B</th>
<th>Length</th>
<th>f'c</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>ft ft °</td>
<td>in</td>
<td>in</td>
<td>ft</td>
<td>psi</td>
</tr>
<tr>
<td>Column 1</td>
<td>1</td>
<td>9.50,10.00,0.00</td>
<td>12.00</td>
<td>24.00</td>
<td>10.00</td>
<td>4000</td>
</tr>
</tbody>
</table>
110.60 WALLS

Wall Dimensions and Material Property

<table>
<thead>
<tr>
<th>Label</th>
<th>Centroid X,Y,Alpha</th>
<th>T</th>
<th>L</th>
<th>Height</th>
<th>f'c</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wall 1</td>
<td>28.74,10.41,0.00</td>
<td>8.00</td>
<td>7.85</td>
<td>10.00</td>
<td>4000</td>
</tr>
</tbody>
</table>

111 PRESTRESSING

111.10 TENDON MATERIAL
Material Label: Prestressing 1
fpu = 270.000ksi  fpy = 240.000ksi  Eps = 28000ksi

111.20 TENDON GROUPS GEOMETRY, SYSTEM AND FRICTION
Material Label: Prestressing 1

<table>
<thead>
<tr>
<th>Group</th>
<th>Span Length</th>
<th>Shape</th>
<th>Start (from bottom)</th>
<th>Center (from bottom)</th>
<th>Right (from bottom)</th>
<th>Code</th>
<th>System</th>
<th>K *0.001</th>
<th>Meu *0.01</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ft</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>1  9.50</td>
<td>4.00</td>
<td>7</td>
<td>7.00</td>
<td>-1</td>
<td>U</td>
<td>1</td>
<td>7.00</td>
<td>7.00</td>
</tr>
<tr>
<td></td>
<td>2  38.00</td>
<td>1</td>
<td>7.00</td>
<td>7.00</td>
<td>-1</td>
<td>U</td>
<td>1</td>
<td>7.00</td>
<td>7.00</td>
</tr>
<tr>
<td></td>
<td>3  9.50</td>
<td>7</td>
<td>7.00</td>
<td>4.00</td>
<td>-1</td>
<td>U</td>
<td>1</td>
<td>7.00</td>
<td>7.00</td>
</tr>
<tr>
<td>Total</td>
<td>57.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>1  10.00</td>
<td>7</td>
<td>7.25</td>
<td>7.25</td>
<td>-1</td>
<td>U</td>
<td>4</td>
<td>20.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2  40.00</td>
<td>1</td>
<td>7.25</td>
<td>0.75</td>
<td>7.25</td>
<td>-1</td>
<td>U</td>
<td>4.00</td>
<td>20.00</td>
</tr>
<tr>
<td></td>
<td>3  10.00</td>
<td>7</td>
<td>7.25</td>
<td>7.25</td>
<td>-1</td>
<td>U</td>
<td>4</td>
<td>20.00</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>60.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

TENDON GROUPING, IDENTIFICATION AND STRESSING

GROUP: Red  Number of tendons: 34  Material ID: Prestressing 1
Tendon length(ft) = 57.00  Strands area (in2): 0.15
Stressing: first end  Seating (in): 0.25
Elongation (in): first end: 5.15 second end: 0.00 Total: 5.15
Tendon ID  Number of Strands
1  1
2  1
3  1

GROUP: Blue  Number of tendons: 4  Material ID: Prestressing 1
Tendon length(ft) = 60.00  Strands area (in2): 0.15
Stressing: both ends  Seating (in): 0.25
Elongation (in): first end: 4.90 second end: 0.11 Total: 5.01
Tendon ID  Number of Strands
35  1
36  1
37  1
38  1

Legend
Shape
1-----Reversed Parabola
2-----Partial Parabola
3-----Harped
4-----Cantilever Up  
5-----Cantilever Partial  
6-----Cantilever Harped  
7-----Cantilever Down  

System  
U-----Unbonded  
B-----Bonded  

Code  
First-----Stressed at first end  
Last-----Stressed at last end  
Both-----Stressed at both ends  

111.30 INDIVIDUAL TENDON'S GEOMETRY, SYSTEM AND FRICTION  

Material Label: Prestressing 1  

<table>
<thead>
<tr>
<th>Tendon ID</th>
<th>Label</th>
<th>Span Length (ft)</th>
<th>Shape</th>
<th>Start (from bottom)</th>
<th>Center (from bottom)</th>
<th>Right (from bottom)</th>
<th>Code</th>
<th>System</th>
<th>K rad/ft</th>
<th>Meu °0.001</th>
<th>Meu °0.01</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Tendon</td>
<td>1</td>
<td>9.50</td>
<td>7</td>
<td>4.00</td>
<td>--</td>
<td>7.00</td>
<td>-1</td>
<td>U</td>
<td>1.00</td>
<td>7.00</td>
<td></td>
</tr>
<tr>
<td>2 Tendon</td>
<td>1</td>
<td>38.00</td>
<td>1</td>
<td>7.00</td>
<td>1.00</td>
<td>7.00</td>
<td>-1</td>
<td>U</td>
<td>1.00</td>
<td>7.00</td>
<td></td>
</tr>
<tr>
<td>3 Tendon</td>
<td>1</td>
<td>9.50</td>
<td>7</td>
<td>7.00</td>
<td>--</td>
<td>4.00</td>
<td>-1</td>
<td>U</td>
<td>1.00</td>
<td>7.00</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 Tendon</td>
<td>1</td>
<td>9.50</td>
<td>7</td>
<td>4.00</td>
<td>--</td>
<td>7.00</td>
<td>-1</td>
<td>U</td>
<td>1.00</td>
<td>7.00</td>
<td></td>
</tr>
<tr>
<td>2 Tendon</td>
<td>1</td>
<td>38.00</td>
<td>1</td>
<td>7.00</td>
<td>1.00</td>
<td>7.00</td>
<td>-1</td>
<td>U</td>
<td>1.00</td>
<td>7.00</td>
<td></td>
</tr>
<tr>
<td>3 Tendon</td>
<td>1</td>
<td>9.50</td>
<td>7</td>
<td>7.00</td>
<td>--</td>
<td>4.00</td>
<td>-1</td>
<td>U</td>
<td>1.00</td>
<td>7.00</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Tendon</td>
<td>1</td>
<td>9.50</td>
<td>7</td>
<td>4.00</td>
<td>--</td>
<td>7.00</td>
<td>-1</td>
<td>U</td>
<td>1.00</td>
<td>7.00</td>
<td></td>
</tr>
<tr>
<td>2 Tendon</td>
<td>1</td>
<td>38.00</td>
<td>1</td>
<td>7.00</td>
<td>1.00</td>
<td>7.00</td>
<td>-1</td>
<td>U</td>
<td>1.00</td>
<td>7.00</td>
<td></td>
</tr>
<tr>
<td>3 Tendon</td>
<td>1</td>
<td>9.50</td>
<td>7</td>
<td>7.00</td>
<td>--</td>
<td>4.00</td>
<td>-1</td>
<td>U</td>
<td>1.00</td>
<td>7.00</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

TENDON GROUPING, IDENTIFICATION AND STRESSING  

Tendon: Tendon 1  Material ID: Prestressing 1  
Tendon length(ft) = 57.00  Strands/tendon: 1  Strands area (in2): 0.15  
Long-term stress loss specified: 11.000ksi  
Stressing: first end  
First end  Second end  
Ratio of jacking force: 0.85  ---  
Seating loss: 0.25  ---  

Tendon: Tendon 2  Material ID: Prestressing 1  
Tendon length(ft) = 57.00  Strands/tendon: 1  Strands area (in2): 0.15  
Long-term stress loss specified: 11.000ksi  
Stressing: first end  
First end  Second end  
Ratio of jacking force: 0.85  ---  
Seating loss: 0.25  ---  

Tendon: Tendon 3  Material ID: Prestressing 1  
Tendon length(ft) = 57.00  Strands/tendon: 1  Strands area (in2): 0.15  
Long-term stress loss specified: 11.000ksi  
Stressing: first end  
First end  Second end  
Ratio of jacking force: 0.85  ---  
Seating loss: 0.25  ---  

216
First end   Second end
Ratio of jacking force:0.85  ---
Seating loss: 0.25  ---

Legend
Shape
1-----Reversed Parabola
2-----Partial Parabola
3-----Harped
4-----Cantilever Up
5-----Cantilever Partial
6-----Cantilever Harped
7-----Cantilever Down

System
U-----Unbonded
B-----Bonded

Code
First-----Stressed at first end
Last------Stressed at last end
Both------Stressed at both ends

111.50 TENDON ELONGATION, BY GROUPS

<table>
<thead>
<tr>
<th>Tendon (Group Label)</th>
<th>Jack(1st,2nd)</th>
<th>Seating(1st,2nd)</th>
<th>Elongation (1st,2nd,Total)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>35.114,N/A</td>
<td>0.25,N/A</td>
<td>5.15,N/A, 5.15</td>
</tr>
<tr>
<td>Blue</td>
<td>35.114,35.114</td>
<td>0.25,0.25</td>
<td>4.90,0.11,5.01</td>
</tr>
</tbody>
</table>

111.60 TENDON ELONGATION, INDIVIDUAL TENDONS

<table>
<thead>
<tr>
<th>Tendon(#,Label)</th>
<th>Jack(1st,2nd)</th>
<th>Seating(1st,2nd)</th>
<th>Elongation (1st,2nd,Total)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1, Tendon 1</td>
<td>35.114,N/A</td>
<td>0.25,N/A</td>
<td>5.15,N/A, 5.15</td>
</tr>
<tr>
<td>2, Tendon 2</td>
<td>35.114,N/A</td>
<td>0.25,N/A</td>
<td>5.10,N/A, 5.10</td>
</tr>
<tr>
<td>3, Tendon 3</td>
<td>35.114,N/A</td>
<td>0.25,N/A</td>
<td>5.15,N/A, 5.15</td>
</tr>
</tbody>
</table>

112 RELEASES AND RESTRAINTS

112.20 POINT SUPPORT LOCATION AND RESTRAIN

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
<th>XX</th>
<th>YY</th>
<th>ZZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Point Support 1</td>
<td>-5.000;12.000;0.000</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Point Support 2</td>
<td>5.018;10.073;0.000</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Point Support 3</td>
<td>14.000;11.000;0.000</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Point Support 4</td>
<td>14.993;2.978;0.000</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

112.40 LINE SUPPORT LOCATIONS AND RESTRAINT

Line Supports Locations

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ft</td>
<td></td>
<td>ft</td>
<td>ft</td>
<td>ft</td>
</tr>
<tr>
<td>Line Support 5</td>
<td>5</td>
<td>7.85</td>
<td>28.74;10.41;0.000</td>
<td>24.81;10.41;0.000</td>
<td>32.66;10.41;0.000</td>
</tr>
</tbody>
</table>

Line Supports Releases

<table>
<thead>
<tr>
<th>Label</th>
<th>#</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
<th>XX</th>
<th>YY</th>
<th>ZZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Support 5</td>
<td>5</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
113 OTHER SUPPORTS

113.10 POINT SPRINGS (Summary Report)

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>Location</th>
<th>Offset</th>
<th>Kz</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Point Spring 1</td>
<td>6.308,11.332,3.000</td>
<td>0</td>
<td>1.00E-006</td>
<td>T/C</td>
</tr>
<tr>
<td>2</td>
<td>Point Spring 2</td>
<td>6.308,11.332,3.000</td>
<td>0</td>
<td>1.00E-006</td>
<td>T/C</td>
</tr>
</tbody>
</table>

Spring Type:
T = Tension only
C = Compression only
T/C = Tension and compression

113.15 POINT SPRINGS (Detailed Report)

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>Location</th>
<th>Offset</th>
<th>Kx</th>
<th>Ky</th>
<th>Kz</th>
<th>Kxx</th>
<th>Kyy</th>
<th>Kzz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Point Spring 1</td>
<td>6.308,11.332,3.000</td>
<td>0</td>
<td>0.00</td>
<td>0.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>Point Spring 2</td>
<td>6.308,11.332,3.000</td>
<td>0</td>
<td>0.00</td>
<td>0.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Units of Kxx, Kyy, Kzz are kN-m/rad

113.35 AREA SPRINGS/SOIL SUPPORTS (Detailed Report)

<table>
<thead>
<tr>
<th>Vertex</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9.003</td>
<td>8.771</td>
<td>3.000</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>12.232</td>
<td>10.807</td>
<td>3.000</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>12.382</td>
<td>5.980</td>
<td>3.000</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>10.032</td>
<td>5.892</td>
<td>3.000</td>
<td></td>
</tr>
</tbody>
</table>

117 MATERIALS

117.20 CONCRETE MATERIAL PROPERTIES

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>f'c</th>
<th>Weight</th>
<th>Type</th>
<th>Ec</th>
<th>Creep coefficient</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Concrete 1</td>
<td>4000</td>
<td>150.00</td>
<td>Normal</td>
<td>3600</td>
<td>2.00</td>
</tr>
</tbody>
</table>

f'c = strength at 28 days
Ec = modulus of elasticity at 28 days

117.40 REINFORCEMENT (NONPRESTRESSED) MATERIAL PROPERTIES

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>fy</th>
<th>fvy</th>
<th>Es</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MildSteel 1</td>
<td>60.000</td>
<td>60.000</td>
<td>30000</td>
</tr>
</tbody>
</table>

fy = yield stress of longitudinal reinforcement
fvy = yield stress of one-way shear reinforcement
Es = modulus of elasticity

117.60 PRESTRESSING MATERIAL PROPERTIES

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>fpu</th>
<th>fpy</th>
<th>Fps</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Prestressing 1</td>
<td>270.000</td>
<td>240.000</td>
<td>28000</td>
</tr>
</tbody>
</table>

fpu = ultimate stress
fpy = yield stress
Fps = modulus of elasticity
120 APPLIED LOADS

120.10 APPLIED LOADS

120.20 DEAD LOAD

Concentrated Loads

<table>
<thead>
<tr>
<th>No</th>
<th>X</th>
<th>Y</th>
<th>Fz</th>
<th>Mxx</th>
<th>Myy</th>
<th>Fx</th>
<th>Fy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>7.09E+001</td>
<td>2.15E+001</td>
<td>1.00E+001</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
</tr>
</tbody>
</table>

Line Loads

Geometry

<table>
<thead>
<tr>
<th>No</th>
<th>X1</th>
<th>Y1</th>
<th>Z1</th>
<th>X2</th>
<th>Y2</th>
<th>Z2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3.54E+001</td>
<td>3.22E+000</td>
<td>1.00E+001</td>
<td>6.11E+001</td>
<td>4.96E+000</td>
<td>1.00E+001</td>
</tr>
</tbody>
</table>

Values

<table>
<thead>
<tr>
<th>No</th>
<th>Fz1</th>
<th>Fz2</th>
<th>Mxx1</th>
<th>Mxx2</th>
<th>Myy1</th>
<th>Myy2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.00E-001</td>
<td>1.00E-001</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
</tr>
</tbody>
</table>

Area Loads

No = 1   Z=10.00ft

<table>
<thead>
<tr>
<th>Vertex</th>
<th>X</th>
<th>Y</th>
<th>Fz</th>
<th>Mxx</th>
<th>Myy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2.86E+001</td>
<td>-7.76E+000</td>
<td>2.00E-002</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
</tr>
<tr>
<td>2</td>
<td>1.59E+001</td>
<td>2.48E+001</td>
<td>2.00E-002</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
</tr>
<tr>
<td>3</td>
<td>9.35E+001</td>
<td>2.96E+001</td>
<td>2.00E-002</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
</tr>
<tr>
<td>4</td>
<td>9.06E+001</td>
<td>-1.35E+001</td>
<td>2.00E-002</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
</tr>
</tbody>
</table>

120.30 LIVE LOAD

Concentrated Loads

<table>
<thead>
<tr>
<th>No</th>
<th>X</th>
<th>Y</th>
<th>Fz</th>
<th>Mxx</th>
<th>Myy</th>
<th>Fx</th>
<th>Fy</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>3.66E+001</td>
<td>8.24E+000</td>
<td>1.50E+001</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>4.91E+001</td>
<td>7.71E+000</td>
<td>1.00E+001</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
<td></td>
</tr>
</tbody>
</table>

Line Loads

Geometry

<table>
<thead>
<tr>
<th>No</th>
<th>X1</th>
<th>Y1</th>
<th>Z1</th>
<th>X2</th>
<th>Y2</th>
<th>Z2</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>4.32E+001</td>
<td>2.27E+001</td>
<td>1.00E+001</td>
<td>6.06E+001</td>
<td>2.47E+001</td>
<td>1.00E+001</td>
</tr>
</tbody>
</table>

Values

<table>
<thead>
<tr>
<th>No</th>
<th>Fz1</th>
<th>Fz2</th>
<th>Mxx1</th>
<th>Mxx2</th>
<th>Myy1</th>
<th>Myy2</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>2.00E-001</td>
<td>2.00E-001</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
</tr>
</tbody>
</table>

Area Loads

No = 2   Z=10.00ft

<table>
<thead>
<tr>
<th>Vertex</th>
<th>X</th>
<th>Y</th>
<th>Fz</th>
<th>Mxx</th>
<th>Myy</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6.70E+001</td>
<td>1.81E+000</td>
<td>3.00E-002</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
</tr>
<tr>
<td>2</td>
<td>6.82E+001</td>
<td>1.11E+001</td>
<td>3.00E-002</td>
<td>0.00E+000</td>
<td>0.00E+000</td>
</tr>
</tbody>
</table>
132 ANALYSIS DATA

132.10 EQUILIBRIUM CHECK
Unit: kN

<table>
<thead>
<tr>
<th>LOAD CASE NAME</th>
<th>TOTAL APPLIED LOAD (ALONG X,Y,Z)</th>
<th>TOTAL REACTION (ALONG X,Y,Z)</th>
<th>%DIFFERENCE (ALONG X,Y,Z)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELFWEIGHT</td>
<td>0.000E+000 0.000E+000 1.262E+003</td>
<td>4.285E-014 1.381E-012 1.262E+003</td>
<td>0.000E+000 0.000E+000 0.000E+000</td>
</tr>
<tr>
<td>PRESTRESSING</td>
<td>0.000E+000 0.000E+000 0.000E+000</td>
<td>1.373E-013 4.850E-012 5.253E-010</td>
<td>0.000E+000 0.000E+000 0.000E+000</td>
</tr>
<tr>
<td>HYPERSTATIC</td>
<td>7.247E-012 1.096E+001 8.138E+001</td>
<td>7.753E-012 1.096E+001 8.138E+001</td>
<td>0.000E+000 0.000E+000 0.000E+000</td>
</tr>
</tbody>
</table>

132.20 SOLUTION STATISTICS
Number of shell elements
- Slab regions: 713
- Walls: 4
Number of frame elements
- Beams: 24
- Columns: 14
Total number of equations: 5
Number of load cases: 5
Number of load combinations: 2
Total time taken for Analysis: 0 Hours 1 Minutes 11 Seconds
Total time taken for Design: 0 Hours 1 Minutes 11 Seconds

132.30 NODES
Units: in

<table>
<thead>
<tr>
<th>NODE</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00000E+00</td>
<td>0.00000E+00</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>2</td>
<td>2.48128E+01</td>
<td>0.00000E+00</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>3</td>
<td>4.90257E+01</td>
<td>0.00000E+00</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>4</td>
<td>7.44385E+01</td>
<td>0.00000E+00</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>5</td>
<td>9.92514E+01</td>
<td>0.00000E+00</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>6</td>
<td>1.24064E+02</td>
<td>0.00000E+00</td>
<td>1.20000E+02</td>
</tr>
</tbody>
</table>

132.40 ELEMENTS
Slab Shell Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>73</td>
<td>102</td>
<td>106</td>
<td>77</td>
</tr>
<tr>
<td>2</td>
<td>102</td>
<td>134</td>
<td>136</td>
<td>106</td>
</tr>
<tr>
<td>3</td>
<td>134</td>
<td>184</td>
<td>180</td>
<td>138</td>
</tr>
<tr>
<td>4</td>
<td>184</td>
<td>214</td>
<td>213</td>
<td>180</td>
</tr>
<tr>
<td>5</td>
<td>214</td>
<td>243</td>
<td>246</td>
<td>213</td>
</tr>
</tbody>
</table>

Wall Shell Elements

| Element | I | J | K | L |


152 DESIGN SECTION GEOMETRY

152.20 AUTOMATICALLY GENERATED DESIGN SECTIONS
Design Strip: Support Line 1

<table>
<thead>
<tr>
<th>Design Section</th>
<th>Start(x,y)</th>
<th>End(x,y)</th>
<th>Centroid (local x,z)</th>
<th>Area</th>
<th>I</th>
<th>Ytop</th>
<th>Ybot</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ft</td>
<td>ft</td>
<td>in2</td>
<td>in4</td>
<td>in</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1100</td>
<td>0.05,60.00</td>
<td>0.05,40.77</td>
<td>9.62,9.67</td>
<td>1846.16</td>
<td>9845.97</td>
<td>4.00</td>
<td>4.00</td>
</tr>
<tr>
<td>1101</td>
<td>1.58,60.00</td>
<td>1.58,40.77</td>
<td>9.62,9.67</td>
<td>1846.16</td>
<td>9845.97</td>
<td>4.00</td>
<td>4.00</td>
</tr>
<tr>
<td>1102</td>
<td>3.17,60.00</td>
<td>3.17,40.77</td>
<td>9.62,9.67</td>
<td>1846.16</td>
<td>9845.97</td>
<td>4.00</td>
<td>4.00</td>
</tr>
</tbody>
</table>

152.40 MANUALLY GENERATED DESIGN SECTIONS

<table>
<thead>
<tr>
<th>Design Section</th>
<th>Start(x,y)</th>
<th>End(x,y)</th>
<th>Centroid (local x,z)</th>
<th>Area</th>
<th>I</th>
<th>Ytop</th>
<th>Ybot</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ft</td>
<td>ft</td>
<td>in2</td>
<td>in4</td>
<td>in</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>44.86,60.71</td>
<td>45.01,41.19</td>
<td>10.11,9.67</td>
<td>1805.55</td>
<td>9629.75</td>
<td>4.00</td>
<td>4.00</td>
</tr>
<tr>
<td>2</td>
<td>35.83,60.86</td>
<td>35.75,41.04</td>
<td>10.34,9.67</td>
<td>1820.12</td>
<td>9707.11</td>
<td>4.00</td>
<td>4.00</td>
</tr>
</tbody>
</table>

154 DESIGN SECTION ACTIONS

154.20 and 154.40 Option 1: report without twisting moment and eccentricities
The following report section is available if the value for the item “Report_Mxy” in the initialization file is set to 0.

154.20 DESIGN ACTIONS FOR AUTOMATICALLY GENERATED SECTIONS

<table>
<thead>
<tr>
<th>Design section</th>
<th>Moment</th>
<th>Shear</th>
<th>Axial</th>
<th>Torsion</th>
<th>Top Stress</th>
<th>Bottom Stress</th>
<th>Centroid Stress</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k</td>
<td>k</td>
<td>k-ft</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
</tr>
<tr>
<td>1100</td>
<td>-5.092</td>
<td>1.319</td>
<td>-339.801</td>
<td>-165.658</td>
<td>-0</td>
<td>-0</td>
<td>-0</td>
</tr>
<tr>
<td>1101</td>
<td>-3.070</td>
<td>1.319</td>
<td>-339.765</td>
<td>-165.641</td>
<td>-0</td>
<td>-0</td>
<td>-0</td>
</tr>
<tr>
<td>1102</td>
<td>-16.421</td>
<td>-10.760</td>
<td>-342.519</td>
<td>-155.396</td>
<td>-0</td>
<td>-0</td>
<td>-0</td>
</tr>
</tbody>
</table>

154.40 DESIGN ACTIONS FOR MANUALLY GENERATED DESIGN SECTIONS
Load Combination: Strength

<table>
<thead>
<tr>
<th>Design section</th>
<th>Moment</th>
<th>Shear</th>
<th>Axial</th>
<th>Torsion</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k</td>
<td>k</td>
<td>k-ft</td>
</tr>
<tr>
<td>Design Section 1</td>
<td>4.760</td>
<td>7.974</td>
<td>0.000</td>
<td>21.168</td>
</tr>
</tbody>
</table>

154.20 and 154.40 Option 2: report with twisting moment and eccentricities
If twisting moment as well as eccentricities shall be reported, set the value for the item “Report_Mxy” in the initialization file to 1.

154.20 DESIGN ACTIONS FOR AUTOMATICALLY GENERATED SECTIONS
Load Combination: Strength

ecc = Eccentricity for force
Normal shear eccentricity (ecc) is the distance from the first end of design section toward the second end
Inplane shear eccentricity (ecc) is the distance from the centroid of design section (upward positive)

Design Strip: Support Line 1

<table>
<thead>
<tr>
<th>Design section</th>
<th>Bending Moment</th>
<th>Twisting Moment</th>
<th>Axial Force</th>
<th>Normal Shear</th>
<th>Inplane Shear</th>
<th>Normal Shear Ecc</th>
<th>Inplane Shear Ecc</th>
<th>Top Stress</th>
<th>Bottom Stress</th>
<th>Centroid Stress</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k</td>
<td>k</td>
<td>k</td>
<td>in</td>
<td>in</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
</tr>
<tr>
<td>101000</td>
<td>2.180</td>
<td>3.012</td>
<td>-296.664</td>
<td>-15.635</td>
<td>-35.520</td>
<td>78.05</td>
<td>4.00</td>
<td>-244</td>
<td>-214</td>
<td>-229</td>
</tr>
</tbody>
</table>

154.40 DESIGN ACTIONS FOR MANUALLY GENERATED SECTIONS

<table>
<thead>
<tr>
<th>Design section</th>
<th>Moment</th>
<th>Shear</th>
<th>Axial</th>
<th>Torsion</th>
<th>Top Stress</th>
<th>Bottom Stress</th>
<th>Centroid Stress</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k</td>
<td>k</td>
<td>k-ft</td>
<td>psi</td>
<td>psi</td>
<td>psi</td>
</tr>
<tr>
<td>Design Section 1</td>
<td>-47.369</td>
<td>-48.314</td>
<td>-378.670</td>
<td>21.726</td>
<td>0</td>
<td>-0</td>
<td>-0</td>
</tr>
<tr>
<td>Design Section 2</td>
<td>196.532</td>
<td>-14.634</td>
<td>-381.401</td>
<td>-43.596</td>
<td>1</td>
<td>1</td>
<td>-0</td>
</tr>
</tbody>
</table>

154.20 and 154.40 Option 3: In addition to Option 1 or Option 2 table the program reports table that includes moments with contribution of twisting moments using Wood-Armer approximation. This table is available if design is based on Wood-Armer method.

Design moments with inclusion of twisting moments (Wood-Armer method)

<table>
<thead>
<tr>
<th>Design section</th>
<th>Positive Bending Moment</th>
<th>Negative Bending Moment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>101000</td>
<td>3.451</td>
<td>-4.321</td>
</tr>
</tbody>
</table>

NA = Not applicable for "One-way" or "Beam" design sections.

156 DESIGN SECTION REBAR

156.20 DESIGN SECTION REBAR FOR AUTOMATICALLY GENERATED SECTIONS
Load Combination: Service
Design Strip: Support Line 1 Design Criteria: SERVICEABILITY

<table>
<thead>
<tr>
<th>Design section</th>
<th>As top</th>
<th>As bot</th>
<th>Top bar</th>
<th>Bottom bar</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in2</td>
<td>in2</td>
<td>#5</td>
<td>#8</td>
</tr>
<tr>
<td>1100</td>
<td>0.00</td>
<td>0.00</td>
<td>#5</td>
<td>#8</td>
</tr>
<tr>
<td>1101</td>
<td>0.00</td>
<td>0.00</td>
<td>#5</td>
<td>#8</td>
</tr>
<tr>
<td>1102</td>
<td>0.00</td>
<td>0.00</td>
<td>#5</td>
<td>#8</td>
</tr>
</tbody>
</table>

156.40 DESIGN SECTION REBAR FOR MANUALLY GENERATED SECTIONS
Design Criteria: SERVICEABILITY
158 DESIGN SECTION CAPACITY

158.20 DESIGN SECTION CAPACITIES BASED ON REINFORCEMENT REPORTED IN THE PROGRAM

Design Strip: Support Line 1

<table>
<thead>
<tr>
<th>Design section</th>
<th>Moment positive</th>
<th>Moment negative</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>KN-M</td>
<td>KN-M</td>
</tr>
<tr>
<td>101000</td>
<td>105.300</td>
<td>-129.600</td>
</tr>
<tr>
<td>101001</td>
<td>68.560</td>
<td>-174.800</td>
</tr>
<tr>
<td>101002</td>
<td>42.690</td>
<td>-201.000</td>
</tr>
<tr>
<td>101003</td>
<td>29.510</td>
<td>-221.500</td>
</tr>
<tr>
<td>101004</td>
<td>19.160</td>
<td>-288.900</td>
</tr>
<tr>
<td>102000</td>
<td>17.640</td>
<td>-258.800</td>
</tr>
</tbody>
</table>

158.40 DESIGN SECTION CAPACITIES FOR MANUALLY GENERATED SECTIONS

<table>
<thead>
<tr>
<th>Design section</th>
<th>Moment positive</th>
<th>Moment negative</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>K-Ft</td>
<td>K-Ft</td>
</tr>
<tr>
<td>Design Section 1</td>
<td>39.158</td>
<td>-9.154</td>
</tr>
</tbody>
</table>

160 COLUMNS

160.20 LOWER COLUMNS

Service

<table>
<thead>
<tr>
<th>Label</th>
<th>#</th>
<th>Fz</th>
<th>Fr</th>
<th>Fs</th>
<th>Mrr</th>
<th>Mss</th>
<th>Mzz</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k</td>
<td>k</td>
<td>k</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>Column 1</td>
<td>1</td>
<td>-76.923</td>
<td>0.000</td>
<td>0.000</td>
<td>-93.39</td>
<td>7.963</td>
<td>-0.140</td>
</tr>
<tr>
<td>Column 2</td>
<td>2</td>
<td>-145.585</td>
<td>0.000</td>
<td>0.000</td>
<td>28.465</td>
<td>58.813</td>
<td>-0.197</td>
</tr>
<tr>
<td>Column 3</td>
<td>3</td>
<td>-74.877</td>
<td>-0.000</td>
<td>-0.000</td>
<td>-50.214</td>
<td>-9.768</td>
<td>0.060</td>
</tr>
</tbody>
</table>

Strength

<table>
<thead>
<tr>
<th>Label</th>
<th>#</th>
<th>Fz</th>
<th>Fr</th>
<th>Fs</th>
<th>Mrr</th>
<th>Mss</th>
<th>Mzz</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k</td>
<td>k</td>
<td>k</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>Column 1</td>
<td>1</td>
<td>-110.179</td>
<td>0.000</td>
<td>0.000</td>
<td>-136.065</td>
<td>8.654</td>
<td>-0.225</td>
</tr>
</tbody>
</table>

170 WALLS

Service

<table>
<thead>
<tr>
<th>Label</th>
<th>#</th>
<th>Fz</th>
<th>Fr</th>
<th>Fs</th>
<th>Mrr</th>
<th>Mss</th>
<th>Mzz</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k</td>
<td>k</td>
<td>k</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>Wall 1</td>
<td>1</td>
<td>-111.789</td>
<td>0.000</td>
<td>0.000</td>
<td>-69.125</td>
<td>-7.553</td>
<td>-1.015</td>
</tr>
</tbody>
</table>
Strength

<table>
<thead>
<tr>
<th>Label</th>
<th>#</th>
<th>Fz</th>
<th>Fr</th>
<th>Fs</th>
<th>Mrr</th>
<th>Mss</th>
<th>Mzz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wall 1</td>
<td>1</td>
<td>-172.591</td>
<td>0.000</td>
<td>0.000</td>
<td>-102.639</td>
<td>-12.251</td>
<td>-1.492</td>
</tr>
</tbody>
</table>

180 PUNCHING SHEAR DESIGN

180.60 PUNCHING SHEAR STRESS CHECK PARAMETERS

<table>
<thead>
<tr>
<th>Label</th>
<th>Condition</th>
<th>Axis</th>
<th>Effective depth</th>
<th>Design length rr</th>
<th>Design length ss</th>
<th>Design area</th>
<th>Section constant</th>
<th>Gamma</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column 1</td>
<td>Interior</td>
<td>rr</td>
<td>175</td>
<td>675</td>
<td>675</td>
<td>4.73E+005</td>
<td>3.65E+010</td>
<td>0.40</td>
</tr>
<tr>
<td>Column 1</td>
<td>Interior</td>
<td>ss</td>
<td>175</td>
<td>675</td>
<td>675</td>
<td>4.73E+005</td>
<td>3.65E+010</td>
<td>0.40</td>
</tr>
<tr>
<td>Column 2</td>
<td>Interior</td>
<td>rr</td>
<td>175</td>
<td>675</td>
<td>675</td>
<td>4.73E+005</td>
<td>3.65E+010</td>
<td>0.40</td>
</tr>
<tr>
<td>Column 2</td>
<td>Interior</td>
<td>ss</td>
<td>175</td>
<td>675</td>
<td>675</td>
<td>4.73E+005</td>
<td>3.65E+010</td>
<td>0.40</td>
</tr>
<tr>
<td>Column 3</td>
<td>Interior</td>
<td>rr</td>
<td>175</td>
<td>675</td>
<td>675</td>
<td>4.73E+005</td>
<td>3.65E+010</td>
<td>0.40</td>
</tr>
<tr>
<td>Column 3</td>
<td>Interior</td>
<td>ss</td>
<td>175</td>
<td>675</td>
<td>675</td>
<td>4.73E+005</td>
<td>3.65E+010</td>
<td>0.40</td>
</tr>
</tbody>
</table>

180.40 PUNCHING SHEAR STRESS CHECK RESULTS

<table>
<thead>
<tr>
<th>Load Combination:Strength</th>
<th>Label</th>
<th>Condition</th>
<th>Axis</th>
<th>Factored shear</th>
<th>Factored moment</th>
<th>Stress due to shear</th>
<th>Stress due to moment</th>
<th>Total stress</th>
<th>Allowable stress</th>
<th>Stress ratio</th>
<th>Case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column 1 Interior rr</td>
<td>-207.050</td>
<td>117.170</td>
<td>0.438</td>
<td>0.434</td>
<td>0.872</td>
<td>1.313</td>
<td>0.66</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column 1 Interior ss</td>
<td>-207.050</td>
<td>127.110</td>
<td>0.438</td>
<td>0.470</td>
<td>0.909</td>
<td>1.313</td>
<td>0.69</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column 2 Interior rr</td>
<td>-377.390</td>
<td>118.680</td>
<td>0.799</td>
<td>0.439</td>
<td>1.238</td>
<td>1.313</td>
<td>0.94</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column 2 Interior ss</td>
<td>-377.390</td>
<td>-67.336</td>
<td>0.799</td>
<td>0.249</td>
<td>1.048</td>
<td>1.313</td>
<td>0.80</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column 3 Interior rr</td>
<td>-136.130</td>
<td>32.940</td>
<td>0.288</td>
<td>0.122</td>
<td>0.410</td>
<td>1.313</td>
<td>0.31</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column 3 Interior ss</td>
<td>-136.130</td>
<td>-17.137</td>
<td>0.288</td>
<td>0.063</td>
<td>0.352</td>
<td>1.313</td>
<td>0.27</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

199.00 REBAR LEGEND

<table>
<thead>
<tr>
<th>#</th>
<th>Legend</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>#8x3'6&quot;@167&quot;o.c.(B)</td>
</tr>
<tr>
<td>2</td>
<td>B</td>
<td>1#5x4'6&quot;(T)</td>
</tr>
<tr>
<td>3</td>
<td>C</td>
<td>#8x5'0&quot;@148&quot;o.c.(B)</td>
</tr>
<tr>
<td>4</td>
<td>D</td>
<td>#8x17'0&quot;@170&quot;o.c.(B)</td>
</tr>
<tr>
<td>5</td>
<td>E</td>
<td>3#5x7'0&quot;(T)</td>
</tr>
<tr>
<td>6</td>
<td>F</td>
<td>4#5x16'0&quot;(T)</td>
</tr>
<tr>
<td>7</td>
<td>G</td>
<td>4#5x16'6&quot;(T)</td>
</tr>
<tr>
<td>8</td>
<td>H</td>
<td>9#5x12'0&quot;(T)</td>
</tr>
</tbody>
</table>
200.00 REBAR LIST

<table>
<thead>
<tr>
<th>#</th>
<th>Legend</th>
<th>Size</th>
<th>System</th>
<th>No.</th>
<th>Length</th>
<th>Unit Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>F</td>
<td>#5</td>
<td>US</td>
<td>4</td>
<td>192.00</td>
<td>1.04</td>
</tr>
<tr>
<td>2</td>
<td>F</td>
<td>#5</td>
<td>US</td>
<td>4</td>
<td>198.00</td>
<td>1.04</td>
</tr>
<tr>
<td>3</td>
<td>D</td>
<td>#8</td>
<td>US</td>
<td>1</td>
<td>204.00</td>
<td>2.67</td>
</tr>
<tr>
<td>4</td>
<td>G</td>
<td>#5</td>
<td>US</td>
<td>9</td>
<td>144.00</td>
<td>1.04</td>
</tr>
<tr>
<td>5</td>
<td>B</td>
<td>#5</td>
<td>US</td>
<td>3</td>
<td>84.00</td>
<td>1.04</td>
</tr>
<tr>
<td>6</td>
<td>E</td>
<td>#8</td>
<td>US</td>
<td>1</td>
<td>60.00</td>
<td>2.67</td>
</tr>
<tr>
<td>7</td>
<td>C</td>
<td>#8</td>
<td>US</td>
<td>1</td>
<td>42.00</td>
<td>2.67</td>
</tr>
<tr>
<td>8</td>
<td>A</td>
<td>#8</td>
<td>US</td>
<td>1</td>
<td>208.00</td>
<td>2.67</td>
</tr>
</tbody>
</table>

Total Length(ft): 289.00 Total Weight(lb): 342.93

210.00 REBAR TOTALS

<table>
<thead>
<tr>
<th>Group</th>
<th>Quantity</th>
<th>Size</th>
<th>Length/bar</th>
<th>Length</th>
<th>Weight</th>
<th>Unit cost</th>
<th>Total cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1</td>
<td>#8</td>
<td>3.50</td>
<td>3.50</td>
<td>9.35</td>
<td>1.35</td>
<td>12.62</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>#5</td>
<td>4.50</td>
<td>4.50</td>
<td>4.69</td>
<td>1.35</td>
<td>6.34</td>
</tr>
<tr>
<td>C</td>
<td>1</td>
<td>#8</td>
<td>5.00</td>
<td>5.00</td>
<td>13.35</td>
<td>1.35</td>
<td>18.02</td>
</tr>
<tr>
<td>D</td>
<td>1</td>
<td>#8</td>
<td>17.00</td>
<td>17.00</td>
<td>66.75</td>
<td>1.35</td>
<td>90.12</td>
</tr>
<tr>
<td>E</td>
<td>3</td>
<td>#5</td>
<td>7.00</td>
<td>21.00</td>
<td>21.90</td>
<td>1.35</td>
<td>29.57</td>
</tr>
<tr>
<td>F</td>
<td>4</td>
<td>#5</td>
<td>16.00</td>
<td>64.00</td>
<td>66.75</td>
<td>1.35</td>
<td>90.12</td>
</tr>
<tr>
<td>G</td>
<td>4</td>
<td>#5</td>
<td>16.50</td>
<td>66.00</td>
<td>68.84</td>
<td>1.35</td>
<td>92.93</td>
</tr>
<tr>
<td>H</td>
<td>9</td>
<td>#5</td>
<td>12.00</td>
<td>108.00</td>
<td>112.65</td>
<td>1.35</td>
<td>152.07</td>
</tr>
</tbody>
</table>

Total 289.00 342.93 462.95

Note:
Group = Identification assigned to a group of bars with the same diameter and length.

Mesh Reinforcement

<table>
<thead>
<tr>
<th>ID</th>
<th>Size 1</th>
<th>Spacing 1</th>
<th>As1</th>
<th>Size 2</th>
<th>Spacing 2</th>
<th>As2</th>
<th>Area</th>
<th>Weight</th>
<th>Unit cost</th>
<th>Total cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>#5</td>
<td>24.00</td>
<td>5</td>
<td>#5</td>
<td>24.00</td>
<td>5</td>
<td>53.874</td>
<td>56.52</td>
<td>1.35</td>
<td>76.30</td>
</tr>
<tr>
<td>2</td>
<td>0.10</td>
<td>0.10</td>
<td>32.578</td>
<td>22.05</td>
<td>1.35</td>
<td>29.77</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Total 78.56 106.06

Architectural Beam Reinforcement

<table>
<thead>
<tr>
<th>Beam label</th>
<th>Quantity</th>
<th>Size</th>
<th>Length/bar</th>
<th>Length</th>
<th>Weight</th>
<th>Unit cost</th>
<th>Total cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam 1</td>
<td>4</td>
<td>#5</td>
<td>24.00</td>
<td>96.00</td>
<td>100.13</td>
<td>1.35</td>
<td>135.18</td>
</tr>
<tr>
<td>Beam 2</td>
<td>4</td>
<td>#5</td>
<td>24.00</td>
<td>96.00</td>
<td>100.13</td>
<td>1.35</td>
<td>135.18</td>
</tr>
</tbody>
</table>

Total 192.00 200.26 270.35

Total volume of concrete = 572.80 ft^3 (21.21/cu yd)
Total surface of floor slabs = 859.20 ft^2
Average rebar usage = 0.72 lb/ft^2, 1.05 lb/ft^3 (0.05 lb/cu yd)
Total cost of reinforcement = 839.36 $

202 POINT SUPPORT REACTIONS

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>Fx</th>
<th>Fy</th>
<th>Fz</th>
<th>Mxx</th>
<th>Myy</th>
<th>Mzz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Point Support 1</td>
<td>-0.000</td>
<td>-0.000</td>
<td>161.830</td>
<td>-82.480</td>
<td>-87.750</td>
<td>0.000</td>
</tr>
<tr>
<td>ID</td>
<td>Label</td>
<td>Fx</td>
<td>Fy</td>
<td>Fz</td>
<td>Mxx</td>
<td>Myy</td>
<td>Mzz</td>
</tr>
<tr>
<td>-----</td>
<td>----------------</td>
<td>------</td>
<td>------</td>
<td>-------</td>
<td>------</td>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>2</td>
<td>Point Support 2</td>
<td>-0.000</td>
<td>-0.000</td>
<td>289.950</td>
<td>-86.708</td>
<td>37.450</td>
<td>0.000</td>
</tr>
<tr>
<td>3</td>
<td>Point Support 3</td>
<td>0.000</td>
<td>0.000</td>
<td>120.790</td>
<td>-27.172</td>
<td>19.589</td>
<td>-0.000</td>
</tr>
</tbody>
</table>

**Strength**

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>Fx</th>
<th>Fy</th>
<th>Fz</th>
<th>Mxx</th>
<th>Myy</th>
<th>Mzz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Point Support 1</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>2</td>
<td>Point Support 2</td>
<td>-0.000</td>
<td>-0.000</td>
<td>372.190</td>
<td>-111.900</td>
<td>104.600</td>
<td>0.000</td>
</tr>
<tr>
<td>3</td>
<td>Point Support 3</td>
<td>0.000</td>
<td>0.000</td>
<td>119.820</td>
<td>-20.188</td>
<td>-8.580</td>
<td>0.000</td>
</tr>
</tbody>
</table>

**204 LINE SUPPORT REACTIONS**

**Service**

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>Fz</th>
<th>Fr</th>
<th>Fs</th>
<th>Mrr</th>
<th>Mss</th>
<th>Mzz</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>kN</td>
<td>kN</td>
<td>kN</td>
<td>kN-m</td>
<td>kN-m</td>
<td>kN-m</td>
</tr>
</tbody>
</table>

**Strength**

<table>
<thead>
<tr>
<th>ID</th>
<th>Label</th>
<th>Fz</th>
<th>Fr</th>
<th>Fs</th>
<th>Mrr</th>
<th>Mss</th>
<th>Mzz</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>kN</td>
<td>kN</td>
<td>kN</td>
<td>kN-m</td>
<td>kN-m</td>
<td>kN-m</td>
</tr>
</tbody>
</table>
DESIGN LEGEND

This legend is provided as an aid for the interpretation of the results that follow.
(a) Max tension 3.3 N/mm², Allowable 2.6 N/mm² - (b) Max tension 2.7 N/mm², Allowable 2.6 N/mm²
Max compression -6.2 N/mm², Allowable 11.9 N/mm² - Max compression -7.1 N/mm², Allowable 11.9 N/mm²

DESIGN STRIP SERVICE COMBINATION STRESSES
(Tension stress positive)

DESIGN STRIP "DESIGN MOMENT (MU)"
(Moment is drawn on the tension side)

DESIGN STRIP REINFORCEMENT REQUIRED AND PROVIDED
The reinforcement summary created for each design strip shows the location, number of bars, length of the bars and the bar size required to meet all the design criteria specified by you (Fig. 11.6-1). This includes, but is not limited to, the initial condition (transfer of prestressing), service, and strength checks.

In order to obtain other reports, you must navigate through the Reports ribbon to the Single Default Reports panel or the Analysis Reports panel and select the report of your choice. For example, for the report on punching shear stress check, the following pull-down and side menus apply (Fig. 11.6-2):
APPENDIX A

A1 NODE CONSOLIDATION ................................................................. 233
  A1.1 Overview .................................................................................. 233
  A1.2 Consolidation of Analysis Nodes .............................................. 234
A2 MESHING USING EXCLUDER ...................................................... 244
A3 VIEW FINITE ELEMENT NODE AND CELL INFORMATION .......... 247
A4 FINITE ELEMENT CELL SIZE AND MESH DENSITY ...................... 249
  A4.1 Maximum Mesh Size ............................................................... 249
A5 MANUAL EDITING OF AUTOMATICALLY GENERATED MESH ........ 252
A1 NODE CONSOLIDATION

A1.1 Overview

The structural model is made up of structural components, such as beams, columns, slab regions, drop caps and more. Each of these components is meshed (subdivided into elements) on its own with the provision that there will be common analysis nodes at the intersection, or a connection of each structural component with those adjoining it.

As they are created in the program, each of the structural components is positioned with respect to the current reference plane as shown in Fig. A1.1-1. Note that the “analysis node” of the structural component is positioned on the reference plane immediately above the associated “natural node.” The natural node is typically at the centroid of each structural component, whereas the analysis node is the location at which the response of the element is formulated. The program solves its equations at analysis nodes. Once a solution is obtained, it is mapped back to the natural nodes, before reporting it to you. As a result, the presence of analysis nodes will be transparent to you.

Strictly speaking, the program is organized such that the existence of both analysis and natural nodes are transparent to the user. All matters related to these items are handled automatically in the background by the program. While the creation of analysis nodes, and the mapping of the natural nodes onto analysis nodes, is carried out by the program in practically all cases, the consolidation of the analysis nodes is an optional function. The default setting of the program is to activate this option with a value 1 to 3 times the slab thickness. However, you may choose to cancel or change it.

This section describes in greater detail the concept of the dual nodes (analysis and natural), as well as the consolidation of the analysis nodes.
Appendix A

A1.2 Consolidation of Analysis Nodes

Consider the wall-supported slab shown in Fig. A1.2-1. The gap between the two walls, as shown in part (b) of the figure, is about the same as the slab thickness. For a gap of up to approximately four times the slab thickness, the behavior of the slab region spanning the gap is significantly different from the assumption of “plane sections remain plain,” which is a key aspect of ADAPT’s software algorithm and essentially all other linear elastic finite element analysis software. Such regions are referred to as discontinuities (Fig. A1.2-2b). The smaller the gap, the closer is the response of the region to a solid volume. Normally, natural nodes are placed at the corners of the walls together with natural lines as shown in parts (c) and (d) of the figure.
It is expedient and safe, from a structural design standpoint, if the natural nodes of the members terminating at such regions are consolidated into a single analysis node, such as node “A” shown in part (c) of **Fig. A1.2-2**. Node “A” will be linked to the natural nodes 1, 2 and 3 by way of three offsets. The consequence of this modeling is that the three points 1, 2 and 3 will be acting as if rigidly connected together. The conditions of equilibrium with the applied loading necessary for the safety of the structure are maintained. The approximation affects the distribution of
stresses within the “D” region. The analysis, however, will conclude with each of the three natural nodes having its own displacement and forces.

![Diagram of structural design](image)

**FIGURE A1.2-2**

Structural design is based on the magnitude of the actions (moments, shears, axial loading) at selected “design sections.” In ADAPT’s formulation, contrary to traditional FEM [Aalami, Dec. 2001], the design actions at a section are not derived from the distribution of internal stresses. The design actions are based on the forces at the nodes adjacent to the section. The consolidation of nodes at a discontinuity region leads to
an expedient and safe design. The regions are designed to satisfy the equilibrium of forces and detailed for ductility.

In Fig. A1.2-2(c), the position of node 2 with respect to its analysis node is shifted both horizontally and vertically. The horizontal shift is referred to as “Node Shift.” The node shift is generally done automatically by the program. You have the option to shift nodes manually and consolidate several natural nodes of a discontinuity region into a single analysis node, or to suppress node shift altogether. The automatic shift node of the program takes place when two or more “imposed” natural nodes fall closer to one another than the minimum cell size you define in the automatic meshing option. This distance is generally two to four times the slab thickness.

One of the great advantages of node consolidation is the substantial reduction in the number of nodes necessary to complete a design. Clusters of closely spaced imposed nodes result in a dense meshing around them and subsequently a greater demand on the computational resources with no significant increase in the accuracy of the design values.

As an example, consider the partial plan of slab shown in Fig. A1.2-3(a). The plan illustrates a closely spaced wall, beam and column. The natural imposed nodes of each is shown in part (b) of the figure. The region bound by the closely spaced components acts essentially as a chunk of solid and rigid concrete. The shift node option of the program would represent the region by a single analysis node as shown in part (c) of the figure. It is important to note that while the three natural nodes shown are consolidated into a single analysis node, the program will automatically determine and report the displacement and actions at each of the natural nodes separately. This determination is based on satisfying the equilibrium of the forces within the region common to the natural nodes consolidated and considering the deformation of the region as a rigid chunk of concrete.
A common practical scenario of node consolidation is the condition of walls terminating at the slab edge. Figure A1.2-4 illustrates the traditional FEM modeling (part b). The alternative available in ADAPT-Floor Pro is shown in part (c) of the figure.
The common cases of node consolidation that are available to be performed automatically by the program are listed in Figs. A1.2-5A, A1.2-5B, and A1.2-5C.
FIGURE A1.2-5A

MODELING OF STEPS IN SLAB AND BEAM SLAB CONNECTION
GUIDELINES FOR MODELING OF STEPS IN MEMBER AND BEAM SLAB CONNECTIONS

FIGURE A1.2-5B
Figures A1.2-6 and A1.2-7 show other examples of node consolidation and offset.

FIGURE A1.2-5C
FIGURE A1.2-6

REFERENCE PLANE, NATURAL AND ANALYSIS NODES; OFFSETS
Figure A2-1 shows a slab with a wall, columns and an opening. The proximity of the wall to the cut-out corner and also the proximity of one of the columns to an opening are likely to cause a dense mesh within the region. If meshing is attempted, a layout as shown in Fig. A2-2 with 541 elements will result. In this example, since the total number of cells is small, the dense mesh generated is of no practical computational consequence. However, for more complex floor
systems, while the program can handle a mesh with a large number of cells, the computational time may not be justifiable, especially if the required accuracy can be obtained by a much smaller number of cells. Typically, standard floor systems do not require more than 4,000 cells. Complex slabs may require up to 6,000 cells.

Referring back to the example of Fig.A2-1, the mesher displays with red circles at the locations, where details of your structural model require a cell with a size smaller than the one suggested (Fig. A2-3). You may override the mesher’s message and continue with the meshing. The outcome will be cells of smaller side dimensions at the locations indicated by the program. This, obviously, is acceptable. The alternative is to exclude the regions of complex details from the automatic meshing and fill in the cells within these regions at later time. This is achieved using manual meshing within the excluded regions.

FIGURE A2-1 LAYOUT IN PLAN VIEW

FIGURE A2-2 MESHING WITHOUT EXCLUDER (541 ELEMENTS)
To exclude a slab region from automatic meshing, click on the Excluder tool located on the Analysis ribbon. Draw a polygon around the region to be excluded. For the program to exclude the region successfully, there are four rules that need to be followed.

Rule #1: The first point of the excluder shall fall within a slab region.

Rule #2: The excluder cannot cross the boundary of a slab region in more than two locations.

Rule #3: The area bounded by the excluder shall be convex. That is to say, none of the internal angles of an excluder shall exceed 180 degrees.

Rule #4: Excluder cannot intersect an opening, but can fully contain one or more openings.

Using the above rules, two excluders are drawn as illustrated in Fig. A2-4. The remainder of the slab region is now ready for Automatic Mesh Generation on the Analysis ribbon at a recommended mesh size of 3ft. The resulting mesh (Fig. A2-5) has a coarser and more even grid. The components located inside the excluder will be treated according to the following rules.

Rule #1: Automatic shift node does not apply within the excluded area.
Rule #2: Manual shift node is permissible within the excluded area but shall not be used to shift nodes to the excluder boundary, or across it.
The regions excluded are now ready to be meshed manually. To fill in the regions within the excluded areas, refer to the Modeler Manual for manual meshing.

A3 VIEW FINITE ELEMENT NODE AND CELL INFORMATION

You can view the finite element cell and node numbers used by the program to obtain your solution. Also, you can obtain a text-based list of both the nodes and cells. The list of cells also includes the node connectivity.

One of the several ways to obtain the graphical display of cell node numbers is to select their display check mark from Visibility ➔ Display Settings ➔ View Settings. Figures A3-1 and A3-2 show views of cell and node numbers.
Samples of node numbers and their coordinate are shown in Tables A3-1 and A3-2.
TABLE A3-1 EXAMPLE OF SHELL ELEMENTS AND THEIR CONNECTIVITY

<table>
<thead>
<tr>
<th>Element</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>113</td>
<td>116</td>
<td>136</td>
<td>135</td>
</tr>
<tr>
<td>2</td>
<td>135</td>
<td>134</td>
<td>107</td>
<td>113</td>
</tr>
<tr>
<td>3</td>
<td>124</td>
<td>139</td>
<td>138</td>
<td>123</td>
</tr>
<tr>
<td>4</td>
<td>123</td>
<td>106</td>
<td>102</td>
<td>124</td>
</tr>
<tr>
<td>5</td>
<td>122</td>
<td>124</td>
<td>102</td>
<td>104</td>
</tr>
<tr>
<td>6</td>
<td>122</td>
<td>134</td>
<td>139</td>
<td>124</td>
</tr>
<tr>
<td>7</td>
<td>122</td>
<td>104</td>
<td>107</td>
<td>134</td>
</tr>
<tr>
<td>8</td>
<td>149</td>
<td>151</td>
<td>138</td>
<td>139</td>
</tr>
<tr>
<td>9</td>
<td>139</td>
<td>134</td>
<td>144</td>
<td>149</td>
</tr>
</tbody>
</table>

TABLE A3-2 EXAMPLE OF NODE NUMBERS AND THEIR COORDINATES (INCH)

<table>
<thead>
<tr>
<th>NODE</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2.49132E+02</td>
<td>2.90839E+02</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>2</td>
<td>2.52144E+02</td>
<td>3.24000E+02</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>3</td>
<td>2.88108E+02</td>
<td>2.45109E+02</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>4</td>
<td>2.85440E+02</td>
<td>2.6592E+02</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>5</td>
<td>2.81406E+02</td>
<td>2.03854E+02</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>6</td>
<td>2.46168E+02</td>
<td>2.56720E+02</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>7</td>
<td>2.63865E+02</td>
<td>2.03854E+02</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>8</td>
<td>2.90595E+02</td>
<td>2.06793E+02</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>9</td>
<td>2.89845E+02</td>
<td>1.67141E+02</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>10</td>
<td>2.63171E+02</td>
<td>1.77661E+02</td>
<td>1.20000E+02</td>
</tr>
<tr>
<td>11</td>
<td>2.42210E+02</td>
<td>1.81068E+02</td>
<td>1.20000E+02</td>
</tr>
</tbody>
</table>

A4  FINITE ELEMENT CELL SIZE AND MESH DENSITY

A4.1 Maximum Mesh Size

Automatic meshing is performed by the program using a maximum mesh size defined by the user. Generally, 6 to 8 divisions for the typical span of a floor system provide a good solution for design. If geometric complexity in the structural model makes it impractical to mesh with the user-suggested size, the program automatically reduces the mesh size and makes a new attempt. The reduction of maximum mesh size followed by a new attempt at meshing is continued through many iterations until either a successful meshing is achieved, or the number of iterations allowed is exhausted. If the automatic meshing is successful, the user has the option to view/edit the meshing selected. Otherwise the solution is ready to be converted into elements. The default number of iterations for selection of an optimum cell size is 2. The user can change this default to a larger number of iterations, each successive iteration with a smaller cell size.

If an attempt at automatic meshing is not successful, several options are available:

- Re-attempt automatic meshing, but specify a smaller “maximum mesh size.” The value to be specified should be less than 80% of
the previous attempt, since the program automatically reduces the suggested size in each of its iterations by 20%. For example, if the first user suggestion was 2m, the second suggestion should less than 1.60m.

- Use the *Node Proximity Detection* tool from the *Shift Nodes* from *Analysis ➔ Meshing* tool panel. The program will encircle and display the location(s). A visual evaluation of the location reveals the preparatory steps necessary for the meshing. Invariably, these are locations where clusters of closely spaced imposed nodes, such as an intersection of several beams at an uncommon location, make it difficult for automatic meshing. In this case the user should rectify the location indicated by the program by manually consolidating two or more of the imposed nodes. This is referred to as the *Shift Nodes Manually* operation.

![Diagram](image)

(a) Selection of a large “Maximum Mesh Size”

![Diagram](image)

(b) Selection of a small “Maximum Mesh Size”

**FIGURE A4.1-1 EFFECT OF “MAXIMUM MESH SIZE” SELECTION**

The effect of the maximum mesh size selection on the outcome of the program’s automatic meshing is illustrated in **Figure A4.1-1**, which shows the plan of a slab with an opening.

The maximum mesh size selection is made in the dialog box shown in **Figure A4.1-2** when invoking the automatic mesh generation tool 🏗️.
The final mesh size selected by the program is governed by the location on the floor system where closely spaced imposed nodes dictate a dense meshing. The following example illustrates the point.

**Figure A4.1-3(a)** shows a slab region with corner columns. For analysis, it is advantageous to consolidate the analysis node of this column with that of the slab corner, in other words shift the analysis node of the column to the corner of slab. If the column’s natural node is not shifted to the slab corner, the program will impose an analysis node at the column centerline and mesh the slab region accordingly (part (b) of the figure). The outcome is generally a denser mesh, since the distance between the column centerline and the slab edge must be represented by at least one slab element. However, if the column’s analysis node is shifted to the slab corner (part (c) of the figure), the ensuing mesh generation will be independent of the column’s natural node. The outcome is a larger mesh size (fewer elements) as shown in part (c) of the figure. It should be emphasized that the location of the corner column remains unchanged, but for purposes of analysis, its analysis node is advantageously shifted to the slab corner. Moments, axial forces, punching shear and other analysis and design values reported by the program refer to the actual (natural) column and member locations.

Edge columns are treated in a similar manner. Their analysis node is best shifted to the slab edge.
FIGURE A4.1-3 IMPACT OF NODE SHIFT ON MESHING

A5 MANUAL EDITING OF AUTOMATICALLY GENERATED MESH

This section describes how you can edit a mesh that is automatically generated by the program. Manual mesh generation is described in detail in Modeler User Manual. Editing of automatically generated mesh becomes of interest in at least two conditions.

First, in some instances the automatic mesher creates an overly dense mesh at complex details of your structural model. While not essential, it is often desirable from a PC-performance standpoint to reduce the number of cells.

Second, at some locations the aspect ratio for sides of a given cell might be too large. Again, while from computational standpoint this is acceptable, some users
may wish to bring the aspect ratio to a more acceptable limit. The formulation of the program gives solutions acceptable for design, with aspects ratios of individual cells well beyond 50. For quadrilateral shell elements this is the ratio of the element length to the element width. For triangular elements, if any, this is the ratio of the triangle base to its height. When aspect ratio reaches a limit that might not be acceptable, the program generates an onscreen message prompt and identifies the cell in question.

The following walks you through the steps of manual mesh editing by way of an example. Consider the floor slab shown in Fig. A5-1. As an exercise, let us edit the cells around the upper right-hand column to a lower density.

![Figure A5-1](image1.png)

**FIGURE A5-1 FLOOR PLAN SHOWING FINITE ELEMENT MESHING**

The enlarged view of this region on the computer screen is given in Fig. A5-2. The quadrilaterals and/or triangles intended for editing are first selected (Fig. A5-3). The selected items are identified on the screen by a change in color. The selected items are then deleted (Fig. A5-4).

![Figure A5-2](image2.png)

**FIGURE A5-2 ENLARGED VIEW OF LOCATION TO BE EDITED**
FIGURE A5-3 QUADRILATERALS INTENDED FOR EDITING ARE SELECTED

FIGURE A5-4 ITEMS SELECTED FOR EDITING ARE DELETED
FIGURE A5-5 SELECTION OF MANUAL MESHING COMMAND

Select Analysis \(\rightarrow\) Meshing \(\rightarrow\) Manual Mesh Generation \(\rightarrow\) and the dialog box of Shell Elements - User Defined will appear (Figs. A5-5 and A5-6).

FIGURE A5-6 MANUAL MESH DIALOG BOX

Set the number of cells to be created to 1 as shown in Fig. A5-6. Press OK to close this dialog window and start drawing quadrilateral or triangular cells to fill in the region to be meshed. Complete each cell first before moving on to the next. In drawing the cells, you have to use the appropriate snapping tool from the Snap Tools on the lower Quick Access Bar as shown in Fig. A5-7. Use Snap to Intersection (fourth button from the left) wherever possible. This will ensure the connectivity of adjacent cells at the nodes. If the vertices of the cells you create do not snap to one another, there will be no force transfer among them.

FIGURE A5-7 SNAP TOOLS

Fig. A5-8 shows the first two cells created. Note that column center is selected as one of the nodes. The completion of the work is shown in Fig. A5-9.
A faster method to fill in a specific region in a mesh is to generate a group of cells that cover the region, and then snap the perimeter nodes of the new mesh to the boundary of the existing mesh cells. Before getting started, estimate how many cells are necessary to fill the region. Select the Manual Mesh Generation tool (Fig. A5-5). In the Shell Elements – User Defined dialog box, define several cells at a time instead of one-by-one. When using this process, a mesh of 3x2 will be used to fill the region (Fig. A5-10).
Once the number of cells has been defined, the program will prompt you to enter the four vertices of the 3x2 mesh. It is good practice to position the four points so that the new mesh’s boundary is close to the boundary of the region it is expected to cover (Fig. A5-11). If the new mesh is positioned well, then there will be less work in adjusting the cells to obtain a well-balanced mesh.

![FIGURE A5-11 VIEW OF 3 X 2 MESH](image)

Use the diagrams in Fig. A5-12 as a guideline in adjusting the cells. Note that to reposition a common vertex shared by two or more cells, you must select all cells that meet at that common vertex. To do so, click on the first cell and then hold down the “Ctrl” key to add more cells to the selection. If you have difficulty selecting a cell, you may find the “tab” key on your keyboard helpful in selecting overlapping cells. In order for the column to be considered in the analysis and design, you must snap the vertex of a cell on the center of the column as shown in Fig. A5-12 (d).
FIGURE A5-12 NODE-ADJUSTMENT PROCESS
B1 TIPS FOR MESHING ..........................................................................................260
  B1.1 Extend the Boundaries of Openings to Centerline of Adjacent Walls....260
  B1.2 Extend Openings to Slab Edge .................................................................260
  B1.3 Combine Adjacent Openings.................................................................261
  B1.4 Break Up Walls and Beams That Intersect Outside a Slab Region ....262
  B1.5 Either “Disregard” Short Wall Projections, or Use Manual Shift Node ..263
B2 SUGGESTIONS FOR IMPROVED MESHING..................................................264
  B2.1 Wall Intersections....................................................................................267
  B2.2 Break Walls Across Different Slab Regions...............................268
  B2.3 Break Up Walls and Beams Adjacent to Jagged or Irregular Slab
       Boundaries...............................................................................................268
B3 MANUAL NODE SHIFT (NODE CONSOLIDATION)........................................270
  B3.1 Exclusion of Locations of Your Choice from Node Shift .................272
  B3.2 Shift Node (Consolidate Node) Manually ..............................................274
B1 TIPS FOR MESHING

B1.1 Extend the Boundaries of Openings to Centerline of Adjacent Walls

For purposes of analysis, it is recommended that the user extend the side of the openings with perimeter walls or beams to the centerline of the walls or beams that form the opening’s boundary (Fig. B1.1-1). If you follow the modeling technique that is outlined in the workshop tutorial, you will find that this style of modeling does not impact the authenticity of the structural drawings you create. Your drawings for construction will show the openings extending to the sides of the perimeter walls/beams.

FIGURE B1.1-1 OPENING EXTENDED TO CENTERLINE OF WALLS

B1.2 Extend Openings to Slab Edge

Where openings are next to the slab edge, such as shown in three different scenarios in Fig. B1.2-1, extend the opening to the slab edge. The extension is justified where the narrow slab band between the opening and slab edge does not make a notable difference in the load carrying capacity of the floor.

Part (b) of the figure shows the treatment in each of the three scenarios.

- If the strip of slab band between the opening and slab edge is not supported, move the slab boundary around the opening.
- Where a wall or a beam separates the opening from the slab edge, extend the opening to the slab edge, with no modifications either in
the wall or the beam. The analysis will automatically mesh the beam and the wall forming the outer boundary of the opening. The contribution of the beam and the wall on the outer edge of the opening will be fully accounted for by the program.

FIGURE B1.2-1 TREATMENT OF OPENINGS NEXT TO SLAB EDGE

B1.3 Combine Adjacent Openings

When two or more openings are next to one another, such as the two openings at the left of Fig. B1.3-1, it is best to combine them into one opening as shown in part (c) of the figure. If left as is, an unnecessarily denser mesh can result (part (b) of the figure).

Likewise, when two openings are drawn one on each side of a wall or a beam, it is best to combine the openings as shown in part (c) of the figure.
When combined, the program correctly accounts for the continuity and load carrying features of the wall or beam that passes through the opening.

FIGURE B1.3-1 COMBINE ADJACENT MULTIPLE OPENINGS INTO ONE

B1.4 Break Up Walls and Beams That Intersect Outside a Slab Region

Figure B1.4-1 shows a slab region with three walls A, B and C. Wall A does not intersect with another wall outside the slab area. This wall does not need special treatment. Walls B and C, however, intersect at a point outside the slab region. You must break each into two segments, one being the length within the slab region and one outside it. In other words, walls, or portions of walls that fall outside a slab region should be modeled as a separate wall. This is a modeling requirement. From an analysis standpoint, the program will automatically consider the walls contiguous.
B1.5 Either “Disregard” Short Wall Projections, or Use Manual Shift Node

In cases where short walls project from longer walls for reasons of architectural detailing, such as the example shown in Fig. B1.5-1(a), there are several options for their efficient modeling.

- Use the scheme suggested in workshop tutorial, whereby the walls appear on your construction (structural) drawings, but not in your structural model for analysis;
- Bring the walls into your structural model, but disregard them in your analysis; and
- Use manual node shift, in order to simplify the modeling and avoid a dense finite element mesh.

The following gives the details.

**Disregard Option**

If a wall is created to complete a structural detail, as opposed to carry load, such as projection B in Fig. 1.5-1, open its property window and select “disregard.” This will retain the wall in your structural model for completeness; will not mesh it; will not consider its stiffness in resisting the applied load – but will consider it in the calculation of reinforcement and quantity take off. In other words, by selecting “disregard” you eliminate the inclusion of that wall in the formation of a stiffness matrix of the structural model, but account for its presence in other aspects of your work, including to resist the design values, such as moments and punching shear.

**Manual Node Shift**
If a wall projection created to complete an architectural detail is large enough to have a notable effect on the local stiffness of the floor system, you may choose to retain it in your model. Select the “consider” option in its property box. In addition, the mesh density resulting from the inclusion of the wall projection can be improved if you manually consolidate its end node with that of the primary wall. An example of this option is shown in the projections D, E and F of Fig. B1.5-1. This kind of node-consolidation is referred to as “manual node shift,” and is explained in other sections of this manual. Figure B1.5-1(b) shows the shifted axis of the wall projections D, E and F.

**Do Not Pre-process**

In general, for wall projections with an aspect ratio greater than four, preprocessing treatment is not necessary.

![FIGURE B1.5-1 TREATMENT OF SHORT WALL PROJECTIONS](image)

**B2 SUGGESTIONS FOR IMPROVED MESHING**

The following recommendation can help to improve the meshing of your structural model, especially in cases where closely spaced multiple constraints result in a dense mesh.

- In the *Automatic Mesh Generation* dialog window ([Fig. B2-1](image)), select a suggested maximum cell size 1/6 to 1/8 times the average span.
- Select *Shift nodes automatically* and consider a distance for node shift equal to three times the average slab thickness. A distance between two to four times gives reasonable results.
Figure B2-2 shows plan of a floor system with closely spaced columns. When using the *Shift nodes automatically* option, the imposed top node of the closely spaced columns will be consolidated into a single analysis node. The resulting mesh is shown in Fig. B2-3. A close up of the three-column cluster (Fig. B2-4a) indicates a node at center of one of the columns only.

Figure B2-4b displays the consolidation of the natural nodes of the two left columns to the column at right. This is illustrated by the lines connecting the natural nodes of the shifted column to the one on the right. These “shift nodes” lines can be displayed onscreen by turning on the “symbol” of the column. It should be emphasized again that the solution proceeds with each column being duly meshed and concludes with separate forces for each column reported at each column’s centroid (Fig. B2-5)
FIGURE B2-3 MESHING OF THE STRUCTURE USING NODE SHIFT

(a) Frame Element Symbol Not Shown  (b) Frame Element Symbol Shown

FIGURE B2-4 CONSOLIDATIONS OF THREE CLOSELY SPACED COLUMN TOP NODES INTO ONE (NODE SHIFT)

FIGURE B2-5 VIEW OF MESHING SHOWING INDIVIDUAL CELLS OF ALL STRUCTURAL COMPONENT
B2.1 Wall Intersections

There are several options to model the intersection of walls. These are illustrated in Fig. B2.1-1. At “A” (part (c) of the figure), the walls intersect (overlap). Likewise, at “B,” Wall 7 is modeled to overlap with Wall 6. Wall 9 butts to Wall 8 at intersection “D.” Using the node shift option, the resulting meshing is shown in part (c) of the figure. Note that in all instances the intersection is consolidated into a common node. The difference between the various modeling schemes lies in the meshing and design of the wall itself. For example, for calculation of building weight and wall design, the length of Wall 10 is calculated to the face of Wall 8. But the length of Wall 5 is calculated to the outside face of Wall 6, that is to say, Wall 5 is assumed to extend over the entire width of the slab.

(a) Wall Supported Slab

(b) Wall Identification

(c) Wall Intersection Identification

(d) Meshing Using Node Consolidation (Node Shift)

FIGURE B2.1-1 WALL INTERSECTION MODELING ALTERNATIVES
B2.2 Break Walls Across Different Slab Regions

While not essential, where walls extend over more than one slab region, such as shown in Fig. B2.2-1 (b), you may break them into several walls for greater accuracy in your solutions. Break the wall, such that each sub-wall covers one of the slab regions. The wall in part (b) of the figure is continuous, but it is broken into three parts. When the Establish Component Connectivity tool of the program is invoked, the program automatically adjusts the top of each sub-wall to be in line with the soffit of respective slab region. The separation of the walls shown in part (b) of the figure does not affect the analysis of the structure. In the analysis, the walls that touch one another, such as the scenario in this case will be considered contiguous and will be treated as one. There will be full compatibility of deformation among the sub-walls.

![FIGURE B2.2-1 WALLS EXTENDING ACROSS SLAB REGIONS](image)

If you have already created a wall as one whole and want to break it into parts, the simplest procedure is to use the program’s “split” tool, which is accessed from the Modify pull-down menu. Once you split a wall, drag the sub-walls with the mouse and snap at their ends to the boundary of the slab regions.

B2.3 Break Up Walls and Beams Adjacent to Jagged or Irregular Slab Boundaries

Where a wall or a beam is close to a multiple discontinuity (jaggedness) at slab edge or opening, as illustrated in Fig. B2.3-1, it may become necessary to break the wall up into sections. This is mostly the case, where the structural modeling is not done accurately, and a condition as shown in Fig. B2.3-1 arises. The break up is only necessary (i) if there is more than one protrusion or cut out along the slab edge, and (ii) if you invoke the
node shift option of the program. When the node shift option is invoked, the program attempts to shift the analysis axis of the wall/beam onto the slab edge or opening. If the slab edge has many discontinuities, it would not be possible to line up the wall axis with more than one segment of the slab edge (or opening). For this reason, the wall has to be broken down into segments as shown in part (b) of the figure. The number of segments should correspond to that of the slab edge/opening adjacent to the wall/beam.

Again, it should be noted that the breakdown of the wall is not necessary if the shift node option is not used. Also, for the analysis, the program will automatically consider the subdivided pieces of a wall/beam as a whole. In other words, the breakdown of a wall/beam into segments does not impact the solution, nor the treatment of the wall/segment as a contiguous member in resisting the load.

Consider wall A in Fig. B2.3-2. This wall need not be subdivided regardless of whether or not shift node option is used, since its analysis axis can be shifted (lined up) to the slab edge next to it. Wall B adjacent to the two openings, however, must be broken down if shift node is used, since its axis cannot be simultaneously be lined up with the edges of both of the openings. If node shift option is used, it is best to break up this wall into two segments.

A variation of the above conditions is shown in Fig. B2.3-3, where a wall is adjacent to a slab edge and at the same time its extension is close to an opening. Again, it generally is not possible to line up the wall axis with both the slab edge and the edge of the opening. If automatic shift node is to be used, it is “best to break the wall into segments.
B3 MANUAL NODE SHIFT (NODE CONSOLIDATION)

You can manually consolidate analysis nodes at locations of your choice. Also, you can prevent the program from doing so automatically when you do not wish nodes to be consolidated. This section describes these options in great detail.

Access the manual shift node fromAnalysis ➔ Meshing (Fig. B3-1). The following options are available:

- Node Proximity Detection
- Shift Nodes Automatically
- Shift Nodes Manually
- Cancel Node Shift
- Display/Hide Component Representative
Shift node option applies to columns, beams, walls, point supports, and line supports. Once a node is shifted manually, it will remain at its imposed position until you activate the Cancel Node Shift. The following illustrates the procedure.

**Figure B3-2(a)** shows a floor slab with two columns and a beam. The node of column A and the nodes of the beam are shifted manually to the locations A for the column and B, C for the beam (**Fig. B3-2(b)**). The new locations are displayed with the symbol of the column (small circle) and the beam (large circles). The analysis nodes generated in meshing for the beam will be along line BC. Likewise, the node of column at the top left of the slab will be at point A. The analysis node of column D was not shifted. Hence, a node is generated at its center (part (c) of the figure).
B3.1 Exclusion of Locations of Your Choice from Node Shift

You can selectively “freeze” one or more components from node shift, while allowing the analysis nodes of the remainder of the eligible components to be automatically or manually shifted. Consider the floor plan in Fig. B3.1-1(a). Column A is well within the interior of the slab and is not a natural candidate for automatic node shift. The remainder of the columns B, C and D, along with the two beams E and F, are close enough to the slab edge to be subject to node shift. Let us assume that you do not want the node of column C and the nodes of beam E to be shifted. The following is the procedure.

- Double click on column C to open its property dialog window (Fig. B3.1-2).
- Select the FEM tab.
- Select the check box for Do not shift nodes automatically. This will lock the position of the analysis node of this column at its
natural position (centroid of the column). The two data fields to the top right of this check box refer to the offset values of the node shift in the X- and Y-directions.

- Likewise, double click on beam E to open its property box and select the Do not shift nodes automatically check box in its FEM tab.

Figure B3.1-1(b) shows the position of the shifted analysis nodes of the columns and the beam, which were either not frozen, or were not a candidate (column A). The outcome of meshing is shown in part (c) of the figure. Observe that in part (c) of the figure there are nodes on column C and along beam E, the two structural components with frozen node shifts.

The mesh layout resulting from this operation is shown in Fig. B3.1-1(c).

Note that once you manually consolidate nodes, the program locks your choice and will not override it in its automatic node consolidation. In other words the work done by you manually remains frozen, until you cancel your work.

![Diagram](image)

FIGURE B3.1-1 COMPONENTS WITH NODE PERMITTED AND LOCKED NODE SHIFT
B3.2 Shift Node (Consolidate Node) Manually

To shift (consolidate) an analysis node manually, click on the Shift Node Manually side menu item of Fig. B3-1, and follow the instructions on command line at the bottom of the screen. To verify your work do the following:

- Turn on the symbol of the structural component that you selected for node shift;
- Click on the structural component you selected for node shift; and
- Operation is successful when the symbol of the structural component you node shifted is displayed in red color.
Appendix C

GLOSSARY OF TERMS

C1.1 Natural Nodes
C1.2 Analysis Nodes
C1.3 Offset
C1 GLOSSARY OF TERMS

C1.1 Natural Nodes

Each structural component has a number of “natural nodes” when converted into finite elements for analysis. For example, the natural nodes of a beam frame are located at the centroid of its end sections. Hence, each frame element has two natural nodes. For shell elements, the natural nodes are at each corner of the shell element and mid-depth of its thickness. The natural nodes are located on the midplane of the shell element. Figure C1.1-1 illustrates several structural components and the position of the natural nodes.

C1.2 Analysis Nodes

Unlike the traditional finite element formulations, in order to handle post-tensioning and also to take advantage of the features of component technology, ADAPT’s formulation is based on “analysis nodes.” Each finite element of the structure is mapped onto a reference plane as illustrated in Fig. C1.2-1. The image of a natural node on the reference plane is its “Analysis Nodes.” For example, I’ is the analysis node of the natural node I. ADAPT’s calculations are performed on the analysis nodes. However, the solution is reported and displayed with respect to the natural nodes. In summary, the analysis node concept is an analytical feature necessitated to move beyond the traditional application of the Finite Element Method and use the more intuitive design approach of “component technology.” The introduction and description of “analysis nodes” in this document is intended to provide a smooth informational transition from the traditional FEM to Component Technology. Otherwise, the knowledge of analysis nodes for design is not necessary.
FIGURE C1.1-1 NATURAL NODE

(a) FRAME ELEMENT

(b) SHELL ELEMENT

NATURAL AND ANALYSIS NODES
C1.3 Offset

Offset is the distance a natural node must be shifted to reach its analysis node. Refer to FigC1.3-1 and note that offsets are expressed in terms of translations along the global coordinate axes. For example, OX is offset along X-direction.
FIGURE C1.3-1 NATURAL AND ANALYSIS NODES
INDEX

Actions at the cut, 150
Allowable Stresses, 72
Analysis node, 121, 235, 279
bitmap, 142
Bonded system, 39
BOUNDARY CONDITIONS, 25
Component representative, 109
Component Technology, 120, 122
Concrete Cover, 74
cracked_section deflection, 125
Current Plane, 21
Cut line results, 148
Design Code, 71
Design Sections, 155
Display settings, 146
Display tools, 143
Dynamic Tendon Modeling (DTM), 60
Effective Force Method, 40
Entity display settings, 144
Excluder, 248
Hyperstatic load, 89
Imposed lines, 107
Imposed nodes, 107
Jacking force, 42
Lateral Load Editing Mode, 101
Lateral loads, 96
Load cases, 87
Long-term stress loss, 42
Material properties
  mild steel, 70
  prestressing steel, 71
Meshing, 105
Natural node, 235, 279
NODE CONSOLIDATION, 272
Node Proximity Detection, 252
Node shift, 110, 120, 239
Offset, 22, 281
Preferred Reinforcement Size, 73
Prestressing load, 88
Punching shear design, 164
Rebar Length, 76
REBAR ROUND UP, 75
Report Generation Manager, RGM, 197

Reports
  - default reports, 198
  - External Graphics, 199
  - external text, 198
  - User Generated Reports, 198

Result display settings, 144

Shear Design, 73

Shift Nodes Manually, 252

Skipping of live load, 91

Stress losses, 42

Tendon
  - cross-sectional geometry, 35
  - friction, 41
  - material properties, 38
  - shape, 31
  - Stressing, 42

Tendon mapping, 49

Tendons intersection, 62

Unbonded system, 39

Variable Force Method, 40

View analysis results, 141